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Digital Documentation (Advanced)
using LibreOffice Writer

Introduction

You have already studied that Word Processing is the process to create,
edit, save, and print text documents on the computer using a word
processor. A word processor is a computer application that is used to
create, edit, and organize a document. One of the examples of Word
Processing applications is LibreOffice Writer. It is a free and open-
source word processing software that is part of the LibreOffice suite.
It is a powerful alternative to other word processors like Microsoft
Word, providing similar functionalities with support for various file
formats. LibreOffice Writer helps you create different types of neat and
attractive text documents, such as fax documents, reports and personal
and professional letters.

One of the standout features of LibreOffice Writer is its compatibility
with multiple file formats, including .docx and .odt, ensuring that users
can open, edit and save documents across different platforms seamlessly.
Additionally, Writer offers advanced functionalities such as mail merge,
styles and formatting and support for footnotes and endnotes.

In this unit, you learn about how to open LibreOffice Writer. Next, you
learn how to create, update, and apply styles in a document. After this,
you learn to work with images and templates. Towards the end, the
chapter discusses the concept of table of concepts.
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Session 1: Opening LibreOffice Writer

Perform the following steps to open the LibreOffice Writer application:

€@ Press the Windows key [J on the keyboard.

e Start typing LibreOffice. The LibreOffice icon should appear in the search results, as shown in

Figure 1.
Clicking the LibreOffice icon
Create:
Best match
X N\ sy y
D LibreOffice Writer Document
i App
s
Apps Z E: [,
LibreOffice Calc Spreadshest
B LibreOffice Writer > App
| O Lbreoffice Calc > i
E 1mpress Presentation
B LibreOffice Base > = Open
Search the web EO Run as administrator
. Draw Drawing
| L lib - See more search results > m Open file location -
B LibreOffice Writer > T Finto start I
: 13 Pin to taskbar NS Math Formula
[ LibreOffice Calc >
| [i]  uninstall

Base Database

LibreOffice

Community

Figure 1:  Selecting LibreOffice Application

Click the LibreOffice icon to open the application.

[ ] [&)

@ Ssearch for the Writer Document within the Create shelf in the
LibreOffice Starter window. It usually resembles a document or a

page with text. Click on it to open LibreOffice Writer, as shown in
Figure 2. Figure 2:  Selecting Writer Document

Help Extensicns

When you open LibreOffice Writer, you'll typically see several key components on the screen:

e Title bar: Displays the name of the application and the document on
which work will be done.

Note:E

You can type LibreOffice
Writer in the start
menu to directly open

e Menu bar: Located at the top of the window, the menu bar contains
various menus such as File, Edit, View, Insert, Format, and others,
providing access to different functions and settings.

the Writer Document,
e Standard toolbar: Below the menu bar, the standard toolbar includes and double-click the
icons for commonly used functions such as Save, Undo, Redo, Print, and Eborsgmfiflce Writer icon

more. These icons provide quick access to frequently used commands.

e Formatting toolbar: This toolbar allows you to change the formatting of text and paragraphs easily.

It includes options for font selection, text alignment, bold, italic, underline, bullet points, and
numbering.

e Ruler: The horizontal and vertical rulers are useful for setting margins, indents, and tab stops.

The horizontal ruler is located at the top, and the vertical ruler is on the left side of the document
window.

e Document area: The large central area is where you compose and edit your document. This is
where you type your text, insert images, tables, charts, and other elements.

e Status bar: At the bottom of the window, the status bar displays information about the current
page number, word count, language settings, and other document-specific details.

Information Technology
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The components of LibreOffice Writer are shown in Figure 3:

B Untitled 1 — LibreOffice Writer — [m} *
Title bar Standard
>File Edit View Insert Format Styles Table Form  Tools Window Help s toolb
e Zar dew e 2 m Jeos X = v oolbar
2 - = - [ O, [t 1 3 abg
B-E-E-Dh & @ B~ & S R »
Menu bar . _ -
|Defau|t Paragraph Style ~ | 7%9 ,%ﬂ |Liberati on Serif v | |12 pt |¥ | B I » Formatting
toolbar
v |||||||-'|||||||:'|||||||§'|||||||.-i|||||||5'|||||||§'| -
I~
Ruler
Document area >
v
[=]| Page1of1| 0words, Ocharacters Default Page Syle| [ [ (19 — ~—0———+ 1(—I Status bar

Figure 3:  LibreOffice Writer Window

Session 2: Introduction to Styles

In LibreOffice Writer, styles are powerful features that streamline the formatting of documents, ensuring
consistency and efficiency. Styles allow users to apply predefined formatting to text, paragraphs and
other elements throughout the document. By utilizing styles, you can easily manage and modify the
appearance of various sections without having to manually adjust each one individually.

Style Categories

Following is an overview of the primary style categories:

e Paragraph styles: Paragraph styles define the appearance of entire
paragraphs. They control elements such as font size, line spacing,
indentation, alignment, and paragraph borders.

o Characterstyles: Character styles apply formatting to specific characters
or words within a paragraph without affecting the entire paragraph.
They are useful for highlighting or emphasizing text.

o Frame styles: Frame styles are used to format text frames and graphica
tables. They control the size, border, and background of the frames.

)

DID YOU Know & §
You can also '
press Ctrl + 1 after
selecting the text to
instantly apply the
Heading 1 style.

| elements like images or

o Page styles: Page styles manage the layout of entire pages. They include settings for page size,

margins, headers, footers, and page numbering.

o List styles: List styles are used to format numbered or bulleted lists. They define the appearance of

the list numbers or bullets and their alignment.

o Table styles: Table styles control the appearance of tables, including border styles, shading, and
cell formatting. They help ensure that tables are consistently formatted throughout a document.

Digital Documentation (Advanced) using LibreOffice Writer
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Styles and Formatting Windows

In LibreOffice Writer, the “Styles and Formatting” window is a crucial tool for managing the appearance
and layout of your document. This feature allows you to apply, modify, and create styles, which are
predefined sets of formatting instructions that control the look of text and other elements in your
document. By using styles, you ensure consistent formatting across your document, making it easier to
maintain a uniform appearance and making global changes more manageable.

Perform the following steps to apply styles: Selecting the Heading 1 option
o Open a new or existing document containing some text. Styles Table Form Jools Window
@ Sselect the text in the document on which you want to As Body Text Curi+0

apply the styles. In our case, we have selected What is Ti Title

LibreOffice Writer? T: Subtitle

(H: Heading 1 Ctri+1

€ Click on the Styles button on the Menu toolbar. A drop- H: Heading 2 N Ctrl+2

down list appears. H: Heading 3 Ctrl+3
o Select the desired style you want to apply to the text. G, Block Quotation

In our case, we have selected Heading 1 as shown in ds _Preformatted Text

Figure 4. Figure 4: Heading 1 Option

e Double click the style that you want to apply on the selected text.

The selected style is applied to the selected text, as shown in Figure 5:

What is LibreOffice Writer?

LibreOffice Writer is a powerful word processing application that is part of the LibreOffice suite, a free and open-
source office software package. It allows users to create, edit, and format documents such as letters, reports, and
books.

Figure 5: Displaying Text after Applying Style

Using Fill Format

The “Fill Format” feature allows users to quickly apply formatting styles from one part of a document to
another. This is particularly useful when you want to replicate specific formatting attributes—such as
font type, size, colour, or background shading—without having to manually adjust each element.

Perform the following steps to apply Fill Format:
o Click on the Styles icon in the right Sidebar.

q Clicking the Fill Format Mode icon
! Styles l 7 x =
iy 22 A
= Default Paragraph Stgla =7

Fill Format Mode

Select the style you want to apply. This could be a
paragraph style, character style, or any other style
available in the list.

0 Click the Fill Format Mode icon in the Styles

window. It looks like a paint bucket, as shown in

Figure 6. Figure 6:  Fill Format Mode

Click on the text or paragraphs in your document where you want to apply the selected style.

The chosen style will be applied to the selected text, as shown in Figure 7.

GUESSWho?

| am a style that manages

the layout of entire pages.
91A)s a8k “suy

What is LibreOffice Writer?

LibreOffice Writer is a powerful word processing application that is part of the LibreOffice suite,
a free and open-source office software package. It allows users to create, edit, and format
documents such as letters, reports, and books.

Figure 7: Displaying Text after Applying Style

Information Technology
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Creating and Updating New Style from Selection Note[=

LibreOffice Writer offers powerful tools for document formatting, and

£i ful f i< the abili dund | You can also update your
one of its most useful features is the ability to create and update styles. selected style by directly using
Styles in LibreOffice Writer are predefined sets of formatting attributes Style Action button in the right
that can be applied to various elements of a document. They help sidebar by clicking on Update
ensure consistency and efficiency in document formatting. Selected Style.

Creating New Style from a Selection
Perform the following steps to create a new style from a selection:
€ Open ablank or existing document.
@) Select the text based on which you want to create a new style.
0 Click on the Styles button on the toolbar. A drop-down list appears.

@ select the New Style from Selection
option from the drop-down list.

A New Style from Selection dialog | Enter new style name:

Mew Style from Selection it

box appears (Figure 8). Simple Style < 0 Typing the
e Type the name of the Style in the Custom styles for current document name for
Enter new style name text box. In the style

our case, we have typed Simple Style

il

[ @ Clicking the

(Figure 8). OK button
@) Click the OK button, as shown in Help m Cancel

Figure 8. The newly created style,

Simple Style, is displayed in the Figure 8 New Style from Selection Dialog Box
Styles dialog box.

Updating Style from a Selection

Perform the following steps to update style using selection:
Selecting the Update

€@ Select the text based on which you want to create a new style. Selected Style option

@ Click on the Styles button on the Menu toolbar. A drop-down list ~ § syles ? x =
appears. GMED 28 AN

@) Select the Update Selected Style option from the drop-down list [ | NewStyle from Selection

as shown in Figure 9. Update Selected Style
Load Styles from Template

The style in the document will be updated to reflect the new '
formatting you applied to the selected text. Figure 3:  Update Selected Style

Load Style from Template or Another Document

LibreOffice Writer allows users to load styles from templates or other documents, ensuring consistent
formatting across multiple files. This feature saves time and effort, especially for collaborative projects
or document series, by promoting uniform presentation.

Perform the following steps to load style from template or another document:

€ Select the Styles button from the Menu toolbar. A drop-down list appears.

Digital Documentation (Advanced) using LibreOffice Writer
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@ Click on the Load Styles from Template —€) Clicking on the
option from the drop-down list. A Load Styles From File button
from Template dialog box appears. Load Styles from Template X

€@ Click on the From File button to select
a document (if loading from another
document), as shown in Figure 10.

If you chose From File, a file browser Will | |oier gusiness Documents

Open. Personal Correspondence and Document

@ Navigate to and select the document whose @ Parsgrphand Charscter - [ Frame O Page
styles you want to load. it - Overwrie

@ Click on the OK button to load the styles into e =N i
your document. Figure 10:  From File Button

Creating a New Style Using Drag-and-Drop

Creating a new style using the drag-and-drop method is a straightforward and efficient way to customize
your document’s formatting. This feature allows users to easily apply consistent formatting across a
document by defining and reusing styles.

Perform the following steps to create a new style using drag-and-drop:
o Click on the Styles icon in the right Sidebar. A drop-down list appears.
e Select the text based on which you want to create a new style.

e Drag and drop the selected text to the desired style category in the Styles dialog box. In our case,
we have dragged and dropped it into the Body Text category.

The New Style from Selection ., siyle from Selection %
dialog box appears (Figure 11). o Typing the
Enter new style name:

@ Type the name of the style l name of
in the Enter new style name My Body Style the style
text box. In our case, we Custom styles for current document
have typed My Body Style Simple Style
(Figure 11). S —— . - |

e Click the OK button, as shown in [ 0 gl’(‘:]gnft the

; utton
Figure 11. Help Cancel
The newly created style, My Body Style, L

is displayed in the Styles dialog box. } o
Figure 11:  New Style from Selection Dialog Box

_ACTIVITY %, \

1. Create a text paragraph in your document. Use the
Fill Format tool to change the background color of ASSESS YOURSELF & g
the paragraph. method allows users to easily apply

2. Apply the new style to a different paragraph to con3|stent formatting across a document by defining and
see the changes. reusing styles.

3. Create a new document and then load styles from 2. styles are used to format text frames and
an existing template. graphical elements like images or tables.

Information Technology
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Session 3: Working with Images

In LibreOffice Writer, images play a crucial role in enhancing the visual appeal and effectiveness of
documents. Integrating images into a document can help illustrate concepts, add visual interest, and break
up text to improve readability. The process of inserting images in LibreOffice Writer is straightforward
and versatile. Users can insert images from various sources, including files on their computer, web links,

or even directly from a clipboard.

Perform the following steps to insert an 0 Selecting the Social Media o Clicking the
image in a document: image from pictures Open button
@ Click on the Insert button from the |8 i

Menu toolbar. A drop-down list ¢ S| B e #

appears. Organice = | Pérw foider Q-0 @
@ Select the Image option from the | ® oo 1

drop-down list. An Insert Image foce

dialog box appears. e, 2 AT

+ Ovwnlosds & Camers Roll Spved Partunes Social Meda

e Navigate to and select the desired

E Docomints #

picture you want to insert. In our s
case, we have selected the Social Bk
Media picture. O #

@ Click the Open button to insert the
picture in the document as shown in
Figure 12. i ichd klade

O Linke

. . . By o
The picture gets inserted in the

< Al > (" bmp" ey -
S

Cangal

document, as shown in Figure 13. Figure 12 Inserted Image in the Document

File Edit View |Insert Format Styles Table Form Tools Window Help

B-E-B-0&QIXBER-4D- Syebs o»

JNEEEEEEEILOOF »

2

VY DOH ® M

Page10f 1 Owords, O characters Default Page Style| [l O (1) | = +—0—— +
-

Figure 13:  Inserted Image in the Document

Modifying Image

in LibreOffice Writer

are predefined sets of formatting
attributes that can be applied to
various elements of a document.

S9JAS “suy

Modifying images in LibreOffice Writer allows users to adjust visuals within
their documents to better align with their content’s needs. Once an image
is inserted, it can be resized, cropped, and rotated to fit the desired space.
Users can also adjust the image’s brightness, contrast and transparency
through the “Image” toolbar or the “Format” menu.

Note
C

You can also use the
Insert Image button

on the toolbar to insert
images into a document.

Digital Documentation (Advanced) using LibreOffice Writer 7
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Resizing an Image
Perform the following steps to resize an image:

€ Click on the image to select it. A selection frame with eight handles wil

| appear around the image.

e Click and drag one of the corners handles to maintain the aspect ratio of the image.

After resizing, you can reposition the image as needed by clicking and dragging it to the desired

location in the document.

Resize the Image Using the Right-Click Menu
Perform the following steps to resize an image using the right-click menu:

€@ Right-click on the desired image. A drop-

dOWn llSt dppears. Position and Size  Options Wrap  Hyperlink Rotation Crop Borders Area  Transparency  Macro

e Select Properties option from the right-click e [
menu. An Image dialog box appears.

€@ Go to the Type tab. bt 24

Under the Size section, you will see options
to adjust the Width and Height of the image.
Manually type the desired dimensions in

01

Anchor Preview

O To page 01
O To paragraph

&  OTochoracter %
© As character

2| to |Entire paragraph area v

these fields. (o em——
Vertical  |[Fromtop  ~| by -023

2| to |Entire paragraph area v

You can resize the image by adjusting the (0 Keep e text bundares
Width and Height values. Ensure that the
Keep ratio option is checked if you want to
maintain the image’s aspect ratio.

Help

Clicking the OK
button

0 Click OK to apply the changes, as shown in

. Figure 14:  Image Dialog Box
Figure 14. ! g g

Cropping an Image
Perform the following steps to crop an image:
o Click on the desired image to select it.

e Click on the Format button from the Menu toolbar. A drop-down list
appears.

0 Select the Image option from the drop-down list.
0 Right-click the drop-down arrow from Image option.
e Select the Crop option from the submenu.

The document displays the cropped image as shown in Figure 15.

Delete an Image

|

Figure 15:  Cropped Image

Deleting an image from a document is a simple process that allows users to maintain a clean and

organized layout.

Perform the following steps to delete an image from a document:
@) select the desired image in the document to delete.
e Press the Delete key from the keyboard.

Now, the image gets deleted from the document.

Information Technology
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Working with Drawing Objects

In LibreOffice Writer, drawing objects like shapes, lines, and text boxes help enhance documents with
visual elements. These tools are useful for creating diagrams, charts, and illustrations, making content
more engaging and informative. The Drawing Toolbar offers various tools for creating and editing these
objects.

Select tool: Allows you to select and move objects. It can also be used to resize and rotate objects.
Line tool: Draws straight lines. You can adjust the line style and thickness.

Arrow tool: Draws arrows. You can customize the arrow style, size, and direction.

Rectangle tool: Creates rectangles and squares. You can modify the corner radius and line properties.
Ellipse tool: Draws circles and ellipses. You can adjust the shape’s dimensions and outline properties.

Polygon tool: Draws polygons with a specified number of sides. You can control the number of
sides and their lengths.

Freeform tool: Draws freehand shapes. This tool is useful for creating custom shapes and designs.
Text tool: Allows you to add text to your drawing. You can format the text as needed.
Image tool: Inserts images into the drawing. You can adjust the size and position of the image.

Bezier Curve tool: Draws complex curves by defining control points. This tool is useful for more
intricate designs.

Line Style tool: Lets you customize the style of lines, such as dashed or dotted lines.
Fill Color tool: Applies colour or gradient fills to shapes.

Line Color tool: Changes the colour of the lines in your drawing.

Shadow tool: Adds shadow effects to shapes to give them a 3D appearance.

3D Effects tool: Applies 3D effects like extrusion or bevel to shapes.

Group/Ungroup tool: Allows you to group multiple objects together or ungroup them for individual
editing.

Align and Distribute tool: Aligns and distributes selected objects relative to each other or the page.

Rotate tool: Rotates objects by a specified angle.

Inserting a Drawing Object in a Document
Perform the following steps to insert a drawing object in a document:

®© ©0 0 00

Open a new or existing document. ) . )
—o Selecting the Drawing option

Click on the View button from the Menu toolbar.
. View Insert Format Styles Table Form Tools Window Help
A drop-down list appears. (3 Nomal Gl &Y
~ 3 g
Select Toolbars option from the drop-down list. v _
User Interface... n Serif v oupt v
A submenu appears. S ; 30-Settings
Select Drawing option from the submenu. A list r; ol :"i:;:’:‘:u -
. Ol Rulers - ul Y mberin
of shapes appears on the status bar as shown in N —>  Orawing
Flgure 16. Grid and Helplines i Drawing Object Properties

Select the shape from the list. In our case, we have  Figure 16:  Displaying Drawing Option
selected the Circle shape.

Digital Documentation (Advanced) using LibreOffice Writer
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The shape of the mouse pointer changes & vrites2—tiorofice wrier =@ &

File Edit View |Insert Format Styles Table Form Tools Window Help

to the crosshair shape. BB DR Bl A 1D s O il

e Click and drag on your document to  oewtzmgopnsye - @ A7 | tisewsonsert v e [ B I U~S[X >

create the drawing object. : £ : : = ‘

€) Release the mouse button to draw A

the shape. The shape is drawn on the TN i

document, as shown in Figure 17. ( ) ®

Similarl i i N 0

imilarly, you can insert more shapes in -

the document. B}

(&

Setting or Changing Properties of the »
Drawing Object

LibreOffice Writer offers a variety of tools
to enhance documents with drawing objects k& ~ ~-¥-5 < OO O AL ©-O-= -1 »
such as shapes, lines, and text boxes. These i Semtome S resdiage BEDID —o o o
drawing objects can be customized to improve ~ Figure 17:  Inserted Circle Shape

the visual appeal and clarity of your document. Setting or changing the properties of these objects allows
users to adjust attributes like size, position, colour, line style, and transparency.

Changing the Style, Width and Colour of the Border Line of the Object
Perform the following steps to change the style, width, and colour of the border line of the shape:
o Select the desired object whose width, style, and colour of border line you want to change.
e Click the down arrow button of the Line Style on the formatting toolbar. A drop-down list appears.

e Select the desired line style from the drop-down list. In our case, we have selected Double Dash
line style from the drop-down list as shown in Figure 18.

The line style of the border line of the object gets changed, as shown in Figure 19.

- > Fle Edit View |Insert Format Styles Table Form Jools Window Help @3‘
B-=-B-0D &R Bl A D AT B-HihE »
E = Default Paragraphstyle || 7 ‘24 [Liberation Serit Szt ¥ B T U-5 »
- - —
[ :J E =i
,!‘!,,,
-7 .
@
kd . D
® e Selecting the >
""""""" ‘ Double Dash G
............ . &
0 line style
] B
------ i BN—-B-%RIO0D00C0ANIC-©-=-%-0O-B- »
g &) Pageiofl OwordsOcharacters _ DefaultPagesyie MO —+—4—+ 150%
Figure 18: Displaying Double Dash Option Figure 19:  The Double Dash Line Style on the Border Line of the Object

o Click on the up/down arrows from formatting toolbar to adjust the width of the border of the
object.

Information Technology
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e Click on the Line Colour box from formatting toolbar to open the colour palette. A Line Colour
palette appears.

@ Select the desired colour from the colour palette. In our case, we have selected Dark Red 1 as
shown in Figure 20.

The border line colour of the object gets changed, as shown in Figure 21.

File Edit View Insert Format Styles Table Form Tools Window Help &
= » B-=-B-D80R B A DL S q @, »
Line Colour = loefault Paragraph Style Z|,y ,y Liberation Serif 3 12 pt Z B I »
standard = - '
EEEEEES " <

EEEEEEEEEm @
| ®
I o O
EEEEEEEN | © / =
EEEEEEEEN ) 4
(] R 0 @ selecting L 2
EEEEE- 11 4 the Dark \ / :
rk Red 1 A 4
ammE aam the D
EEEEEEEEEEEE |
colour
Recent from line
EEEEE EEEE
colour \ .
& Custom Colour... [ AR OOO0CO0OARNICO~2 s »
=] _Page 10f 1_0words, 0 characters Default Page Style B[ T — ——&8——+
Figure 20: Dark Red 1 Option Figure 21:  Changed Colour of the Border Line of an Object

Changing the Fill Colour of an Object

In LibreOffice Writer, changing the fill colour of an object, such as a shape or text box, is a simple process
that enhances the visual appeal of your document. Fill colours are used to highlight or differentiate
specific elements, making your document more

) | File Edit View Inset Format Styles Table Form Tools »
engaging and easier to read

B-E-B-0& Q@ X B R4 »

Perform the following steps to change the fill colour of — — — — (=

. . O EE IE EO0 O IE E:I v I_C'I_] I~ O |
an object: : _
€ Click on the object whose fill colour you want to o |
change. RN
/ \ 1y
e Click on the down arrow of Fill Colour ! , g
box from the formatting toolbar. A Standard k- //I
colour palette appears. S~ ©
e Select the desired colour from the colour palette. o~ N
In our case, we have selected Light Yellow 4. FIN—=-¥-5%2 00000 »
The selected colour will immediately fill the Bl fzvziznl i seniainii T o
object, as shown in Figure 22. Figure 22:  The Selected Fill Colour

Resizing and Grouping Objects

Resizing and grouping objects help manage document layouts with multiple graphical elements. Resizing
adjusts the dimensions of images, shapes, or text boxes using handles or specific values. Grouping
combines multiple objects into a single unit, making it easier to move, align, or format them consistently,
especially in complex layouts.

Digital Documentation (Advanced) using LibreOffice Writer
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Resizing Drawing Objects
Perform the following steps to resize a drawing object:

€@ Click on the drawing object that you want to resize. You will see small handles or squares around
the edges of the object.

e Move your mouse pointer over one of the handles on the corners or sides of the object. The pointer
will change to a resizing icon (a double-headed arrow).

€ Click and hold the left mouse button then drag the handle inward to reduce the size or outward to
increase the size.
Grouping Drawing Objects
Perform the following steps to group objects in a document:
Click on the first object to select it.
Drag a selection box around all the objects you want to group as shown in Figure 23.

Click on the Format button on the Menu toolbar. A drop-down list appears.

0000

Navigate to Group from the drop-down list, and then select Group from the submenu.

The selected objects will now be grouped together, as shown in Figure 24.

Which of the following toolbar
provides various tools for creating
and editing drawings and shapes?

a. Drawing toolbar

. . - - b. Format toolbar
c. Style toolbar
........................................ X

— d. File toolbar
Figure 23 Ungrouped ObjeCtS Figure 24: GrOUped Objects 1eq|oo} 6U|N\EJC| B 'suy

Positioning Image in the Text

Positioning an image within text enhances document presentation by allowing precise control over the
image’s location and text flow around it. In LibreOffice Writer, you can position the graphical objects in
different ways. Some of the ways are as follows:

Wrapping Text around a Graphical Object

The feature to wrap text around graphical objects is a powerful tool that enhances document layout and
presentation. This functionality allows you to position images, shapes and other graphical elements
within your text in a way that the surrounding text flows around the object, creating a more integrated
and visually appealing document.

Writer

Perform the following steps to wrap the text around a — Femst sye wbie fom oo
graphical object:

Spaci

€@ select the image that you want to wrap around the SIS 38 N
text. & Aﬂ:r'::ge : i ;;arallel
L2 Rotate or Flip » [ 3 Optimal
@ Click on the Format button from the Menu toolbar. A G e—
drop-down list appears. Figure 25: Displaying Before Option From Submenu
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Hover over Wrap option, this will display a submenu with various arranging options.

0

Select the desired option from the submenu. In our case, we have S
selected Before option from the submenu as shown in Figure 26. —«DID YOU KHOW!} —
e Move the image to wrap the text. You can '

also right-click on the

The text is wrapped around the selected object, as shown in Figure 26. image and select "Align

File Edit View Inset Format Styles Teble Form Tools Window Help

510 /q abs = B Y » Objects" from the
D & m-= -Q L e &g » context menu to access
: ) i aligning options directly.
A/ J
Social Media @
Social media refers to digital @
platforms and applications 0O
that facilitate
communication, interaction, 77, Y
and content sharing among [%
individuals, communities,
and organizations. It has jo)
revolutionized huw people
cooect,com GUESSWho? —
Eﬁiigﬁiii’aﬁﬁ"fmg | am a tool that allows
virtual spaces where users can share opinions, ideas, photos, Wdeos and more. a d dlng Sha dOW e f feC tS tO
- e shapes to give them a 3D

appearance.
Ans. Shadow tool

ASSESS YOURSELF . \

................................. objects can be customized to improve the visual appeal and clarity of your document.

Figure 26:  The Wrapped Text around the Image

2. e enables users to combine multiple objects into a single unit, making it easier to move, align, or apply
formatting consistently.

ACTIVITY ¥,

1. Create a new drawing object in your document using the Drawing toolbar and fill it with a colour.
2. Draw multiple shapes, resize them, and then group them together for easier manipulation.
3. Insert an image and apply text wrapping so that the text flows around the image on one side.

Session 4: Working with Template

Working with templates in LibreOffice is a convenient way to streamline the creation of documents,
presentations and spreadsheets. Templates serve as pre-designed formats that include various elements
like text styles, formatting, images and layout. By using a template, you can ensure consistency across
multiple documents, saving time and effort. LibreOffice provides a variety of built-in templates, and
users can also create and customize their own templates to suit specific needs. Templates can be easily
accessed and applied through the “File” menu, enabling efficient document creation and maintaining a
professional appearance throughout your work.

Creating a Document Using a Predefined Template

Templates in LibreOffice are pre-designed documents that serve as a foundation for creating new
documents with a consistent layout, style, and structure.

Perform the following steps to create a new document using the predefined template:

o Click on the File button of the Menu toolbar. A drop-down list appears.
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@ Select the Templates option from the drop-down list. A Templates dialog box appears.

€) Select the desired template based on which you want to create a document. In our case, we have
selected Resume (Figure 31).

Q Click the Open button, as shown in Figure 27.

Templates X A
Rp— w | re— DID YOU Know .t:(
You can press

Ctrl + Shift + N on your
keyboard to open the
Templates Manager.

Search.., Filter |Text Documents

Medern business letter sans- Modemn business letter serif Jja_ott_normal Simplified Chinese Normal
serif

€) Selecting the
desired template

mediawiki Businesscard with logo [

Default Modem Simple

@) Clicking the Open
button

Figure 27:  Templates Dialog Box

The new document is created based on the selected template, as shown in Figure 28.

Fle Edit View Inset Formet Stles Teble Forn Tools Window Help

B-=-B-DheQ B & O AN TE-HhBEHB-Q >
Body Text VD Ry | uberaton seit Vne MBI UYS[X x| A APV E > [
e L v & P A = N ote —
|
2
= You can select the
Your Name Edveaton__ ® Create a letter from this
M tine ] Coiersiy of Egngon. iy 2010 D .
- o G205 > template radio button to
(000 00000 i A B
it B Cegs e N create a document based
s Experioncs P on the letter template.
'Ham Inspector Jun 2011 - Nov 2013

‘Ham and Eggs, Co.

GUESSWho?
| am a pane where

you want to save the
document.

Skills
SePCIL T NEEES
BIN= -3 D0000ANIC-O = %-0-F- 8B F

(501 Page 101 | Towords, 388 charscters DefautPoge Stle|_English (USA) ST ROO(D -

+ 00

Figure 28:  Resume Template
uonegiAeN ‘su

Creating a Template

A template serves as a blueprint for new documents, providing predefined styles, formatting and content
layouts that can be reused across multiple projects. To create a template, users typically start by designing
a document with the desired formatting, including font styles, headings, page layouts and other design
elements.
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In LibreOffice Writer, you can create a template by using two ways, which are as follows:

From a document

Creating a Template from a Document
Perform the following steps to create a template from a document:

e From a wizard

o Open a new or existing document to use as a template.

e Edit the document as per your requirement such as formatting, adding placeholders, or including

©@ O 00

o

headers and footers.

Click on the File button from the Menu toolbar. A drop-down list appears.

Hover over the Templates option.
A submenu appears.

Select the Save as Template from the
submenu. A Save As Template dialog
box appears (Figure 29).

Type the desired name for the template
in the Enter Template Name text box. In
our case, we have typed Class Template
(Figure 29).

Select the desired category for your
template in the Select Template
Category list box. In our case, we
have selected My Templates category
(Figure 29).

Click the Save button to save the
template, as shown in Figure 29.

Creating a Template from a Wizard
Perform the following steps to create a template from a Wizard:

Save As Template X

Enter Template Name:

|Class Template < I

Select Template Category:

None ~
Business Correspondence
Drawings
Localization
MediaWiki
Other Business Documents W
< >
[ Set as default template —0
L
Figure 29: Save As Template Dialog Box

o Click on the File button from the Menu toolbar. A drop-down list appears.

(2]

Typing Class
Template
in the Enter
Template
Name box

Selecting the
My Templates
category

Clicking the
Save button

Hover over the Wizard option. e Clicking the Selecting the
A submen.u appears. Select the Next button Elegant option
Letter option from the submenu. . v %
. . Steps |
A Lettel‘ WlZal‘d dlalog bOX e Please choose the type of letter and page design
appears (Figure 30). S ——
Select the desired radio button ==t Page design
with the Please choose the type . recpient snasender e paper vith pre-prined letemhead clements
of letter and page design page.  Sfoo= © forma Persoral Letter
6.N d Locati . . -
In our case, we have selected e Page desgn
Business Letter (Figure 30). © personal Letter
Select the desired page design
fl‘0m the Page design dl‘Op-dOWﬂ @ This wizard helpsyqulu crea?ealetlertemplate.\‘uu ;anthenusethe
list_ ln our case' we have Selected template as the basis for writing letters as often as desired.
the Elegant option (Figure 30).
Click the Next button, as shown £ e Eneh conee
in Figure 30. Figure 30:  Choose the Type of Letter and Page Design Page

Digital Documentation (Advanced) using LibreOffice Writer

©Copyright 2025 by Dreamtech Press




The Select the items to be printed page appears (Figure 31).

©

Select the desired salutation from the drop-down list under the Salutation check box. In our case,
we have selected Dear Sir or Madam (Figure 31).

Select the desired option from the drop-down list under the Complimentary close check box. In
our case, we have selected Best regards (Figure 31).

©

Click the Next button, as shown in Figure 31:

Letter Wizard X
Steps
Select the items to be printed
\ Page Design L () Sselecting the Dear
M Logo .
2.Letterhead Layout =9 Sll‘ or Madaln
Return address in envelope window Option
4.Recipient and Sender Letter signs
5-Footer Subject line
6.Name and Location Y
[ Salutation Dear Sir or Madam &7
Bt €) Selecting the Best
Complimentary close » l‘egal'dS Optlon
[ Footer
@) Clicking the Next
button
Help < Back Next iy Finish Cancel

Figure 31:  Items to be Printed Page

The Specify the sender and recipient information page appears (Figure 32).

©

Select the desired radio button with the Sender’s address. In our case, we have selected New
sender address radio button (Figure 32).

Enter the details under the New sender address (Figure 32).

=Xz

Click the Next button, as shown in Figure 32:

Letter Wizard X
Steps
Specify the sender and recipient information
1.Page Design Sender's address
2.Letterhead Layout O Use user data for return address
3.Printed Items ® New sender address: <€ @ Selecting the New
4. Recipient and Sender| .
5.Footer Name: |Deepanshu Tyagi | Sender addl‘ess l‘adlo
6.Name and Location Street: |L—1231 green park street | button
Posteode/County/Post oy 10001 | [Delhi | [india |
Recipient’s address
® Use placeholders for recipient's address
(O Use address database for mail merge
@ Clicking the Next
button
Help < Back Ne» > Finish Cancel

Figure 32:  Sender and Recipient Information Page
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The Fill in the information you would like in the footer page appears (Figure 33).
@ Type the desired information to the Footer of your letter template (Figure 33).
@ Click the Next button, as shown in Figure 33:

Letter Wizard X
Steps
Fill in the information you would like in the footer
1.Page Design Footer
2.Letterhead Layout Best regards,
3.Printed ltems [Nia Sharma]
. [XYZ Organization]
4.Recipient and Sender Address: 1234 Main St, Anytown
- Phone: (555) 123-4567

6.Name and Location Email: you@example.com

[ Include only on second and following pages

@ Typing the desired
information to the
Footer text box

@ Clicking the Next
button

Help < Back Finish Cancel

Figure 33:  Filling in the Information in the Footer

The Please specify last settings page appears (Figure 34).
@ Select the Make manual changes to this letter template radio button (Figure 34).
@ Click the Finish button, as shown in Figure 34:

Letter Wizard X
Steps
Please specify last settings
1.Page Design This wizard creates a letter template which enables you to create multiple

2.Letterhead Layout letters with the same layout and settings.

3.Printed Items

4.Recipient and Sender Template name: Letter Template
5.Footer Location and file name: .
C\Users\admin\AppData\Roaming\Li breOffice\d\user\termpiate\m @ Selectmg the
Make manual
How do you want to proceed?
changes to
() Create a letter from this template . g
® Make manual changes to this letter template thlS letter
template
@ To create another new letter using the template just navigate to the radio button

template location and double-click it.

@ Clicking the
Finish button

Help < Back Next > Cancel

Figure 34:  Specifying Last Settings

A Save As dialog box appears.

@ Navigate the location for the template. In our case, we have navigated towards Documents.
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@ Type the desired name for your template in the File name combo box. In our case, we have typed
My_LetterTemplate.

@ Click the Save button.

A LibreOffice-Security Warning message box appears (Figure 35).
@ Click the Disable Macros button, as shown in Figure 35.

The Letter Template is opened, as shown in Figure 36.

Clicking the Disable
Macros button

?huitbep ot Deepanshu Tyagi

L1323, green park swrees Inia , Dalbi 10001
=

LibreOffice - Security Warning

1. My_LetterTemplate.ott

The document contains document macros.

Macros may contain viruses. Disabling macros for a document is|always safe. If
you disable macros you may lose functionality provided by the glocument macros.

Help Enable Macros Qiﬁ@b!e___hj_a_c[u_g‘

Figure 35: LibreOffice - Security Warning Message Box

Best regards,

[tz Sharma]

(X)Z Organizario]

Address: 1234 Maia St Aayiys
Phane: (555) 1234567

Email yougenmple o

Figure 36: Letter Template

@ Clicking the Save button

Setting Up a Custom Default Template

A custom default template in LibreOffice Writer can Save As Template x
streamline your document creation process, ensuring

. Enter Template Name:
that every new document starts with your preferred

settings and styles. My New Template
Perform the following steps to setting up a custom Select Template Category:
default template: Mone -

. .
0 Click on the File > Templates - Save as Template

R Business Comespondence
option from the submenu. A Save As Template

! Drawings

dialog box appears. Localization

Type the desired name for the template in the MediaWiki

Enter Template Name text box. In our case, we Other Business Documents v
have typed My New Template. < p

Select the desired category under the Select
Template Category drop list. In our case, we have
selected My Templates. Help Save Cancel

[ Set as default template

(3]
(4]
(5]

Click the Save button. The desired template is
saved as shown in Figure 37. Figure 37: Save As Template Dialog Box
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0 Click on the File button from the Menu toolbar. A drop-

o

down list appears.

Select the New = Templates option from the submenu

as shown in Figure 38.

0

New

Open.
Open Remote...

r| B
crl+0 | W

—@) Selecting the Templates option

File Edit View |Insert Format Stydes Table Form Tools

Text Document
Spreadsheet
Presentation

Cirl+N

(©  Recent Documents v Drawing

. [A Close [#  Formula

A Templates dialog box appears. e | B Dambase
. . . [0 Templates » | @ HTML Document
Click on the desired template to which you want to B A Farcs Desinia
set as a default. In our case, we have selected My New B Laveis
B save Ctrl+S Business Cards
Template- B SaveAs.. Ctrl +Shift+S ‘IE] Master Document
. . . Save Remote.. 7 [1 Templates.. Ctri+Shift+N
Right-click over the desired template and select Set S W
as Default option from the submenu as shown in i
Figure 39: Figure 38: Drop-Down List
Templates *
Filter |Text Documents|~ | |All Categories ~| Manage ¥
My New Template My Resume Modem business letter Modem business letter
sans-serif serif
Open

B Edit

[ Setas Default I

[# Rename

X Delete

ja_ott_normal B Move fse mediawiki Businesscard with logo
& e ©) Sselecting the
Set as Default
option
(o' Resume Default Modern
Help Close Open

Figure 39: Templates Dialog Box

Changing to a Different Template

To change to a different template in LibreOffice Writer, you can switch your document’s format and style
quickly by applying a new template that aligns with your preferred layout and design.

Perform the following steps to change to a different template:

Download the Template Changer extension from https:/extensions.libreoffice.org/en/extensions/
show/27416 website.

Open LibreOffice Writer. Go to Tools, then Extensions. Select Add and browse to the downloaded.

oxt file.

Select the file and right-click Open to install the extension. Restart LibreOffice Writer if prompted.

Open the document that needs to change its template. Go to File, then Templates, then Assign
Template (current document). In the dialog that appears, navigate to and select the desired
template. Select Open to apply the new template to the document.

Check the document to ensure that the styles and formatting have been updated according to the

new template.
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Updating a Document Based on Modified Template
Perform the following steps to update a k
— ASSESS YOURSELF »Y -

document based on a modified template: Lr . :
1. A custom default template in LibreOffice Writer ensures

that every new document starts with your preferred settings
and styles. (True/False)

€ Open an existing document and make
any style change.

@ Click on the File button from the Menu
toolbar. A drop-down list appears

2. provides a variety of built-in templates, and
users can also create and customize their own templates to

. suit specific needs.
e Select the Save option from the drop- \ J

down list.
ACTIVITY ¥,

1. Create a new document by selecting a predefined template
from the available options.

2. After saving the document, modify the template by changing
the font style, heading format or adding a new section.

If the document is linked to a template
and the template is updated, the
document will prompt to update styles
when opened.

@ Select Update Styles to update the styles

] 3. Download a new Writer template from the internet.
based on the new template, if prompted.

Session 5: Create Table of Contents

In LibreOffice Writer, a Table of Contents (TOC) provides an organized overview of document headings.
It generates automatically based on the applied styles, making navigation easy. Users can customize its
structure, format and update it as content changes, ensuring an accurate reflection of the document’s
layout.

Creating a Table of Contents
Perform the following steps to create a TOC in LibreOffice Writer:

@ Open a new or existing document

containing  rough  sections  and : ?:;lnf ofg;enterl:ssr?s @ Clicking the
subsections. - OK button
the Title text box.
e Click on the Insert button from the Menu S =
toolbar. A drop-down list appears. R e o prsson o
€) Hover over Table of Contents and Index —_
option; a submenu appears. T [labic o Comtents_~|
@ Sselect the Table of Contents, Index or G:plﬁ'::;::m:x%
Bibliography option from the submenu. A For. [Entire document |  Include up tolevet: 10
Table of Contents, Index or Bibliography e
dialog box appears. i
e Type the title of table of contents in the e
Title text box. In our case, we have typed
Table of Contents.
o Select the type of index from the Type
drop-down list. In our case, we have VI
selected Table of Contents. Hep__JIC]Preice R [ okl cnce
o g.lid( Z}(l)e OK button as shown in Figure 40: Table of Contents, Index or Bibliography Dialog Box
igure 40.
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The output of the document is shown in Figure 41.

x

File Edit View Insert Format Stles Table Form Took Window Help

B-0-B-0 a0 © .| Bt » GUESSWho?
[Conens hestng 5] By B [Lbentonsns M H » I am a tab to modify the
2 ; ; i : : Al R structure of TOC entries.
e e saLuyg suy
Pvmeaz@rA z
Table of Content for Practical Demonstration [ Contents Rl
imu;mz_— i Figure Ind | [
gmmmer objectind. . s
e , Table Inde [ DID YOU Know &7
5.1 i  Table of Contents. 2 A
User Index -
1. Introduction Sihifin 4 You can press
S e s e ¢l .| B the Alt + Shift + 0 to
document structure and styles. | Iis::::viewsljsmhgm - [% open the Insert Table
: : 5 = : : of Contents and Index
BIN—=-¥4- %A IO00OCOANIC~-O~=-%~-O-B-9 B F » dialoa b
= Page10f2 | 313 words, 2040 characters Default Page Style 1] DI.CD - + 5% 1a Og OX.

Figure 41:  Table of Contents in the Document

Customization of a Table of Contents

Customizing a TOC in LibreOffice Writer allows users to tailor the appearance and structure of the TOC.
Options include adjusting formatting styles, changing levels of headings displayed, adding hyperlinks, and
modifying entries. This customization ensures that the TOC aligns with specific document requirements
and enhances readability.

Perform the following steps to customize a TOC in LibreOffice Writer:
0 Right-click on the Table of Contents. A drop-down list appears.

@ Select Edit index [ aignsye x
option from the drop-

. Styles
down list. A Table of St
Contents, Index or Body Text
Bibliography  dialog Gaption

Contents Heading

bOX appears. Default Paragraph Style

€ Click on the Entries tab it - S8 -0 Selectfng the
. e - GROU0L Heading 2

to modify the structure Index Heading

of TOC entries. List level style
@ Cdlick on the Structure

line to add elements

such as page numbers, o

tabs, and hyperlinks. @ Clicking the

. . OK button

@ Click on the Styles icon W bl

from right sidebar to _

change the formatting Help x Lancel

of TOC levels.

G Click on the Assign Figure 42:  Assign Styles Dialog Box

Styles option to apply different paragraph styles to various levels of the TOC. In our case, we have
used Caption as the Heading 2 level as shown in Figure 42.

@) Click the OK button.
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G Click on the Background tab to change the background colour. In our case, we have selected Light

Gold 1 as shown in Figure 43.

Table of Contents, Index or Bibliography

Type Entries Styles Columns Background
Noe image

Colours

Palette: standard T| =
EEEET

20?
BEr EEEEE
] Light Gold 1 ...... et Hex _?29fd
 pEEEEEEEEEN

:159

= 6 1=

Recent Colours

Custom Palette
Add Delete

NMESEENNEEEEE Pick ()

x [ Quick Quiz

........................................... provides
an organized overview of
document headings.

(DOL) s3ua3u0) JO Jqe "suy

MU N INE

Help  [JPreview Reset oK

O Selecting Light Gold 1 colour
from standard palette.

Cancel

Figure 43: Displaying Light Gold 1 Colour

The output of the customized TOC is shown in Figure 44.

Table of Content for Practical Demonstration ( ACTIVITY tig = N

1. Introducti

2. Setting Up LibreOffice Writer

3. Creating a Simple Table of Contents
4. Customizing the Table of Contents

4.1. Modifying Heading Levels.
4.2. Adjusting Table of Content Styles.
4.3. Adding Hyperlinks.

5. Updating the Table of Contents.

3. Create a table of contents on the created document.
.

1. Create a new document and type at least three
sections (e.g., Introduction, Methods, Conclusion)
and apply heading styles (Heading 1, Heading 2)
from the Styles menu.

2. Apply the character style to the page numbering in
the table of contents.

J

Figure 44:  The Customized Table of Contents

Applying Character Styles

Perform the following steps to apply character styles to a TOC in LibreOffice Writer:

Click the Styles icon from the right sidebar.

Click on the desired style for the document. In our case, we have clicked on the Character Styles

icon.

Select the desired text to format. Double-click on
the desired character style in the Styles icon.

Right-click on an empty area and select New in the
Styles and Formatting window to create a new
style. Define the properties for the new character

style.
Click on the OK button.

Information Technology
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1. In the Table of Contents, Index, or Bibliography
dialog box, you cannot change the title of the
Table of Contents. (True/False)

2. e style is used to apply different
paragraph styles to various levels of the TOC.
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Summary

A word processor is a computer application that is
used to create, edit, and organize a document.

Styles allow users to apply predefined formatting to
text, paragraphs, and other elements throughout the
document.

Character styles apply formatting to specific characters
or words within a paragraph without affecting the
entire paragraph.

The “Styles and Formatting” window is a crucial tool
for managing the appearance and layout of your
document.

The “Fill Format” feature allows users to quickly apply
formatting styles from one part of a document to
another.

easily apply consistent formatting across a document
by defining and reusing styles.

Drawing objects: Drawing objects feature is
particularly useful for creating diagrams, charts, and
other illustrations that can make a document more
engaging and informative.

Grouping: Grouping in LibreOffice Writer allows you
to combine multiple objects (such as shapes, images,
or text boxes) into a single entity. This makes it easier
to move, resize, or format them collectively.

o

Images play a crucial role in enhancing the visual
appeal and effectiveness of documents in LibreOffice
Writer.

Resizing objects, such as images, shapes or text boxes,
allows users to adjust their dimensions either by
dragging the object’s handles or by entering specific
values in the position and size dialog box.

Templates in LibreOffice are pre-designed documents
that serve as a foundation for creating new documents
with a consistent layout, style and structure.

KEY TERMS

O Drag-and-drop: Drag-and-drop feature allows users to

LibreOffice Writer: LibreOffice Writer helps you create
different types of neat and attractive text documents,
such as fax documents, reports and personal and
professional letters.

Styles: Styles in LibreOffice Writer are predefined sets
of formatting attributes that can be applied to various
elements of a document.

Templates: Templates serve as pre-designed formats
that include various elements such as text styles,
formatting, images and layout.

Digital Documentation (Advanced) using LibreOffice Writer
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| LD PRACTICE QUESTIONS

Solved Questions
Multiple-Choice Questions (MCQs)

1.

Which toolbar in LibreOffice Writer includes icons
for commonly used functions such as Save, Undo
and Print?

a. Formatting toolbar b. Standard toolbar

d. Ruler
Which dialog box in LibreOffice Writer is used to

modify image properties such as size, rotation and
cropping?

c. Status bar

b. Edit menu
c. Picture settings box d. Image dialog box

a. Format dialog box

Which style category is used to apply formatting to
specific characters or words without affecting the
entire paragraph?
a. Table styles

c. Character styles

b. Page styles

d. Frame styles

Where should you drag-and-drop the selected text
to create a new style?
a. Toolbar b. Styles dialog box

c. File menu d. Status bar

Which toolbar option is used to change the fill
colour of an object in LibreOffice Writer?

a. Text Formatting toolbar

b. Table toolbar

c. Style toolbar

d. Formatting toolbar
ANSWERS

3.c.

Very Short Answer Questions

1.
Ans.

Ans.

Ans.

How can you create a template in LibreOffice Writer?
To create a template, design your database, then save it as
a template via File > Templates > Save.

What tool is used to insert drawing objects in
LibreOffice Writer?

The Drawing Toolbar is used to insert drawing objects like
shapes and lines.
How do paragraph styles affect a document?

Paragraph styles affect a document by controlling the
appearance and formatting of entire paragraphs, including
alignment, indentation, spacing, and font styles.

How can you access the template categories when
saving a document as a template?

Information Technology

Ans.

Ans.

When saving the document as a template, you will be
prompted to select a category in the “Save As Template”
dialog box.

Where can you change the formatting for each
heading level in a Table of Contents?

In the Table of Contents dialog box, under the “Styles” tab,
you can modify the formatting for each level.

Short Answer Questions-I

1.

Ans.

Ans.

Ans.

Ans.

Ans.

What are the main style categories in LibreOffice
Writer, and what is their purpose?

LibreOffice Writer offers five main style categories:
Paragraph, Character, Page, Frame, and List styles.
Paragraph styles format entire paragraphs, Character styles
focus on specific text, Page styles handle layout settings,
Frame styles customize objects like text boxes and List
styles format bulleted and numbered lists.

What is the purpose of a template in LibreOffice
Writer?

A template in LibreOffice Writer is a pre-designed
document layout that can be reused, helping users
maintain consistency in formatting across multiple
documents.

What is a Table of Contents (TOC) in LibreOffice
Writer?

A Table of Contents (TOC) is an automatically generated
list of headings and subheadings in a document that
helps users quickly navigate to different sections of the
document.

What is a word processor in LibreOffice Writer?

A word processor in LibreOffice Writer is a software
application used for creating, editing, formatting, and
printing text documents, allowing users to manage
content efficiently.

What is the function of the menu bar in LibreOffice
Writer?

The menu bar provides access to various menus such as
File, Edit, and View, which contain commands and options
for document management and editing.

Short Answer Questions-II

1.

Ans.

What is the process for wrapping text around a
graphical object in LibreOffice Writer?

Click on the graphical object to select it. Right-click and
select “Wrap,” then select the desired text wrapping
option (e.g., “Page Wrap,” “Optimal Page Wrap”). Adjust
the wrap settings if needed in the Format dialog to control
text flow around the object.

How can you set or change the properties of a
drawing object in LibreOffice Writer?
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Ans.

Ans.

Ans.

Ans.

To set or change the properties of a drawing object, select
the object and right-click to open the context menu. Select
“Properties” to access options like size, position, and style.
Alternatively, use the “Format” menu or the side panel to
adjust properties such as line width, fill colour, and effects.

How do you set the alignment of a drawing object
relative to the page in LibreOffice Writer?

To set the alignment of a drawing object, select the object,
then go to the “Format” menu and select “Position and
Size.” In the dialog box, use the alignment options under
the “Position” tab to specify how the object should align
relative to the page or margins.

How do you ensure that the styles are correctly
applied after loading from a template?

After loading styles from a template, review the styles in
the “Styles” sidebar to ensure they are applied correctly.
You can also apply these styles to various elements in your
document to verify that the formatting is as expected.

How can you rotate an image in LibreOffice Writer?
Select the image, then click and drag the green rotation
handle at the top of the image to rotate it. For precise
rotation, right-click the image, select “Position and Size,”
and set the angle in the “Rotation” box.

Long Answer Questions

1.

Ans.

Ans.

What is a Table of Contents (TOC) in LibreOffice
Writer, and why is it important for document
organization?

A Table of Contents (ToC) in LibreOffice Writer is a
structured list that outlines the headings and subheadings
within a document, along with their corresponding page
numbers. It serves as a navigational tool, enabling readers
to quickly locate specific sections of the document. To
create a ToC, LibreOffice Writer automatically generates
it based on the document’s heading styles, such as
Heading 1, Heading 2, and Heading 3. This ensures that
as the document evolves, the ToC can be updated easily
to reflect changes in the content’s structure. The ToC is
essential for large or complex documents, such as reports,
theses, or books, as it enhances readability and provides
a clear overview of the document’s organization. It helps
both authors and readers by summarizing the content and
improving navigation, which is particularly useful when
dealing with extensive information.

What techniques can you use to ensure images are
properly aligned and integrated into a LibreOffice
Writer document?

To ensure proper alignment and integration of images,
first, insert the image via Insert > Image. Use the image
handling options to position it correctly. To align the
image, select it and then use the alignment tools in the
Format menu or the toolbar, such as Align Left, Center,
or Align Right. Adjust the image’s text wrapping settings
to ensure it integrates smoothly with the text, choosing
options like Wrap Through for text to flow around the
image. For consistent spacing, use the Spacing options
in the Properties dialog box to set margins and padding
around the image.

Ans.

Ans.

Ans.

How can you format an image in LibreOffice Writer
to fit the text layout of your document?

To format an image to fit the text layout, first, insert the
image by going to Insert > Image. Select the image and
right-click to access Properties. Under the Text Wrapping
tab, select the wrapping style that suits your layout: Page
Wrap, Optimal Page Wrap, or Through. Adjust the image’s
position and alignment within the document by using the
alignment options and dragging it to the desired location.
For further control, you can resize the image and adjust
the spacing around it using the Position and Size settings
in the Properties dialog box.

How can the Freeform tool in LibreOffice Writer be
utilized to create complex shapes and designs, and
what are its key features?

The Freeform tool in LibreOffice Writer allows users to
create intricate shapes and custom designs with precision.
Accessible from the Drawing toolbar or the “Insert” menu,
it enables free drawing of lines and curves through anchor
points. This tool offers flexibility in modifying shapes,
making it ideal for detailed illustrations and unique
designs. By using the Freeform tool, users can enhance
documents with personalized and visually appealing
content.

How can you precisely position an image within text
in LibreOffice Writer, and what are the key options
available for aligning it with surrounding text?

To position an image within text in LibreOffice Writer,
use the “Wrap” options. Insert your image by selecting
Insert > Image and choosing your file. Once inserted,
click on the image to select it. A toolbar will appear; click
on the Wrap icon. Select a wrapping style: “Page Wrap”
for text flowing around the image, “Optimal Page Wrap”
for precise control, or “In Line with Text” for treating the
image as text. Adjust the image’s position by dragging or
using alignment tools in the toolbar.

Higher Order Thinking Skills (HOTS) Question

1.

Ans.

Ans.

Ans.

Alex’s document is outdated and needs to be
updated according to a newly revised template. How
can Alex update the document?

Alex should first open the document and then select
“Styles” from the sidebar. By choosing “Load Style from
Template,” Alex can apply the latest template styles to the
document, ensuring that it is consistent with the updated
template guidelines.

. Jane needs to create a presentation with grouped

drawing objects. How can she ensure they move
together?

Jane should select the objects, right-click, and select
“Group” to group them. They will now move together.

Lisa wants her table of contents to show only
specific headings. How can she customize it?

Lisa should modify the heading styles in the document and
adjust the table of contents settings to include only the
desired headings.

Digital Documentation (Advanced) using LibreOffice Writer
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Assignment
Multiple-Choice Questions (MCQs)

1.

Which document types can be created using
LibreOffice Writer?

a. Spreadsheets and presentations

b. Reports and personal letters

c. Database tables and queries

d. Graphs and charts

Which tool should you use if you want to apply a
gradient fill to a shape?

b. Fill Color tool

c. Arrow tool d.

a. Line Style tool
Image tool

After clicking on the File button, which option
should you select to save the document?

b. Save As

d. Close

a. Open
c. Print
When you drag-and-drop the selected text into a
style category, which dialog box appears?

a. New Style from Selection

b. Style Properties

c. Format Style

d. Style Manager

Which menu must you access to start cropping an
image?

b. Edit

d. View

a. File
c. Format

Very Short Answer Questions

1.

> LN

What is LibreOffice Writer?
What is a word processor?
What do you understand by Frame style?

How do you exclude certain headings from appearing
in the Table of Contents?

Can you control the distance between the text and
the graphical object?

Short Answer Questions-I
1.

What is a Paragraph style, and how does it differ
from a Character style?

What are the advantages of a predefined template?

What is the purpose of updating a document based
on a modified template?

What is the first step in creating a new template
using the Template Wizard?

What menu option allows you to delete a Table of

Contents in LibreOffice Writer?

Information Technology

Short Answer Questions-I|

1.

What steps are involved in modifying, resizing,
cropping and deleting an image in LibreOffice
Writer?

Which type of document can be created using the
“Report Wizard” in LibreOffice Writer?

What is the primary function of a word processor
like LibreOffice Writer?

What is the purpose of the ‘Load Styles’ feature in
the Styles and Formatting window?

What are the benefits of using graphical objects in a
writer document?

Long Answer Questions

1.

Describe the process for applying a style to text
using the Fill Format option in LibreOffice Writer,
including how to access the Styles and Formatting
window.

Describe the procedure for generating and
customizing a Table of Contents (ToC) in LibreOffice
Writer.

Explain the process of creating a professional
document layout in LibreOffice Writer. Discuss
the steps for setting up page margins, configuring
header and footer settings and applying styles to
ensure consistency throughout the document.

How can you use the drag-and-drop method to
create a new character style in LibreOffice Writer,
and what steps should you follow to edit this style
later if you change the text formatting?

How would you go about creating a new table
style based on a table you have formatted in your
document, and what is the process for updating
this style if you later alter the table design or cell
formatting?

Lab Activities

1.

Anjali is a content creator at a company called
TechPro Solutions. Her manager, Alice, has asked her
to create a professional report using a predefined
template. The company has several report templates,
but you need to customize one to meet specific
branding guidelines. The goal is to:
O Open an existing template in LibreOffice Writer.
O Modify the title style by changing its font size to 18pt,
the colour to blue, and making it bold.
Add the company's logo to the header.
Save the changes as a new template named "TechPro_
Report_Template" and apply it to a blank document.

You are working on a research document for your
company, "Tech Innovators Inc.," and the document
has multiple chapters and sections. The company
requires you to include a Table of Contents (TOC) at
the beginning of the document for easy navigation.
Your task is to format the document headings,
create the TOC, and ensure it is dynamically updated
whenever changes are made in the document.
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Electronic Spreadsheet (Advanced)
using LibreOffice Calc

Introduction

LibreOffice Calc is a versatile spreadsheet application within the
LibreOffice suite, designed for data analysis and management. It features
advanced calculations, chart generation and data visualization tools,
making it suitable for both casual and professional users. Calc supports
various file formats, including Microsoft Excel, ensuring easy sharing and
collaboration. Its extensive functions and data manipulation capabilities
allow for efficient handling of complex analyses and organized data.

In today’s digital age, counting and calculations are essential from daily
tasks to professional work. Spreadsheet software, like LibreOffice Calc,
helps manage large datasets efficiently, similar to an accountant’s ledger.
This supplement explores advanced spreadsheet features, including data
analysis, automation with macros, linking multiple sheets, collaborative
editing, enhancing decision-making and streamlining tasks across shared
documents.

In this unit, you learn about how to open LibreOffice Calc. Next, you
learn about the concept of data analysis. After this, you learn how to
link data and spreadsheets. Further, you learn how to share and review
spreadsheets. Towards the end, the chapter discusses the concept of
macros in spreadsheets.
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Session 1: Opening LibreOffice Calc

To open LibreOffice Calc, start by clicking on the Start Menu (Windows) or Applications Menu (Linux)
on your computer. Next, type LibreOffice into the search bar to locate the LibreOffice suite. Select Calc
Spreadsheet from the list of applications. Wait for the program to load, and once it opens, you will see a
blank spreadsheet ready for use as shown in Figure 1:

3
Active cell :

Title bar | | Window control buttons |

Standard
toolbar

Untitled 1 - LibreOFfice Calc

Formatting
toolbar

Column
headings

—
Input line B 2
El Vertical
Row 5] scrollbar
numbers B4
16 | PR
Navigation e
buttons and = Horizontal

sheet tabs 121 v scrollbar

4 | Sheet1
Status bar Sheet1of1 | | Default English (India) | |mi| @] | Average:;sumo | — & + | 100%Y Zoom controls

Figure 1:  LibreOffice Calc Window

The LibreOffice Calc window comprises the following components:

Title bar: Displays the name of the currently open workbook. Note [—

Window control buttons: Allow you to minimize, maximize/restore

and close the LibreOffice Calc window. Ina spreadsheet,

the term "function”

Standard toolbar: Consists of tools for performing basic functions, encompasses a broader
such as open, save, copy, cut and paste. range of capabilities
beyond just mathematical

Formatting toolbar: Consists of tools for formatting the text. functions

Column headings: Refer to the names of the columns.

Sidebar: Contains the icons for displaying various panels, such as Properties, Styles and Formatting,
Gallery, Navigator, and Functions. It is located to the right of the LibreOffice Calc window.

Vertical scrollbar: Allows you to move the worksheet in vertical direction (up and down).

Cell: Refers to the area of intersection of a row and a column.

GUESSWho?

| am a toolbar that consists
of tools for performing
basic functions, such as
open, save, copy, cut, and
paste.

Horizontal scrollbar: Allows you to move the worksheet in horizontal
direction (left and right).

Zoom controls: Allow you to zoom in or zoom out the worksheet.
Menu bar: Consists of menus, such as File, Edit, View and Insert.

Name box: Displays the address of the active cell or a range of selected PIEPUEIS SV

cells.

Information Technology
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o Active cell: Refers to the cell that is currently active. It is the cell where the data you enter will be
placed. You can only enter data in an active cell.

e Input line: Contains the content of the selected cell or formula applied to the selected cell.
e Row numbers: Refer to the numbers of the rows.

e Navigation buttons and sheet tabs: Allow you to navigate from one worksheet to another in a
workbook. Sheet tabs display names of the worksheets present in a workbook. You can change the
default name of a worksheet by double-clicking its sheet tab and typing the desired name in the
Rename Sheet dialog box.

e Status bar: Displays information about the current worksheet.

ASSESS VOURSELF: .

................................. refers to the area of intersection of a row and a column.

2. The sidebar in LibreOffice Calc is located at the bottom of the window and contains icons for displaying various panels.
(True/False)

Session 2: Data Analysis

Data analysis in LibreOffice Calc involves organizing, interpreting and visualizing data using features such
as formulas, functions, and charts. It allows users to efficiently analyze trends, patterns and insights from
datasets, aiding in informed decision-making and reporting.

Consolidating Data

Consolidating data in LibreOffice Calc combines data from multiple sheets or ranges into a single
summary. It simplifies data analysis by aggregating information, offering insights from various sources at
once. Perform the following steps to consolidate the data in LibreOffice Calc:

o Ensure that the data to consolidate is organized in separate sheets, with the same layout (i.e., the
same columns in the same order) as shown in Figure 2:

PO c E—— s 1« o | e T T T N - =
1 ID Name Department Salary Name Department Salary A 1D Name Department Salary &
2| 1 Anil Kumar HR 50000 Meena Reddy HR 52000 < !T| Pooja Iyer HR 54000

52 Sunita Shama iy 75000 Vikram Bana I 78000 a= 1 Ajay Menon T 82000 | &

4| 3 RajeshGupta  Finance 65000 Neba Verma  Finance 67000 ® 13 Kav,iia Desai Einance 70000 I 6]
5 4 PrivaSingh  Marketing 55000 Amitabh Joshi  Marketing 60000 e 14 N Nai Marketi 58000 fe

B 5 DepkMcw T Rodhika Patcl 1T 85000 Shyam Nair arseng ’

z 15 Sneha Kulkarni T 88000 g
«

Vo shett  Sheetr | sheets 1 _Shest?  shess G40 0 d e | S | Shews

Figure 2:  Data for Consolidation

Open a new sheet by right-clicking the plus sign before Sheet1 ( =) and name it Consolidated
Sheet by double-clicking the sheet name.

e Click the Data button from the Menu toolbar. A drop-down list appears. ?_
_ . _ : —=DID YOU Know & §j —
o S.elect the Consolidate option from the drop-down list. The Consolidate If you frequently -
dialog box appears. consolidate the same cell
@ Select the function that you want to use for consolidation (e.g., Sum, ranges, you can convert
Average, Count, Max, Min, etc.) from the drop-down list in the Function them into reusable
section. In our case, we have selected Sum. named ranges to simplify
o the process.

Enter the range for the first data set from Sheet1. In our case, we have J
entered (Sheet1.A1:D6).

Electronic Spreadsheet (Advanced) using LibreOffice Calc
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o Click the Add button to add the ranges you want to |« o ;i T =(o
consolidate. 1 Name! ‘Depancmem ‘Salaryn ‘ ‘
[2] 1 50000
o Repeat step 7 to add further ranges from Sheet2 and |- 2 75000
4 3 65000
Sheet3. In our case, we have entered range (Sheet2. [+ 4 55000
A1:D6) from Sheet2 and the range (Sheet3.A1:D6) from -+ : oo00
Sheet3. o] 7 78000
9 8 67000
o Configure Options by checking the Row labels " o000
and Column labels boxes for adding labels in the = » ireed
Consolidated Data sheet. ] 13 70000
| 14 58000
@ Click OK button to consolidate the data. The final = 15 —88000

output shown in Figure 3. Figure 3:  Consolidated Data

Creating Subtotals

Subtotals in LibreOffice Spreadsheet are intermediate summaries that help break down data into smaller,
manageable sections for better analysis and understanding. They are used to perform calculations, such
as sums, averages, counts, or other functions, on specific groups of data within a larger dataset.

Perform the following steps to create a subtotal:

Copy the data in Sheet2 and Sheet3 and paste it in Sheet1after ID 5.

Select the range of data to add subtotals. In our case, we have selected cell range A1:D16.

Click the Data button from the Menu toolbar. A drop-down list appears.

Select the Subtotals option from the drop-down list. The Subtotals dialog box appears (Figure 4).

Select the desired option from the Group by drop-down list based on which you want to group the
subtotal. In our case, we have selected Department (Figure 4).

Select the desired check box under Calculate subtotals for list box to specify the column where you
want to apply the subtotal. In our case, we have selected the Salary check box (Figure 4).

Select the desired function under the Use function section to calculate the desired subtotals. In our
case, we have selected Sum (Figure 4).

© © 0 00000

Click the OK button, as shown in Figure 4.

The output is shown in Figure 5.

KE-=m
Subtotals X o
Name Department Salary
1stGroup  2ndGroup  3rdGroup  Options = Rajesh Gupta Finance 65000
Group by: [ select all columns 183 Nﬂlﬂ y‘gm Ei::zz: 2{7]$g
Calculate subtotals for: Use function: ooeeooooooi.........___ FinanceSum 202000 |
- 7 1 Anil Kumar HR 50000
O S e
[ Name Count :
11 Pogja Iyer HR 54000
Avaoge T | L0
[ Salary Mazx =l TR Sun -'['g'§'h'g'!m"'g"""i—'r""""'m""
Min 5 Deepak Mehta T 80000
Product 7 Vikram Batra T 78000
Count (numbers only) 10 Radhika Patel T 85000
StDev (Sample) 12 Ajay Menon 1T 82000
StDevP (Population) Sneha
Var (Sample) 15 Kulkami 1T 88000
VarP (Population)
crmcgommeee) oo e MIES U SOUOUORES
= 4 Priva Singh  Marketing 55000
9 Amitabh Joshi  Marketing 60000
14 ‘Shyam Nair Marketing 58000
Marketing Su» 173000
Help Reset Remove oK Cancel Grand Sum
Figure 4:  Subtotal dialog box Figure 5:  Subtotal Output
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Using What-If Tools

What-If tools in LibreOffice Spreadsheets are powerful features designed to analyze and forecast potential
outcomes by altering the input data and observing the resulting changes. These tools allow users to
explore different scenarios and make informed decisions based on various potential future conditions.
The primary What-If tools, including Goal Seek, Data Tables, and Scenarios, are as follows:

e Scenarios: It allows users to define and save different sets of input values to compare various
potential outcomes.

o Goal Seek: It is used to find the input value needed to achieve a desired result in a formula.
o Solver: Solver is a toll in LibreOffice Calc that optimizes a target cell's value by adjusting multiple
variables, subjected to specific constraints.

Using Scenario

A What-If scenario is a collection of variables that can be plugged into a spreadsheet’s calculations. Each
scenario is assigned a unique name, allowing you to create multiple scenarios within the same sheet.
These scenarios are helpful for exploring and comparing different outcomes based on varying conditions.

Perform the following steps to use What-If scenario:

€ Create the following sheet as shown s E—— ‘ \ 0 \
in Figure 6. Enter the function Loan Amount 10000000 Time Period (Months) 144
=ABS(PMT(B3/1200,D2,B2)) for Rate of Interest 19.00%
calculating EMI, =B4*D2 for EMI 70244.616720371
Total Amount Paid 10115224.8077334

calculating Total Amount Paid, and
=B5-B2 for Total Interest Paid.

Total Interest Paid 115224.807733428]

Select tl?e Ce“.S B2 and D2 using Figure 6:  What-If Spreadsheet
Ctrl + Right-click on these cells, as
these two are the variables in this situation.

Create Scenario X

Click the Tools button from the Menu toolbar. A drop-down |
list appears. * [scenario?

Click the Scenarios button from the drop-down list. A c"cﬂ"':b s
. . reats ,on L 14:51:
Create Scenario dialog box appears (Figure 7). !

Type the desired name of the scenario in the text box. In
our case, we have typed Scenario_1 (Figure 7).

Settings
Select the Display Border check box to display a border A Display border | E20] #00c0C0 -
around the scenario. In our case, we keep the display Cliony back

[ Copy entire sheet
Prevent changes

border as a default (Figure 7).

Uncheck the Copy back check box to not modify the o o ] ome
scenario while changing the values (Figure 7). - _

Click the OK button to add this to the scenario list as shown  F9ure7:  Create Scenario dialog box
in Figure 7.

© 060 0606 0606 ©

Modify the values in the scenario to create a new scenario.

In this example, we modified the value of Loan Amount to 15000000 and Time Period (months) to
180 in first case and Loan Amount to 35000000 and Time Period (months) to 120 in second case.

Electronic Spreadsheet (Advanced) using LibreOffice Calc
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[10)

(1)

i | |

R.epeat Step§ 3 to Step 7 and Fhange the colour to ‘nght ] B e >
Lime l.and Light Gold 1 respectlvely. Name the scenarios as Loan Amount |22 | i

Scenario_2 and Scanario_3 respectively. ] Scenaro 3

- - Rate of Interest 19.00%

Right-click the down arrow button of the scenario to switch | EMI 70244.616720371

from one scenario to another. Select the scenario you want Total Amount Paid 10115224.8077334

to dlSplay, as Shown In Flgul’e 8 Total Interest Paid 115224.807733428
e et et ettt ™l

Using Goal Seek Figure 8:  Switching Scenarios

Goal Seek in LibreOffice Spreadsheet is a powerful tool used for what-if analysis. It allows users to
determine the input value needed to achieve a specific goal or result in a formula. By automating the
process of trial and error, Goal Seek simplifies complex calculations and helps users make informed
decisions based on specific targets or goals.

Perform the following steps to use the Goal Seek tool for analyzing data:

(1]
(2]

© ©0 0 00 0O

© 60

12)

Open a new or existing spreadsheet containing the data you want to analyze. In this case, we have
used the data as shown in Figure 9.

2 I N
Select the desired cell. In our case, we have selected B7 for Sé‘r']';:;;‘ M:L"S
calculating the average marks obtained as shown in Figure 9. Hindi 00
Click the Tools button under the Menu toolbar. A drop-down list Megz;r:::‘:s %0
appears. « | General Knowledge 85
i i A 71.25
Select the Goal Seek option from the drop-down list. vorsge

Select the desired cell with the formula you want to achieve a  Figure 9: Goal Seek Data

target. In our case, we have selected cell B7. The address of the s x

selected cell appears in the Formula cell text box. Default Settings

Enter the desired value in the Target value text box to specify the e =

result you want. In our case, we have entered value 70 (Figure 10). meeut - DI
Variable el =

Enter the desired value in the Variable cell text box to specify the
cell whose value needs to change to reach the target. In our case, UER
we have entered B5 (Figure 10).

Cancel

Figure 10:  Entering Goal Seek
Click the OK button (Figure10). Variables

Clicking the OK button triggers an error in LibreOffice Calc if the Variable cell is empty. A dialog box
will prompt you to enter a 0 value in the cell.

Click the Yes button on the error dialog box, which will automatically add a 0 in the variable cell.

Repeat step 3 and step 4 to re-enter your target and variable cells & S PREETTTTT

as before, and proceed. | Subject Marks
. . English 60

Click the OK button (Figure 10). Hi?\di 90

The LibreOffice Calc will display a dialog box asking whether to Mast::::g‘:s 38

update the cell with the calculated value. . General Knowledge a5

Average

Selecting the Yes button will replace the original value with the
calculated one in the sheet. The final output is shown in Figure 11.

Figure 11:  Goal Seek Output

Using Solver

The Solver in LibreOffice Spreadsheet is a tool used for optimizing complex decision-making problems
by adjusting variables to achieve a desired outcome, such as maximizing profits or minimizing costs. It
defines an objective cell for optimization, variable cells for adjustments, and constraints to guide the
solution.

Information Technology
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Perform the following steps to use Solver for analyzing data:

€ Open a new or existing spreadsheet that contains data. In our case, . ——
. ]| Category Amount

we have opened a new spreadsheet and entered the data as shownin - Income 3000
H : Rent 800
Figure 12. B Utilities 150
. . Groceries 250
@ Click the Tools button from the Menu toolbar. A drop-down list = orene 100
appears. ’ Savings 1700

. . . I Total Expenses -

Select the Solver option from the drop-down list. A Solver dialog box oo s

appears. Figure 12:  Solver Data

Select the desired cell from the sheet for the Target cell text box to specify the goal. In our case,
we have selected B7.

Select the desired radio button for the Optimise result to specify the value for the target cell. In
our case, we have selected Maximum option

©@ 0 0 0

Select the cell ranges for By changing cells ;g conditions

to specify the cells that you want to change T S W 4
for achieving the set objective. In our case, 5B+ 2]l [¥] o [=][®
we have selected the cell B8. The output of | 52 ] [
data is shown in Figure 12.
in Fig | =5 | =
€) Enter the desired cell for the Cell reference | =1 F| =
text box under the Limiting Conditions
section as shown in Figure 13. Figure 13:  Limiting Constraints dialog box
‘ "
@) Click the Solve button. A Solving Result dialog box appears. Category Auoant
@) Click the Keep Result button to verify the output provided by e pe
LibreOffice Calc, if it’s correct. Otherwise, click the Restore Previous Groceries 250
button. In our case, we have clicked on Keep Result. The output of the Em;:ff:;em 117200

Total Expenses

1250

Figure 14:  Solver Output

ASSESS YOURSELF (@ : \

................................. is a collection of variables that can be plugged into a spreadsheet’s calculations.
2. Goal Seek is a What-If tool that helps find the input value needed to achieve a desired result in a formula. (True/False)

Solver tools is shown in Figure 14.

Session 3: Linking Data and Spreadsheets

Linking data and spreadsheets in LibreOffice Calc allows you to connect and update data across multiple
sheets or external sources. This feature ensures data consistency and automates updates when source
data changes. It’s useful for managing complex datasets, consolidating reports or referencing data from
different sheets without manual copying, enhancing efficiency and accuracy.

Setting up Multiple Sheets

When a new spreadsheet opens, it contains only one
sheet named as Sheetl. Open a new sheet by right- 2
clicking the plus sign before Sheet1 ( +/). A new sheet 2
opens named as Sheet2. If required, you can add more
sheets in the spreadsheet and rename them according <
to your needs. Before you perform any of the tasks, 44 » M 4 Sheetl | Sheet2 | Sheetly Sheetd |
you need to select the sheet you want to work on the SSS—
sheet tab as shown in Figure 15.

Figure 15:  Displaying the Sheet Tab
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Creating References Between Sheets

Creating references between sheets in LibreOffice Calc allows you to link data across multiple sheets,
making it easier to manage complex datasets. By referencing cells from other sheets, you can consolidate,
compare, or calculate data seamlessly.

(1]
(2]

Referencing a Cell in Another Sheet G e et o e S Do e 0@
. . . B-o-B-D@@ XBE-a 40
Perform the following steps to reference a cell in another sheet: B I U-A- »
Open a new or existing worksheet that contains data. In our case, " T M
we opened a new worksheet and saved it as Demonstration.ods. ! |Month Sales 12
2 [January 1000 =)
Enter the following data as shown in Figure 16 in Sheet1 and create i:b“ﬁ“y iggg @
@ arc
another sheet. 5 |April w0 |
s [May 1600
Go to Sheet2. Select a cell where you want to place the reference. In June
our case, we have entered data in Sheet2 as shown in Figure 17, and @ ol
selected B2 cell in Sheet2 for the reference. e S — .
Enter the following Formula =Sheet1.B3 in cell B2 to pull values Figure16: Demonstration.ods Data
from Sheet1 to create summaries or perform calculations. At-= | =
. . A B =
Press Enter key in the keyboard. The output will be the Salgs Month Sales .
data from Sheetl of the month of February as shown in February =
Figure 18. s April ®
. . |3
Continue to enter the following formulas =Sheet1.B5 and - Tli:t;I f
=Sheet1.B7 to reference the Sales amount of the months April

©o o 060 o

and June respectively. Figure 17:  Selecting the B1 Cell

Select cell B5 in Sheet2 and enter the formula =Sheet1.B3 + Sheet1.B5 + Sheet1.B7 to obtain sum
of the sales in the three months by referencing from Sheet1.

Press the Enter key in the keyboard.

This will add the sales from February, April and June and display the total, which is 5300 as shown
in Figure 19.
] . — T
Month Sales
February 1500
nApril
4 June

Total

~

® g & [

=

5
6

Figure 18:  Referencing Data from Sheet1 Figure 19: Displaying Total Sales of Three Months

Creating References from Other Documents
Perform the following steps to reference a cell from another document:

(1]
(2]
(3]
(4]

Open a new spreadsheet by selecting the File > New = Spreadsheet option from the Menu toolbar.

Enter the required information in the spreadsheet as shown in [« G T =[emsme || =
. A B ~
Figure 20. 1 A
Enter the = formula in B1 cell. : . g
< >i

Click the Window button from the Menu toolbar. A drop-down <’ + s &

. Shest 101  Default English (USA) [1] - ————+ | 2009
list appears. Figure 20:  Information in the spreadsheet
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@ Select the Demonstration.ods option from the drop-down list. & q & E-=] I~ =
. A 5

The Demonstration.ods spreadsheet appears. 1 Total Sales 5300 A

e Select the relevant cell in the demonstration spreadsheet and . Eg
return to the new spreadsheet. IR ™ L

Sheet10f 1 Default English (UsA) | 1] — ————— + | 2003

@) Press the Enter key from the keyboard. Figure 21:  Referencing Cell from

The referenced cell will show the exact value, as shown in Figure 21. Another Document

Using Hyperlink in LibreOffice Calc

Ahyperlink in LibreOffice Calc is a clickable link that navigates to a web page, another sheet, a specific cell,
or an external document. It’s useful for quickly accessing related resources or data within a spreadsheet.

Hyperlinking External Sheet
Perform the following steps for hyperlinking external sheet:

o Open a new or existing spreadsheet that contains some data. In our case, we have selected the
previously saved Demonstration.ods.

Open a new spreadsheet. Select the desired cell where you want to insert the hyperlink.
Click the Insert button from the Menu toolbar. A drop-down list appears.

Select the Hyperlink option from the drop-down list

A Hyperlink dialog box appears.

Click the Document button in the list box to create a hyperlink to the document.

The Hyperlink dialog box shows the options to insert a document hyperlink.

Right-click the folder icon in the Path field and navigate to the
external sheet (Demonstration.ods).

Target in Document X

Click the Target in Document button in the Hyperlink dialog box. The
Target in Document dialog box appears (Figure 22).

Sheet1
Select the desired sheet that you want to use for the hyperlink. In our <J Range names
case, we have selected Sheetl. Database ranges
Click the Apply button as shown in Figure 22. .
Click the Close button in the Hyperlink dialog box to close it. Close

The hyperlink is displayed in the spreadsheet as shown in Figure 22.

Figure 22:  Targetin Document

Enter #Sheet1 in Text option in Further Settings shelf. Di
ialog Box

Click the OK button.

The reference of hyperlink is shown in Figure 23.

@G0 60 0 ©0 0 O 0060

= |-

&
= B-E-B-Dael XHhkR-a 54 »
B S—— Qs B I U<l A/ <
o G SR —
A B | c %
Wisheetl | N
) @
] L ()]

Figure 23:  Hyperlink
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Hyperlinking Registered Data Sources “~

Perform the following steps for hyperlinking registered data source: —=DID YOU Know.’; =
. . . The reference
o Click the Tools = Options = LibreOffice Base - Databases. for a file includes three
e Click the New button to register a data source (e.g., an existing database forward slashes (///),
or spreadsheet). whereas a hyperlink
f tains t
e Select the cell where you want to insert the hyperlink. Go to Insert —> ][grsvraepd(:ilgzﬂein(w/'s/)-\/vo

Hyperlink. )

o Choose Internet on the left panel and select Database. In the URL field, enter the registered data
source URL (e.g., sdbc:embedded:hsqldb:dataSourceName). Optionally, set the table or query
within the data source that you want the hyperlink to access.

e Click the Apply —> Close to create the hyperlink. Clicking on the hyperlink will open the registered
data source, allowing you to interact with the specified table or query.

J

— }g =
1.AC(r:e.!|-tIe‘£Is-!a-leYs performance table with targets ASSESS YOURSELF ’Y@

for various products, using the Goal Seek feature | | 1+~ allow users to manage and organize data
to determine required sales volumes for specific across several separate tabs within one file in LibreOffice
revenue targets. Link data across multiple sheets, Spreadsheet.
add a hyperlink to the registered data source, and 2. allows you to link data across multiple
demonstrate retrieval. sheets, making it easier to manage complex datasets.

(. J

Session 4: Sharing and Reviewing Spreadsheet

LibreOffice Calc provides the facility of sharing a spreadsheet at a location on a network from where
multiple users can work on the spreadsheet at the same time. Sometimes, many people review the
spreadsheet before it is marked as final or submitted for printing. While reviewing the spreadsheet,
every reviewer can give their suggestions in the form of comments or can directly change the content.
After reviewing the document, a final draft of the spreadsheet is prepared, incorporating all the

suggestions and changes in it, if there are any. B Wiadow Help
. ) ® Spelling. |
Setting Up a Spreadsheet for Sharing ' Automatic Spell Checking ShiftsF7
Perform the follov_ving steps for setting up a g oo i
spreadsheet for sharing: fu AusoGomed Optons..
o Open a new or existing spreadsheet. In our —
case, we have opened the Demonstration.ods Redact
worksheet. Auto-Redact
. %% Goal Seek_
e Click the Tools button from the Menu toolbar @ Solver.
(Figure 24). A drop-down list appears (Figure = Detective ,
24).
Forms '
@) Select the Share Spreadsheet option from the /[ sha Spresdshect. L €) Selecting
drop-down list as shown in Figure 24: Protect Sheet.. the Share
% Protect Spreadsheet Structure_
A Share Document dialog box appears [ macos - Spreadsheet
(Figure 25). [F Development Tools option
r" XML Filter Settings—

Figure 24: Share Spreadsheet Option
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o Select the Share this spreadsheet with other users check box (Figure 25).
@ Click the OK button as shown in Figure 25.
A LibreOffice Confirmation message box appears (Figure 26).

0 Click the Yes button to activate the sharing mode as shown in Figure 26.

Share Document x ‘

[ Share this spreadsheet with other users

Note: Changes to formatting attributes like fonts, colours and number formats will Cthlﬂg the
not be saved and some functionalities like editing charts and drawing objects are
not available in shared mode. Turn off shared mode to get exclusive access OK button

needed for those changes and functionalities.

Users Currently Accessing This Spreadsheet @) Clicking the

Yes button
Name lAccessed | —
DESKTOP-5RHDCBO/admin (exclusive 09/04/2024 11157 11:57 Confirmation X
e e} O The spreadsheet must|be saved now to activate sharing mode.
Do you want to continue?
: Y
Help oK [ Cancel No
Figure 25:  Share Document Dialog Box Figure 26:  Confirmation Message Box

Opening and Saving a Shared Spreadsheet

Perform the following steps for opening and saving a shared spreadsheet:
o Click the File button from the Menu toolbar. A drop-down list appears.
e Select the Open option from the drop-down list that appears. An Open dialog box appears.
e Navigate the location of the desired file.

@ Select the desired file from the location. In our case, we have selected the Demonstration.ods

spreadsheet.
© Click the Open button. x
The spreadsheet is in shared mode. This al Itiple users to
When you open a shared document, the ! e e e i
LibreOffice message box appears that shows
.. . ‘Changes to formatting atiributes like fonts, colowrs and number formats will not
the spreadsheet is in shared mode. This allows be saved and some functionalities ike editing charts and drawing objects are not
. . available in shared mode. Turm off shared mode 10 get exclutive Soceds nesded
multiple users to access and edit the spreadsheet for those changes and functionalities.
at the same time, as shown in Figure 27. [ 0o not show warming again
(@) Click the Save As option under the File button =
from the Menu toolbar. To save the desired file. Figure 27:  LibreOffice Message Box
Adding, Editing and Formatting Comments .
Perform the following steps for adding, editing and formatting comments: Note| <]
@ Select the cell where the comment will be added. Right-click and | When the cursor
choose Insert Comment. Enter the comment text and click outside the is hovering over a cell
comment box to save it. containing both a change
) ) . . ) comment and a general
@ Right-click the cell with the comment. Choose Edit Comment. Modify | comment, a tooltip will

the comment text and click outside the comment box to save changes. display both comments.

@) Select the text to format, while editing a comment. Use the Formatting
toolbar to apply formatting (e.g., bold, italics, font size).
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Reviewing Changes — View, Accept or Reject Changes
Perform the following steps for reviewing changes — view, accept or reject changes:
o Click on the Edit = Track Changes = Show to see all tracked changes.

e Click on the Edit - Track Changes - Manage Changes. In the Manage Changes dialog box, review
each change. Use the Accept or Reject buttons to accept or reject the changes.

_ ASSESS YOURSELF 3.

_ACTIVITY ¥%, \

) ) 1. When you open a shared document, a message
1. Create a spreadsheet that will be shared with team members box indicates that the spreadsheet is in private
for a project. Include the following steps: mode, allowing only one user to access and edit
a. One student will upload a spreadsheet to a shared drive or it. (True/False)
platform. 2. LibreOffice Calc allows multiple users to work
b. The other student will open the shared spreadsheet, make on a spreadsheet simultaneously from a shared
some changes (e.g., add new data, format cells), and save it. network location. (True/False)
. AN J

Session 5: Using Macros In Spreadsheet

A macro can be defined as a set of commands or actions that are recorded and then executed in a
spreadsheet when required. Macro provides the facility to reuse the recorded action in a spreadsheet
several times when required, thereby making your work easier. By using macros, you can reduce the
wastage of time in performing repeated tasks.

Record a Macro in LibreOffice

Recording a macro in LibreOffice Calc allows you to automate repetitive tasks, saving time and reducing
errors. Perform the following steps to record a macro:

€@ Click Tools > Macros = Record Macro to begin recording. A small NOte.E
dialog box with a Stop Recording button will appear, indicating that Each library
the macro recording is active. Make sure to enable macro recording container includes a
under Optional Features. By default, this feature is turned off in Standard library.
LibreOffice Calc.
Enter the desired text that you want the macro to execute. For instance, type your name.
Click the Stop Recording button in the small dialog box. This will open o
the Basic Macros dialog box. Open the library container, My Macros. DID YOU Know §

Locate the library named Standard within My Macros. You can also
. .. press Alt+F11 from the
Select the Standard library and choose an existing module to save the keyboard to open a Basic

macro. Alternatively, you can create a new module by clicking New Macros dialog box.
Module.

0 In the Macro Name text box at the top left section of the dialog box, enter a name for the macro,
such as EnterMyName.

0 00

€) Click Save button to save the macro and close the Basic Macros dialog box.
Creating a Simple Macro as a Function
Perform the following steps for creating a simple macro as a function:

o Click the Tools - Macros = Organize Macros —> Basic for opening macros editor. Select Libraries
from Organizer dialog box. Ensure the Location dropdown is set to My Macros & Dialogs.

Information Technology
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e Click the New button, enter a library name (e.g., Library2), and click OK button. In the Modules tab,
expand My Macros and select your library (Library2). Use the existing Module1 or create a new
module by clicking New.

e Select the module (e.g., Module1) and click Edit to open the Integrated Development Environment
(IDE). Insert your macro code into the module. For example:

Sub HelloMacro Warning *
Print Hello
Hello
End Sub !
Sub Main
End Sub
Then click on Run or press F5. Choose the HelloMacro and click on Run.

The output is shown in Figure 28. Figure 28: Basic Macros

Passing Arguments to a Macro
Perform the following steps for passing arguments to a macro:
o Open the macro editor and enter the following code:

Function PositiveSum(Optional x)
Dim TheSum As Double
Dim iRow As Integer
Dim iCol As Integer

TheSum = 0.0
If NOT IsMissing(x) Then
If NOT IsArray(x) Then

If x > 0 Then TheSum = X

Else

For iRow = LBound(x, 1) To UBound(x, 1)

For iCol = LBound(x, 2) To UBound(x, 2)

If x(iRow, i1Col) > 0 Then TheSum = TheSum + x (iRow,

iCol) GUESSWho?
Next | am a set of commands or
Next actions that are recorded
End If and then executed in
End If a spreadsheet when
PositiveSum = TheSum required

End Function

01BN “SUY

e Assign the macro to a button or call it from another macro with =PositiveSum(7).

Passing Arguments as Values

In LibreOffice Calc, arguments are values or references that you pass to functions in order to perform
calculations or operations. Understanding how to use arguments effectively allows users to leverage
the full power of spreadsheet functions, making data analysis more efficient and effective. Perform the
following steps for passing arguments as values:

o Open the macro editor and enter the following code:

Sub MultiplyValues (a As Double,
Dim result As Double

b As Double)

result = a * b
MsgBox "The result is " & result
End Sub

e Use MultiplyValues(5, 10) in the macro editor to see the result.
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Accessing Cells Directly
Perform the following steps for assessing cells directly:

€ Open LibreOffice Calc. Click the Tools > Macros - Edit Macros to open the macro editor.

@ Create a new module and enter the script for SumCellsAllSheets in the macro editor. Enter the
following code:

Function SumCellsAllSheets ()
Dim TheSum As Double
Dim i As Integer
Dim oSheets
Dim oSheet
Dim oCell
TheSum = 0
oSheets = ThisComponent.getSheets ()
For i = 0 To oSheets.getCount() - 1
oSheet = oSheets.getByIndex (i)
oCell = oSheet.getCellByPosition (0, 1) ' Get cell A2
TheSum = TheSum + oCell.getValue ()
Next i
SumCellsAllSheets = TheSum
End Function

©

Click the View — Toolbars = Form Controls to show the form controls toolbar for assigning the
Macro to a button. Click the button icon and draw a button on the spreadsheet.

Right-click the button and select Control Properties. In the Events tab, assign the Execute Action
event to the SumCellsAllSheets macro.

o

Call the Macro from another Macro by using the code:

Sub CallSumCellsAllSheets ()

Dim result As Double

result = SumCellsAllSheets ()

MsgBox "The sum of values in cell A2 from all sheets is: " & result
End Sub

@ Run the CallSumCellsAllSheets macro to ensure it correctly sums the values in cell A2 from all
sheets and displays the result in a message box.

[ Untiled 2.0ds — Libreffice Calc - o x

Sorting Columns Using a Macro B e e
. . . B 1 u-A--
Perform the following steps for sorting columns using a macro: o EIARE
| A | 3 |

€@ Open LibreOffice Calc. Enter the following data, as shownin = > Sne :
Figure 29. : 3 1 Three ®
4 7 8 Four fx

s 4 2 Five

@ Create a new module and enter the code for SortRange in - "

€ )+ _sheett

the macro editor, as shown below: D e e
Figure 29: Unsorted Columns

Sub SortRange
Dim oSheet ' Calc sheet containing data to sort.
Dim oCellRange ‘' Data range to sort.

REM An array of sort fields determines the columns that are
REM sorted. This is an array with two elements, 0 and 1.
REM To sort on only one column, use:
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REM Dim oSortFields (0) As New com.sun.star.util.SortField
Dim oSortFields(l) As New com.sun.star.util.SortField

REM The sort descriptor is an array of properties.

REM The primary property contains the sort fields.

Dim oSortDesc (0) As New com.sun.star.beans.PropertyValue

REM Get the sheet named "Sheetl"
oSheet = ThisComponent.Sheets.getByName ("Sheetl")

REM Get the cell range to sort

oCellRange = oSheet.getCellRangeByName ("A1:C5")

REM Select the range to sort.

REM The only purpose would be to emphasize the sorted data.
‘ThisComponent.getCurrentController.select (oCellRange)

REM The columns are numbered starting with 0, so
REM column A is 0, column B is 1, etc.

REM Sort column B (column 1) descending.
oSortFields (0) .Field = 1
oSortFields (0) .SortAscending = FALSE

REM If column B has two cells with the same value,
REM then use column A ascending to decide the order.
oSortFields (1) .Field = 0
oSortFields (1) .SortAscending = TRUE

REM Setup the sort descriptor.
oSortDesc (0) .Name = "SortFields"
oSortDesc (0) .Value = oSortFields ()

REM Sort the range.
oCellRange.Sort (oSortDesc ())
End Sub

Save your macro by clicking the save icon or using File - Save.

Click the Run icon in the Macro toolbar of the LibreOffice Basic IDE to execute the macro. The
output is shown in Figure 30:

0

File Edit View Insert Format Styles Sheet Data Tools Window Help x
B-E-EB-DeR X DR 44000 At @ »
B 1 u-lA-8-EE= TEL
J AT~ I~ = "*gt’
. | : - _— ACTIVITY " m
= 8 F;uer 4 1. Record a macro that performs a series of actions in a
i

P 2 Five 5 database.

3 1 Three IR 2. Create a simple macro that performs a calculation.

4 1 Two o1 3. Develop a macro to sort records in a table based on
e specified criteria.
) | Sheet1of1 | Default | English (USA) ] Average: ; Sum: 0 -+ | 220%

Figure 30:  Sorted Columns Using Macros

ASSESS YOURSELF. .

................................. are values or references that you pass to functions in order to perform calculations or operations.
2. The macro recording feature is enabled by default in LibreOffice Calc. (True/False)
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Data analysis in LibreOffice Calc involves organizing,
interpreting, and visualizing data using features such
as formulas, functions, and charts.

Consolidating data combines data from multiple
sheets or ranges into a single summary.

Subtotals in LibreOffice Spreadsheet are intermediate
summaries that help break down data into smaller,
manageable sections for better analysis and
understanding.

A What-If scenario is a collection of variables that can
be plugged into a spreadsheet’s calculations.

What-If tools in LibreOffice Spreadsheets are powerful
features designed to analyze and forecast potential
outcomes by altering the input data and observing the
resulting changes.

Goal Seek in LibreOffice Spreadsheet is a powerful
tool used for What-If analysis.

LibreOffice Calc: A spreadsheet application within
the LibreOffice suite, used for creating, editing and
managing spreadsheets.

Consolidating data: The process of combining data
from multiple sources or ranges into a single summary
view or report.

Comments: The comments in LibreOffice Calc can be
used for collaboration or to explain the purpose of
specific data points.

Spreadsheet: A digital grid consisting of rows and
columns used for organizing, analyzing and storing
data.

Data tables: Data tables can be used to perform
various calculations and analyses, such as generating
summary statistics.

Information Technology

Summary

o

The Solver in LibreOffice Spreadsheet is a tool used
for optimizing complex decision-making problems by
adjusting variables to achieve a desired outcome, such
as maximizing profits or minimizing costs.

Multiple sheets in LibreOffice Spreadsheet allow users
to manage and organize data across several separate
tabs within one file.

A hyperlink in LibreOffice Calc is a clickable link that
navigates to a web page, another sheet, a specific cell,
or an external document.

A macro can be defined as a set of commands or
actions that are recorded and then executed in a
spreadsheet when required.

Recording a macro in LibreOffice Calc allows you to
automate repetitive tasks, saving time and reducing
errors.

KEY TERMS

Solver: An optimization tool used to find the best
solution for a problem by changing variables to meet
specific criteria.

Linking: The process of connecting data or cells
between different sheets or workbooks, so that
changes in one location are automatically reflected in
another.

Hyperlink: A clickable link within a spreadsheet that
directs users to another location within the same
document, a different document or a web page.

Macros: An automated sequence of instructions
recorded and saved to perform repetitive tasks in
spreadsheets, often used to streamline processes and
improve efficiency.

Arguments: Values or references used in functions or
formulas to perform calculations.
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Solved Questions
Multiple-Choice Questions (MCQs)

1.

Which menu option should you select to create a
hyperlink in LibreOffice Calc?

a. Format b. Insert

c. Data d. Tools

Which component in LibreOffice Calc allows you to
move the worksheet in a vertical direction?

b. Horizontal scrollbar
d. Status bar

a. Vertical scrollbar
c. Zoom controls
Which section allows you to specify the function
used for calculations when creating subtotals?

a. Group by b. Calculate subtotals for

c. Use function d. Select range

Which button do you click to finalize the results and
apply the solution when using Solver?
a. Restore Previous b. Keep Result

c. Cancel d. Solve

Which dialog box allows you to name and save your
macro after recording a macro?

a. Save As Dialog Box

b. Module Dialog Box

c. Macro Options Dialog Box

d. Basic Macros Dialog Box

ANSWERS
3.c

Very Short Answer Questions

1.

Ans.

Ans.

Ans.

Ans.

How can you quickly sum a column of numbers in
LibreOffice Calc?

Select the column, then click the “AutoSum” button on the
toolbar.

What is a cell in spreadsheet software?

A cell is a single data unit in a grid, identified by a column
letter and row number.

How can you view a comment in LibreOffice Calc?
Hover over the cell with the comment, and it will appear as
a tooltip.

What is the purpose of the Subtotals feature in
LibreOffice Calc?

To summarize data by grouping and calculating subtotals
for selected columns.

What does Goal Seek do in LibreOffice Calc?

' PRACTICE QUESTIONS

Ans.

It finds the input value needed to achieve a specific output
value in a formula.

Short Answer Questions-I

1.

Ans.

Ans.

Ans.

Ans.

Ans.

How can you use a data table to perform a sensitivity
analysis?

Select the range of cells that include your input and output
values. Go to Data > Data Table, and specify the row or
column input cell. The table will automatically compute
the output values based on the input variations.

What is the benefit of linking data between
spreadsheets in LibreOffice Calc?

Linking data between spreadsheets allows for dynamic
updates. Changes made in the source spreadsheet are
automatically reflected in the target spreadsheet, ensuring
consistency and reducing manual data entry.

How can you format a comment in LibreOffice Calc?
To format a comment, right-click the cell with the
comment, select “Edit Comment,” then use the formatting
options in the toolbar or right-click within the comment
box to format text and adjust the comment’s appearance.

How can you record a macro in LibreOffice Calc?

To record a macro in LibreOffice Calc, go to “Tools” >
“Macros” > “Record Macro.” Perform the actions you want
to record, and then click “Stop Recording.” Save the macro
with a name and assign it to a specific function or shortcut
if needed.

How can you edit an existing hyperlink in LibreOffice
Calc?

To edit an existing hyperlink, right-click on the cell
containing the hyperlink, choose “Edit Hyperlink” from the
context menu, make the necessary changes in the dialog
box, and click “Apply” or “OK” to save the changes.

Short Answer Questions-II

1.

Ans.

Ans.

How do you pass arguments to a macro in LibreOffice
Calc?

To pass arguments to a macro in LibreOffice Calc, you use
the ParamArray in the macro definition. Define the macro
with a parameter list, such as Sub MyMacro(ParamArray
args()). When calling the macro, provide the arguments as a
comma-separated list. Inside the macro, access arguments
using the args array, e.g., args(0) for the first argument.

How can you sort a column in LibreOffice Calc using
a macro?

To sort a column using a macro in LibreOffice Calc, first,
you need to record or write a macro. Start by selecting the
column you wish to sort. Go to Tools > Macros > Record
Macro, and perform the sorting action via Data > Sort.
After recording, stop the macro recording and save it. The
macro script will include the sort operation, which you can
run to sort the column automatically.
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Ans.

Ans.

Ans.

How can you edit or remove a hyperlink in a
LibreOffice Spreadsheet?

To edit or remove a hyperlink in a LibreOffice Spreadsheet,
right-click on the cell containing the hyperlink and select
“Hyperlink” from the context menu. For editing, in the
“Insert Hyperlink” dialog box, you can modify the URL or
display text as needed. After making changes, click “Apply”
and then “Close” to update the hyperlink. To remove the
hyperlink, right-click the cell, choose “Hyperlink,” and
then click “Remove Link” in the dialog box that appears.
This action will delete the hyperlink while keeping the text
in the cell intact.

How do you create a simple formula in LibreOffice
Calc?

To create a simple formula in LibreOffice Calc, start by
selecting the cell where you want the result to appear.
Enter an equal sign (=), followed by the formula. For
example, to add the values in cells A1 and B1, you would
type =A1+B1. Press Enter to calculate the result, which
will be displayed in the selected cell.

How can you consolidate data from multiple
sheets into one using the “Consolidate” function in
LibreOffice Calc?

To consolidate data from multiple sheets, first, select
the cell where you want the consolidated data to appear.
Then, go to Data > Consolidate. In the Consolidate dialog,
choose the function (e.g., Sum, Average) and click Add to
select the ranges from each sheet. After adding all ranges,
click OK to consolidate the data into the selected cell.

Long Answer Questions

1.

Ans.

Ans.

44

How can Goal Seek be applied to financial
forecasting in LibreOffice Spreadsheet?

In financial forecasting, Goal Seek in LibreOffice
Spreadsheet can be invaluable for determining the required
inputs to meet specific financial targets. For instance,
suppose you are preparing a financial model to forecast
the future value of an investment based on variable
interest rates. You might have a formula calculating the
future value of an investment based on the initial amount,
interest rate, and time period. If you want to determine
what interest rate is needed to achieve a target future
value, you can use Goal Seek. First, ensure your formula
is correctly set up in your spreadsheet. Then, navigate to
Tools > Goal Seek and enter the following details: set the
target cell to the cell containing the future value formula,
specify the target value you want to achieve, and indicate
the cell that represents the interest rate. Goal Seek will
then adjust the interest rate until the future value matches
your target. This method allows for precise financial
planning and scenario analysis by automatically solving for
unknown variables that will help achieve desired financial
outcomes.

Describe how you can use formulas and functions
in LibreOffice Calc to perform data analysis, and
provide an example of a common analytical function.

Formulas and functions in LibreOffice Calc are essential for
performing data analysis as they allow users to perform

Information Technology

Ans.

Ans.

complex calculations, automate repetitive tasks, and
derive meaningful insights from datasets. To use a formula,
you start by selecting a cell and entering an equal sign
(=), followed by the desired formula. For example, if you
want to calculate the sum of values in a range of cells, you
would use the SUM function: =SUM(A1:A10). A common
analytical function is the AVERAGE function, which
calculates the mean of a range of values. For instance, if
you have a list of monthly expenses in cells B1 through
B12, you can determine the average monthly expense
with the formula =AVERAGE(B1:B12). This function helps
in understanding trends and making budgetary decisions
by providing a central value that represents the typical
expense.

How can you use the What-If analysis feature in
LibreOffice Calc to evaluate different financial
outcomes based on varying interest rates and loan
terms?

In LibreOffice Calc, the What-If analysis feature allows you
to explore various scenarios by adjusting input values to
see how these changes affect your financial outcomes.
For instance, to evaluate different financial outcomes
based on varying interest rates and loan terms, you would
start by setting up a basic loan calculation model. Create
a spreadsheet where you input the principal amount,
interest rate, and loan term. Use formulas to calculate
monthly payments and total interest paid based on these
inputs. Next, implement the Scenario Manager to define
different scenarios. Enter varying interest rates and
loan terms as separate scenarios, and link these to your
calculation model. By switching between scenarios, you
can observe how changes in interest rates or loan terms
affects your monthly payments and total interest. This
analysis helps in making informed financial decisions by
comparing how different conditions affect your overall
financial commitments.

What is Solver in LibreOffice Calc, and how can it be
used to optimize a business problem?

Solver in LibreOffice Calc is an advanced optimization
tool that helps users find the best solution for complex
decision-making problems by adjusting multiple variables.
It is particularly useful for optimizing business problems,
such as determining the most cost-effective way to allocate
resources or maximize profits. To use Solver, you need to
define an objective cell, which is the cell that contains
the formula you want to optimize (e.g., total profit). You
then specify the decision variable cells, which are the cells
that Solver can change to achieve the desired outcome.
Additionally, you can set constraints to ensure that the
solution adheres to certain restrictions or limits, such as
budgetary constraints or resource limits. For example, if
a company wants to maximize its profit by deciding how
many units of different products to produce, Solver can
help by adjusting the production quantities to maximize
total profit while meeting constraints like production
capacity and budget. By running Solver, users receive an
optimal solution that satisfies the objective function and
constraints, thus aiding in informed and effective business
decisions.
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5. How can you set up multiple sheets in LibreOffice 2. Which of the following What-If tools in LibreOffice
Calc, and what are the benefits of organizing data Spreadsheets is used to find the input value needed
across different sheets? to achieve a desired result in a formula?

Ans. To set up multiple sheets in LibreOffice Calc, you start by a. Data Tables
creating a new spreadsheet or opening an existing one. b. S .
Then, to add additional sheets, click the “+” button next - >cenarios
to the sheet tabs at the bottom of the window. Each new c. Goal Seek
sheet is initially named “Sheet1,” “Sheet2,” etc., but you d. Solver
can rename them by right-clicking on the sheet tab and ) ) ) )
selecting “Rename.” This allows you to give each sheet 3. After selecting the ‘Hyperlink’ option, which button
a meaningful name related to its content. Organizing allows you to link to an external document?
data across multiple. sheets can gre.atly enhgnce the a. Folder button
management and clarity of complex projects. For instance,
you might use separate sheets for different months in a b. Document button
financial report or different departments in a company’s c. Web button
budget. This separation helps to ke.ep data. organlzed, d. Email button
reduces clutter, and allows for easier navigation and
reference. By using formulas and references between 4. Which feature does LibreOffice Calc provide to allow
sheets, you can also aggregate data from multiple sheets, multiple users to work on a spreadsheet at the same
making analysis and reporting more streamlined and time?
efficient.
a. Protected Sheet
Higher Order Thinking Skills (HOTS) Questions b. Lock Sheet

1. John is applying a formula and wants to start from c. Track Changes
cell B5 but accidentally starts from cell A1l. How can d. Share Spreadsheet
he quickly move the active cell to B5? . . .

q y 5. Which menu option allows you to create subtotals in

Ans. John can click directly on cell B5 to make it active
or press Ctrl + G, type B5, and press Enter to jump

LibreOffice Spreadsheet?

directly to the cell o Dawa
rec o the cell.

Y b. Insert
2. Sarah needs to determine how changes in sales ¢ Tools
volume affect her company’s revenue. How can .

d. View

Sarah use What-If tools in LibreOffice Calc to analyze
different sales volume scenarios?

Ans. Sarah can use the Scenario Manager to create and

Very Short Answer Questions

! ; : 1. What is LibreOffice Calc?
compare various sales volume scenarios, assessing ] ]
how each affects revenue projections. 2. What is data analysis?

3. Alex wants to simplify data entry for a weekly sales 3. What do you understand by What-If scenario?
report. HO_W can Algx use a macro to enhance data 4. What symbol is used to separate the sheet name and
entry efficiency in LibreOffice Calc? cell reference in LibreOffice Calc?

Ans. Alex can create a macro to insert predefined 5. What is the purpose of the “Target” field in the

templates, validate inputs, and auto-fill cells,
streamlining the data entry process for his weekly
sales reports.

Hyperlink dialog box in LibreOffice Calc?

Short Answer Questions-I

Assignment 1. What is the purpose of the Solver tool in LibreOffice
Calc, and how can it be used for scenario analysis?
Multiple-Choice Questions (MCQs) 2. What are the steps to create a reference to a cell in a
1. In the Consolidate dialog box, which section different LibreOffice Calc document?
allows you to choose the type of calculation for 3. How do you create a hyperlink to an external sheet
consolidation? within a LibreOffice Calc document?
a. Range: 4. What is the process for grouping data and inserting
b. Function subtotals in LibreOffice Calc?
¢ Data 5. What is the function of the ‘Data Pilot’ feature in
d. Sheet

analyzing data within LibreOffice Calc?

Electronic Spreadsheet (Advanced) using LibreOffice Calc
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Short Answer Questions-II

1.

What steps are involved in hyperlinking registered
data sources in LibreOffice Calc?

How can the ‘Goal Seek’ function in LibreOffice Calc
be used to find the necessary input value to achieve
a desired outcome?

What is the primary function of macro with
examples?

What is the purpose of the ‘Load Styles’ feature in
the Styles and Formatting window?

How can you customize subtotals in LibreOffice Calc
to accommodate different types of data analysis
needs, and what are the implications for data
presentation?

Long Answer Questions
1.

How can you troubleshoot and update hyperlinks to
external sheets or workbooks in LibreOffice Calc if
the external files are moved or renamed, and what
are the best practices for managing such links?

Explain how you can pass arguments to a macro in
LibreOffice Calc and describe the steps involved in
creating a macro that takes parameters.

Describe the process of consolidating data from
multiple worksheets into a single summary
worksheet in LibreOffice Calc. Include steps for both
using the built-in consolidation feature and manual
methods.

Explain how to use the What-If analysis feature in
LibreOffice Calc to assess the impact of varying
different input values on a financial model. Provide
a step-by-step guide on setting up a scenario where
you want to evaluate how changes in interest rates

Information Technology

and loan amounts affect the monthly payments of
a loan.

Discuss the limitations of Goal Seek in LibreOffice
Calc. In what situations might Goal Seek not provide
an optimal solution, and how could you address
these limitations using other tools or methods
available in LibreOffice Calc?

Lab Activities

1.

You are tasked with consolidating data from multiple
departments within a company using LibreOffice
Calc. Each department (Sales, Marketing, and
Finance) has separate spreadsheets containing
quarterly revenue figures. Your goal is to consolidate
the data into one master sheet to get an overall
picture of the company’s performance. Open
the individual spreadsheets and use the “Data >
Consolidate” feature to merge the quarterly figures
by selecting the relevant ranges. Ensure that the
data is consolidated based on the same row and
column labels. After consolidation, analyze the total
revenue by department for each quarter and create a
summary report that displays the company’s overall
performance.

Imagine you are tasked with preparing a financial
report for BrightStar Finance. The report includes
links to external documents, such as detailed
expense reports and external websites for additional
information. You need to add hyperlinks in your
LibreOffice Calc spreadsheet to external files located
on your computer and URLs of relevant financial
sites. Explain how you would create both types of
hyperlinks in the spreadsheet and demonstrate how
users can open the linked files and websites directly
from the document.
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UNIT COVERS

* Appreciate the concept
of database management
system

* (Create and edit tables
using Wizard and SQL
commands

¢ Perform operations on
table

* Retrieve data using
query

* Create forms and report
using Wizard

D New Database_SCL.odb : Queryl — LibreOffice Base: Query Design — O X

File Edit View |Insert Tools Window Help

B0 B h 9V BB 5 st
B} LIl E T Y 3

ID | OrderlD | ProductiD | UnitPrice |
11000 F) 66

B

Form Wizard
Stej

Arrange the controls on your form
1.Field selection Label placement S
2.Setup a sub-form ® Align left
3.Add sub-form fields O Align right
4.Get joined fields .
Arrangement of the main form

|5:Arrange controls
6.5et data entry == == % ==

o-o == ==
7.Apply styles === == ==
8.5et

etname Columnar - Labels Left

Database Management System
using LibreOffice Base

Introduction

A Database Management System (DBMS) is software that enables the
creation, management, and manipulation of databases. It provides
a systematic and organized way to store, retrieve and manage data
in a database, ensuring that the data is easily accessible, secure,
and consistently maintained. A DBMS abstracts the complexities of
data storage, allowing users to interact with the data using queries
reports, and other tools without needing to understand the underlying
architecture.

Key functions of a DBMS include data storage, retrieval, update
and administration. It supports various types of databases, such as
relational, hierarchical, network, and object-oriented databases. A
relational DBMS (RDBMS), which uses tables to represent data, is the
most common type. The DBMS also enforces data integrity, ensuring
that data is accurate and consistent, and provides tools for data backup,
recovery and security.

In this unit, you learn about how to create a database. Next, you learn
how to create a Table in Base. After this, you learn to perform operations
on a table. Towards the end, the chapter discusses how to create a
query, form and report in LibreOffice Base.
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Session 1: Creating a Database

LibreOffice Base allows you to design and manage databases with ease. You can create tables, forms,
queries and reports to organize and retrieve data efficiently. The process begins by defining a new
database file and selecting the appropriate database type (e.g., embedded HSQLDB). You can then create
tables to store your data, define relationships between them, and use forms to enter and manage the
data. Queries allow you to extract specific information, and reports help present the data in a structured
format. LibreOffice Base provides a user-friendly interface, making database management accessible
even to users with limited technical knowledge.

Perform the following steps to create a database:

€@ Click the LibreOffice icon to open —€) Selecting the Createa ) Clicking the Next
the LibreOffice Start Center on new database option button
your desktop or in the Start menu.
In the LibreOffice Start Center, you | Welcome to the Librebffice Database Wisard

Wl“ see VariOUS appliCatiOH iCOﬂS, Use the Database Wizafd to create a new database, open an existing
such as Writer, Calc, Impress, and | g database fll, or connept 1o 2 database stored on a server.

What do you want to do?

Base. 2, Save and proceed > ® Create a new database

e Click the Base Database option Embedded database:
from the list of available © Open an existing database file
applications. A Database Wizard Recently used: |
dialog box appears, as shown in Open
Figure 1. O Connect to an existing database

Firebird External

Select the Create a new database
radio button Figure 1.

© 0

Click the Next button, as shown in

Figure 1.
Help < Back Mext > ; Finish Cancel

The Decide How to Proceed
After Saving the Database page
appears, as shown in Figure 2.

Figure 1: Creating a New Database

GUESSWho? —
| am a bar that shows

the progress of any task
being performed on the
database.

Select the Yes, register the database for me option (Figure 2).

(5]
(6]

Click the Finish button, as shown in Figure 2.

steps Decide How to Proceed After Saving the Database Ieq smejs ‘suy 7

Do you want the wizard to register the database in LibreOffice?
1. 5elect database (®) Yes, register the database for me <€ 0 Selecting the Yes,

2. Save and proceed O Ng, do not register the database l‘egister the database

After the database file has been saved, what do you want to do? for me Option
Open the database for editing
O Create tables using the table wizard

Click 'Finish' to save the database.

@) Clicking the
y Finish button

Help < Back Next = Finish g Cancel

Figure 2: Deciding How to Proceed After Saving the Database

Information Technology
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A Save As dialog box appears.

0 Select the location in the Navigation pane where you want to save the database. In our case, we
have selected Desktop.

Q Type the name of the document in the File name combo box. In our case, we have typed My
Database.

Q Click the Save button. The desired database is saved with the specified name, as shown in

Figure 3.
" Quick Quiz
1 [E] Create Table in Design View... Description
B s Crte Tl Which of the following is software
_ that enables the creation,
“E - o
95 management, and manipulation of
- databases?
! .|
; — a. Database Management System
None ~ .
N0 b. Relational Database
Reports Management System
¢. HyperSQL Database
d. NoSQL Database
i i i et

. . . . . . wasAS JuswaSeuely aseqele( e ‘suy
Figure 3: Displaying a Database in the OpenOffice Base Window

Closing the Database and Quitting the LibreOffice Base Application

When you finish working with a database in LibreOffice Base, it’s important to close it properly to ensure
that your data is saved and to prevent any potential corruption.

Perform the following steps to close a database:
0 Click the File button from the Menu toolbar. A drop-down list appears.
@ Select the Close option from the drop-down list.
The current database gets closed, and the LibreOffice Base window appears.

In LibreOffice Base, quitting a database involves closing the application or ending your current database
session. Perform the following steps to quit a database:

0 Click the File button from the Menu toolbar. A drop-down list appears.
Q Select the Exit LibreOffice option from the drop-down list. The LibreOffice Base application gets
closed.

Opening an Existing Database

Perform the following steps to open an existing database document:

Click the File button from the Menu toolbar. A drop-down list appears.

Select the Open option from the drop-down list.

Navigate to the location where your database file is stored. In our case, we have selected Desktop.

Select the desired database document that you want to open. In our case, we have selected My
Database.

Click the Open button to load the selected database document.

Database Management System using LibreOffice Base

©Copyright 2025 by Dreamtech Press




ASSESS YOURSELF 3],

L allow you to extract specific information, and reports help present the data in a structured format.
2. The Database Object buttons are found at the bottom of the LibreOffice Base window. (True/False)

J

_ _ _ DEFINITIQN
Session 2: Creating a Table in Base The Wizard in LibreOffice

. . . Base is a user-friendly tool
In LibreOffice Base, a database table organizes data into rows and designed to simplifyt&;e

columns. Rows r‘epresent rec.ords, while columns define specific ﬁe}ds. process of creating and
Creating a table involves setting field names, data types, and constraints managing database elements,
like primary keys. Base provides a user-friendly interface for creating, such as tables, queries, forms,
managing, querying, and manipulating data efficiently. and reports.

Creating Using Wizard

The Wizard simplifies table creation by guiding users through steps with predefined templates for
common scenarios like contacts or invoices. Users can customize fields, define field types, set primary
keys, and establish relationships. It ensures a structured approach, making it ideal for beginners to create
tables ready for data entry.

Perform the following steps to create a table using Wizard:

Open a new or existing database in which you want to create a table.
Click the Tables option from the left sidebar.

Various options related to the selection are displayed in the Tasks pane.

Select the Use Wizard to Create Table option under the Tasks pane. The Table Wizard window
appears (Figure 4).

Select the desired option under the Category section from the Select fields for your table page. In
our case, we have selected Business, as shown in Figure 4.

Click the down arrow button in the Sample tables (Figure 4). A drop-down list appears (Figure 5).

@0 ©0 0 00

Select the desired Sample tables from the drop-down list. In our case, we have selected Employees,

as shown in Figure 5.

Selecting th
@ Selecting the Business option o & the

Employees option
Table Wizard >
Steps Sample tables
S sty ol R
Events ~
This wizard helps you to create a table for your database. After selecting a table category Orders
and a sample table, choose the fields you want to include in your table. You can include
] Contacts
fields from more than one sample table.
Expenses
oty Invoices
> (®) Business O Personal Payments
- - Products
Sample tables Projects
Available fields Selected fields Suppliers
Categories
Deliveries
TimeBilled
Mailinglé
Figure 5:  Select Fields for
Figure 4:  Select Category for Your Table Page Your Table Page

Information Technology
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o Move the fields from the Available Fields shelf by using (>>) buttons, and then click the Finish
button to finish setting up table using Wizard. The window to add records in the table will open
next.

_ACTIVITY ¥, \

1. Create a new database and save it with the name School_Database.
2. Create a table using the Wizard in LibreOffice Base and add the following fields to your table:

a. ID c. Last Name e. Phone Number
b. First Name d. Email Address . Date Joined
3. Create a student database and a table using the Design View feature in LibreOffice Base.

ASSESS VOURSELF .

................................. in LibreOffice Base is a methodical process that allows for precise control over the structure of a database
table

2. The Wizard in LibreOffice Base allows users to define field types and set primary keys. (True/False)

Session 3: Operations on Table

Tables are the fundamental structures used to store data in a relational database, such as those created
in LibreOffice Base. They consist of rows (records) and columns (fields), where each field represents a
specific attribute of the data (e.g., name, age, salary), and each row represents a single record containing
data values. Operations on tables in LibreOffice Base refer to the various tasks you can perform to
manage, manipulate, and analyze your data.

Entering Records in a Table ™ Quick OQuiz |

Perform the following steps to enter records in a table:
e . . is a structured format
o Open a new or existing database in which you want to create a T s Gt i s Al

table. columns, allowing for organized
@ Click the Tables - Create Table in Design View option under the ~ and efficient data management.
Tasks pane. dIqeL ‘suy

Click in the first empty row at the bottom of the table to begin entering your data.
Type Employee_Id in the Field Name.

Press the Enter key to move to the Field Type column. In the Field Type column, the Text [VARCHAR]
field type is selected by default.

Click the down arrow button in the Field Type. A drop-down list appears.

Select the Number [NUMERIC] fields type from the dropdown list. Similarly, you can define the
various fields and their types in the Table Design window.

© 00 000

CliCk the SaVe button from the quick daccess [ Employee - Demonstration — LibreOffice Base: Table Data View
toolbar to save the current file manually. File Edit View Inset Dota Toos Window Help

Once you have finished entering all your (2 B O -~
records, you can close the table by clicking
the X in the upper-right corner of the
table window. This will open the table ina |~
spreadsheet-like view, as shown in Figure 6.  Figure 6: Spreadsheet View for Entering Records

EmployeelD | FirstName | LastName Department Salary

Al

Database Management System using LibreOffice Base
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o Click on the first cell to the enter data. The cursor will appear in the cell.
@ Type the desired data for each field in the record. The record entered is shown in Figure 7:

EmployeelD | FirstName | LastName | Department | Salary s
lhor Shahark |Mim |OA 25000 DID YOU Know £
e Kajal Jain 1) 30000 You can also press '
103 Priyanka Verma HR 15000 Ctrl + - (minus key) to delete
| Varun K R&D 32000 the selected row. Alternatively,
- |ios Nishel Rakshita Management 29000 you can press Delete after
[t ] selecting the row.

Figure 7:  Entering Records in the Table

m Click on the Save icon in the toolbar or press Ctrl + S on the keyboard to save the data.

Editing and Deleting Records in a Table

Perform the following steps for editing or deleting records in the table:

o Double-click on the table you want to edit. In our case, we have double-clicked on Employee-
Demonstration.

The table will open in Data View, where you can see all the records.
Right-click on the desired cell to edit the current data.

Type the new value or make the 103 Priyanka Verma HR 15000
necessary changes. 104 Varun K R&D 32000

Mishel Rakshita Management | 29000

Press the Enter key from the

keyboard to save the changes, as
shown in Figure 8. Figure 8: Editing Records in the Table

Click on the row header (the grey box on the left of the row) to select the entire row.

Right-click on the desired row header. A drop-down list appears.

00 © 00

Select the Delete Rows option from the drop-down list, as shown in Figure 9.

EmployeelD | FirstName | LastMame
o Shashank  Mittal ——aGUESSWho? —
102 Kajal Jain | am a fundamental
|03 Priyanka Verma structure used to store
104 Varun K data in a relational
Rakshit
N Toble Format.. [Rakshita || database, such as those
1 . created in LibreOffice
= Row Height...
Base.
Copy M~ s9[qeL suy
Delete Rows < €) Selecting the Delete Rows option
B S M P«

Figure 9: Deleting Records in the Table

The LibreOffice message box appears, asking you to confirm the deletion.

G Click the Yes button to delete the record.

Sorting Records in a Table

Sorting in LibreOffice Base allows users to organize records in a table by arranging them in ascending
or descending order based on specific fields, such as names, dates, or numbers. This operation helps
in managing data efficiently, making it easier to identify trends and locate information. Users can sort

Information Technology
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Selecting Sort
Ascending option

- A AFYARY:
rtment | ]

30000

directly from the Datasheet View using toolbar buttons or use the “Sort”
dialog for multi-level sorting, offering flexibility in handling complex
datasets.

Perform the following steps for sorting records in a table:

@ Select the desired column/row header of the field you want to sort.
@ Click on the Salary tab in the Table Data View.
15000

€ Click on the desired sorting button from the Formatting toolbar. In
our case, we have selected Ascending Order, as shown in Figure 10. o

ASSESS YOURSELF JF’ . -

1. In LibreOffice Base, relationships help to maintain data integrity and avoid Figure 10:  Sorting Salary in
redundancy by establishing connections between tables. (True/False) Ascending Order
2. o define the characteristics and behavior of data within a table’s columns
in LibreOffice Base.

ACTIVITY ¥,

1. Create a new database for a small library system. Define a table named Books with the following fields:
a. Book ID (Integer, Primary Key) c. Author (Text, Required) e. Genre (Text)
b. Title (Text, Required) d. Publication Year (Integer)

Session 4: Creating Query in LibreOffice Base

Creating a query in LibreOffice Base allows you to retrieve and manipulate data from one or more tables.
Queries enable you to filter, sort, and summarize information according to specific criteria, providing
customized views and reports to better analyze and understand your database data.

Creating Query in Design View
Perform the following steps to create a query in the design view:

o Open a new or existing database in which you want to create a table.

@ Click the Queries > Create Query in Design View option under the Tasks pane. The Add Table or

Query dialog box appears. Selecting Employee

e Select the Tables radio button that you want to use in your new table
query. In our case, we have selected Employee table, as shown in  .unsicoou,
Figure 11. @ Tbles

O Queries
Click the Add button to add the table. The selected table is added to
the Query Design window.

Click the Close button to close the Add Table or Query dialog box.

Select the desired fields that you want to include in your query from
the tables listed in the top section. In our case, we have selected
EmployeelD, FirstName, LastName, Department, and Salary.

© 00 O

Enter criteria in the Criteria row for the corresponding field to filter
the data in the lower part of the Query Design View. Here, criteria o Gose
for Department IT are used, and for Salary <50000 are used.

Figure 11:  Adding Table for Query

Database Management System using LibreOffice Base
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G Click on the Run Query icon (a green checkmark) in the toolbar to see the query results. The output

is shown in Figure 12.

[ Demonstration.odb : Query? — LibreOffice Base: Query Design - m] x
File Edit Wiew Insert Tools Window Help
B- BO-CBE TR B KBRS
(2 JOAR O 5L ELI N4 S )
EmployeelD | FirstName | LastName | Department | Salary |
7»102 Kajal Jain T 30000
s | Quick Quiz
el T o OECHE allows users
| . to organize records in a
- i - table by arranging them in
Field EmployeelD FirstName LastName Department Salary ~ ascendlng Or descendlng
Alias s
order based on specific
Sort fields, such as names,
Visible [}
p— dates, or numbers.
Ciiterion m <50000 . dunuog ‘suy

Figure 12:  Query in Design View

Creating Query with Wizard

Perform the following steps for creating a query using the Wizard:

Open the Tables drop-down menu in
the Query Wizard — Field Selection
step.

Move desired fields from Available
fields to Fields in the Query by
selecting them and clicking the >>
button.

(2]

Click the Next to go to the Sorting
Order step, and select Employee
Salary in Ascending order.

Figure 13.

summary query.

assign aliases if desired.

needed.

®© 00060 © o

Figure 14.

Information Technology

Click the Next button to reach the Alias step and

Click the Next button to reach the Overview step.
Review selections and click Back to make changes if

Click the Finish button to save the query, enter a
name, and click OK button. The output is shown in

Steps
Select the search conditions

1. Field selection (O Match all of the following

2. Sorting order ® Match any of the following

Searw:h conditions|

Fields Condition Value

4. Detail or summary

V‘ |isequa|nr|essthan v| |3{D0d

5.Grouping |Emplnyee.SaIary

6. Grouping conditions

7. Aliases

Condition Value

8. Overview | o |

A ‘ |isequa|lu
et e et et ettt et ™ et ™ el ™t et ™™™ ]

Figure 13:  Search Condition of the Query

Click the Next button to reach the Search Conditions step. Set conditions to filter data, selecting
the field, condition, and value to compare. Add multiple conditions if needed as shown in

Click the Next button to go to the Grouping step (if grouping is required). Select fields to group by
and set any aggregate functions (e.g.,

SUM, AVG).

Click the Next button to reach the Detail or Summary step, and choose between a detail or

U Query_Employee - Demenstration — LibreOffice Base: Table Dat... —
File Edit View |Insert Data Tools Window Help
7 Z| A z
(2 PIO - 2 &
| EmployeelD ‘ FirstName ‘ LastName | Department | Salary |
» [ho3 Priyanka  Verma HR 15000
101 Shashank Mittal QA 25000
105 Mishel Rakshita Management 29000
102 Kajal Jain IT 30000

Figure 14:

Query Using Wizard
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Handling Query with SQL Commands

Perform the following steps for handling query using SQL commands:
@ Gotothe Tablessectionin LibreOffice ~ ™PIe T InvoiceDetails Table

Base and dclick on Create Table IR EIE I AL R

in Design View. Define the table 1 1000 989 66 2 10
structure as shown below and save 2 1001 157 127 6 13
the table as InvoiceDetails. 3 1002 1 200 1 10
Enter the data provided below in the 4 1003 55 9000 8 10
InvoiceDetails table, as shown in 5 1004 96 24 10 12
Table 1. 6 1005 144 15639 2 10

@ Go to the Queries section and click
on Create Query in SQL View. Enter your SQL query for SELECT command. The outputs are shown
in Figure 15 respectively.

SQL Query 1
SELECT ID, OrderID, ProductID, UnitPrice FROM InvoiceDetails;

D Mew Database_SCL.odb : Queryl — LibreOffice Base: Query Design - [m} * t*w,
File Edit Miew |Insert Tools Window Help (_ACTIVITY
B = = 1. Creat ry in Design
= B RO o o C_eaeaquey esig
_ View that retrieves a
¥; JORNOR NEISY T Y (3 list of employees from
ID | OrderlD | ProductlD | UnitPrice | the "Employee” table,

1000 080 86 displaying only the
1oo1 157 17 fields "Employee Name,"
1002 an 200 'elds ploy '

1003 55 9000 "Department,” and "Salary."

| P |

| |5 oM (% “ 2. Write an SQL command
1005 144 15639 . .

] to display the "Customer
] Name" and "Order Date"
from the "Orders" table
where the order amount is

greater than 500.

I

Record| 1 of 6 OO [ [

SELECT ID, OrderID, ProductID, UnitPrice FROM InwvoiceDetails; -~

Figure 15:  SQL Query 1

ASSESS YOURSELF 4@

L in a query are conditions used to filter records from a table.
2. Queries in LibreOffice Base do not allow you to filter, sort or summarize information. (True/False)

Session 5: Creating Form in LibreOffice Base

In LibreOffice Base, forms are user-friendly interfaces for entering, viewing and editing data in your
database tables. Creating a form simplifies data management by allowing you to interact with multiple
fields at once. You can design a form using the Form Wizard, which guides you step-by-step in selecting
fields, layout and style. Alternatively, forms can be customized in Design View for advanced formatting.
Forms are essential for enhancing the usability and functionality of your database.

Database Management System using LibreOffice Base
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Creating Form Using Wizard

Perform the following steps to create a form using Wizard:

© 000 © 0 00

©

® 66 6 @ ©

Open a new or existing database in which you want to create a table.

Click the Forms option from the left sidebar. Various options related to the selection are displayed
in the Tasks pane.

Select the Use Wizard to Create Form option under the Tasks pane. The Form Wizard window
appears.

Select the desired table from the Tables or queries drop-down list. In our case, we have selected
Employess_details.

Select the desired fields from the Available fields box to the Fields in the form box.
Click the Add button. The added fields are displayed in the Fields in the form list box.

Click the Next button. The Decide if you want to set up a sub-form page appears on the Form
Wizard.

@) Selecting the @ Selecting As
Click the Next button. Columnar-Labels Data Sheet
The Arrange the controls on Left option option
your form page appears. Form Wizard x
. . Steps

Select the desired button in Arrange the controls on your form
the Arrangement of th.e main Label placement
form section to specify the  2seiupasub-form ® Align left
arrangement of the labels in 3.Add sub-form fields O Align right
the form. In our case, we have  “Cetomecrieie PR AR R e
selected Columnar-Labels Left, RIS - -

. . 6.5et data entry === == % ==
as shown in Figure 16. 7. Apply styles e == =
Select the desired button in  **™™ Columnar - Labels Left
the Arrangement Of the Sub Arrangement of the sub-form v

form section to specify the
arrangement of the form. In
our case, we have selected
As Data Sheet, as shown in

As Data Sheet

Figure 1 6' Help < Back FEinish Cancel
Click the Next button. Figure 16:  Arrange the Controls on Your Form Page

The Select the data entry mode page appears.

Select the desired check box to specify the permission. In our case, we have selected Do not allow
deletion of existing data. The Apply the style of your form page appears.

Select the desired style for the form in the Apply styles list box. In our case, we have selected
Violet.

Click the Next button, The Set the name of the form page appears.

Type the desired name of the form in the Name of the form text box. In our case, we have typed
Employees_details_Forms.

Select the desired radio button in the How do you want to proceed after creating the form?
option. In our case, we have selected Work with the form.

Information Technology
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@ Click the Finish button, as shown in Figure 11:

Form Wizard x

Steps
Set the name of the form

1.Field selection Name of the form

2.5etup a sub-form Employees details Forms < } @ Typing the form name
3.Add sub-form fields

4.Get joined fields How do you want to proceed after creating the form?

5.Amange controls ® Work with the form <€ @ Selfffti”g the WOl'k WIth
6.Set data entry © Modify the form the form o t

7.Apply styles ption

@) Clicking the Finish button
Help < Back Next > Cancel

Figure 17:  The Set the Name of the Form Page

ACTIVITY ¥¥

AssEss YOURSELF .

1. Create a custom form to input data into L — are user-friendly interfaces for entering, viewing, and
an existing table using Design View. editing data in your database tables.

2. Create a simple data entry form quickly 2. To create a form in Design View, you need to click the "Forms —>
using the form wizard. Create Form in Design View" option under the Tasks pane. (True/False)

Session 6: Creating Reportin LibreOffice Base

Creating a report in LibreOffice Base allows you to generate formatted summaries of your database data
for analysis or presentation. The Report Wizard guides you through selecting fields, grouping, sorting,
and defining layouts. You can also customize the design and structure. Reports provide a clear, organized
view of data for printing or sharing.

Creating Report Using Wizard

Perform the following steps to create a report using Wizard:

Open a new or existing database in which you want to create a table.

Click the Reports > Use Wizard to Create Reports option under the Tasks pane.
The Report Wizard window appears.

Select the desired table from the Tables or queries drop-down list in Which fields do you want to
have in your report? page. In our case, we have selected Employess_details.

Select the desired fields from the Available fields box to the Fields in the form box.
Click the Add button. The added fields are displayed in the Fields in the form list box.
Click the Next button.

The How do you want to label the fields page appears.

Click the Next button. The Do you want to add grouping levels? page appears.

© 000 ©0 ©0
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(8]
(9]

® 600 ©6

5]

[17)

ACTIVITY ¥%,

1.
2.

Click the Next button. The According to which fields do you want to sort the data? page appears.

Select the desired fields in the Sort by drop-down list. In our case, we have selected the data based
on EmployeelD.

Click the Next button. The How do you want your report to look? page appears.

Select the layout for the data in the Layout of data list box. In our case, we have selected the
Tabular, columnar and more option.

Select the Landscape radio button in the Orientation.
Click the Next button. The Decide how you want to proceed page appears.

Type the desired name for your report in the Title of report text box. In our case, we have typed
Employee Report.

Select the desired radio B Demanstration.adh : Employes Repart — LibreOffice Wiiter

o x
. . File Edit View Inset Format Styles Table Form ook Window Help
button in the What kind of | o ;a0 oA : o .
report do you want to create? A =
option. In our case, we have
selected Static report. i
Select the desired radio ®
button in the How do you Empiyeeid FirstName . Salary J
101 Shashank Mittal A 25000 o
want to proceed after Empiyeeid EZ,;‘;';?‘" La i Sairy -
ain 5
creating the report? option. fufgv'w“'f’ Firsthame Lasth Ds Salary ;r
In our case, we have selected Ermplayeeln Firsthiame K Fy e
EmployeelD FirstName LastN; Salary
Create report now. 105 Nishel Rakshita Management 29000
Click the Finish button.
The report Is dlsplayed in the Tl Poge 1011 | S0words, B2choracters Defoult Poge Sty ER IR ] | Tan i e—

LibreOffice Writer document,  Figure 18: Report Using Wizard
as shown in Figure 18.

Create a custom report for the "Sales” table using the Design View in LibreOffice Base.
Generate a report summarizing student information from a student database.

ASSESS YOURSELF P

2.

................................. allows you to generate formatted summaries of your database data for analysis or presentation in
L|breOff|ce Base.

In the Report Wizard, fields are added to the report by selecting them from the Fields in the form box and clicking the Next
button. (True/ False)

Information Technology
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Summary

DBMS is software that enables the creation,
management, and manipulation of databases.

Queries allow you to extract specific information, and
reports help present the data in a structured format.

In LibreOffice, a table in a database is a structured
format that stores data in rows and columns, allowing
for organized and efficient data management.

Design View in LibreOffice Base is a methodical
process that allows for precise control over the
structure of a database table.

The Wizard guides users through a series of steps,
making it easy for those who may not be familiar with
database design.

Operations on tables in LibreOffice Base refer to the
various tasks you can perform to manage, manipulate
and analyze your data.

LibreOffice Base: LibreOffice Base is a DBMS that is
part of the LibreOffice suite. It allows users to create
and manage databases, design forms, queries and
reports, and interact with data for various tasks such
as inventory management, contact lists or academic
records.

Relational Database Management System (RDBMS):
An RDBMS is software that manages data stored in
a relational database. Data is organized into tables
with rows and columns, and relationships between
different data entities are defined through primary
and foreign keys.

Hyper Structured Query Language Database
(HSQLDB): HSQLDB is the default embedded database
engine used in LibreOffice Base. It is a lightweight,
SQL-based database management system written
in Java, providing in-memory and disk-based tables
for managing data within the LibreOffice Base
environment.

Primary key: A primary key is a unique identifier for
each record in a database table. It ensures that each

o

Field properties in LibreOffice Base define the
characteristics and behavior of data within a table’s
columns.

Sorting in LibreOffice Base allows users to organize
records in a table by arranging them in ascending or
descending order based on specific fields, such as
names, dates or numbers.

Relationships in a database establish connections
between tables based on common fields.

In LibreOffice Base, forms are user-friendly interfaces
for entering, viewing and editing data in your database
tables.

A report in LibreOffice Base allows you to generate
formatted summaries of your database data for
analysis or presentation.

KEY TERMS

entry in the table is distinct and can be referenced
unambiguously.

Wizard: In LibreOffice Base, a Wizard is a step-by-
step guide that helps users perform complex tasks
like creating tables, queries, forms, and reports. It
simplifies the process by asking a series of questions
and then generating the appropriate database object.

Scenarios: In LibreOffice Base, scenarios typically refer
to different possible sets of data or configurations that
users might want to evaluate.

Datasheet: A datasheet in LibreOffice Base is the
spreadsheet-like view used to display and enter data
in a table. It shows records in rows and fields in
columns, allowing for easy data manipulation, sorting
and filtering.

Data handling: Data handling refers to the processes
of collecting, storing, managing, and manipulating
data within the database. In LibreOffice Base, data
handling includes tasks like entering data, sorting,
filtering, querying and updating records in tables and
forms.

Database Management System using LibreOffice Base
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| LD PRACTICE QUESTIONS

Solved Questions
Multiple-Choice Questions (MCQs)

1.

Which component allows you to create various
database objects such as tables, queries, forms, and
reports?

a. Status bar

b. Toolbar

c. Tasks pane

d. Database object buttons

What does each row in a LibreOffice Base table

represent?
a. Field
b. Database
c. Record

d. Primary key

Which of the following is not a field property in
LibreOffice Base?

a. Field size

b. Data type

c. Default values

d. Field colour

Which option should be selected from the File menu
to quit the LibreOffice Base application?

a. Exit LibreOffice

b. Close

c. Save

d. Minimize

Which type of relationship allows a record in Table

A to relate to multiple records in Table B, but each
record in Table B relates to only one record in Table

a. One-to-One (1:1)

b. One-to-Many (1:00)

c. Many-to-Many (N:oo)

d. Many-to-One (c0:1)

ANSWERS
3.d.

Very Short Answer Questions

1.

What is a database in LibreOffice Base?

Ans. A collection of data organized for easy retrieval,

management, and updating.

Information Technology

2.

Ans.

Ans.

What does the Design View in a table allow you to
do?

It allows you to define and modify the structure of .....the
table, including fields and their properties.

How do you set the data type of a field in LibreOffice
Base?

By selecting the field and choosing the data type from the
Field Properties section in Design View.

Short Answer Questions-I

1.

Ans.

Ans.

Ans.

How can SQL commands be used in LibreOffice Base
queries?

SQL commands can be used in LibreOffice Base to write
custom queries for complex data retrieval, manipulation,
and updating tasks beyond the capabilities of the graphical
query design interface.

What can you do in Design View when creating a
report in LibreOffice Base?

In Design View, you can customize the layout and
appearance of a report, including arranging fields,
adding labels, and setting properties to present data in a
structured and visually appealing manner.

What does RDBMS stand for, and what is its primary
function?

RDBMS stands for Relational Database Management
System. Its primary function is to manage and organize
data into tables that can be linked through relationships,
enabling efficient data retrieval and manipulation.

Short Answer Questions-II

1.

Ans.

Ans.

Ans.

What is a Relational Database Management System
(RDBMS) and how does it relate to LibreOffice Base?

A Relational Database Management System (RDBMS) is
software that manages databases by organizing data
into tables that can be linked based on relationships.
LibreOffice Base is an RDBMS that allows users to create,
modify, and manage relational databases, enabling users
to organize and query data efficiently.

What are criteria in a query, and how are they used
in LibreOffice Base?

Criteria in a query define the conditions that records must
meet to be included in the query results. In LibreOffice
Base, you set criteria in the Query Design View by
specifying conditions in the criteria row of the query grid.
This allows you to filter data based on specific values or
ranges, enabling precise data retrieval.

How do you create a report in LibreOffice Base?

To create a report in LibreOffice Base, use the Report
Wizard or Design View. In the Report Wizard, select the
data source, choose fields, and set sorting and grouping
options. The wizard generates a report layout based on
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your selections. In Design View, you can manually design
the report layout by dragging and dropping fields, adding
labels, and adjusting formatting.

Long Answer Questions

1.

Ans.

Ans.

Ans.

How can you create a table in LibreOffice Base
using the Table Wizard, and what are the key steps
involved in this process?

Creating a table using the Table Wizard in LibreOffice
Base is a simplified method for beginners to set up
database tables without requiring extensive knowledge
of database design. The Table Wizard provides predefined
categories and templates for commonly used fields. The
process begins by selecting the Table Wizard option
from the database objects list. In the first step, you
choose a category (e.g., Business or Personal) and a table
template that matches your needs, such as “Employees”
or “Customers.” The next step involves selecting fields
for your table from the template. You can add or remove
fields as necessary. After this, the Wizard asks you to set
field types and properties like primary key designation.
Finally, the table is named, and the user has the option
to immediately open the table for input or modify its
structure further in Design View. The Wizard streamlines
table creation by automating many design choices while
still offering flexibility.

Explain how to customize field properties in a table
using LibreOffice Base and discuss the significance
of field properties in database design.

In LibreOffice Base, customizing field properties is essential
for defining the data characteristics and behaviour within
a table. Field properties include attributes such as field
type (e.g., text, number, date), length, format, and default
value. To edit field properties, the user opens the table in
Design View, where each field's properties can be adjusted.
For instance, if a field is designated as a "Number" type,
you can specify whether it should allow decimal places,
whether it has a minimum or maximum value, or if it
should auto-increment. Customizing field properties
ensures data integrity and consistency within the database.
Setting a field to “Required” ensures that data cannot
be left blank, while setting a unique constraint ensures
no duplicate values are entered. Proper field property
customization contributes to a more efficient and reliable
database system by controlling how data is input, stored,
and managed.

Describe the process of editing and deleting records
in a table in LibreOffice Base and explain the
precautions to consider during this process.

Editing and deleting records in a table in LibreOffice Base
can be done through the Table Data View or using SQL
commands. To edit records, users can open the table and
simply click on the fields they want to modify, updating
the values directly in the cells. When deleting a record,
the user selects the row they wish to remove and presses
the delete key or uses the delete option in the right-click
menu. However, care must be taken when performing
these actions, especially when deleting records, as this is
often irreversible. Backing up data is recommended before

deleting records to prevent accidental loss. In multi-
user environments, record-locking mechanisms should
be considered to prevent conflicts when multiple users
are editing the same table simultaneously. Additionally,
updating foreign key values or deleting records that have
dependent data in related tables should be done with
caution to maintain data integrity across the database.

Higher Order Thinking Skills (HOTS) Question

1.

Ans.

Ans.

Ans.

You are managing a small business and need to keep
track of customer orders, payments, and inventory.
You want to create a system that automates the
process of generating invoices and tracking payment
statuses. How would using a Database Management
System (DBMS) in LibreOffice Base help you achieve
this?

Using a DBMS in LibreOffice Base allows you to efficiently
store and organize your data. You can create tables for
customers, orders, and inventory, establish relationships
between them, and automate invoice generation
using queries and reports. This ensures data integrity,
eliminates redundancy, and allows for easy retrieval of
payment statuses, leading to better decision-making and
streamlined business operations.

You have created a database in LibreOffice Base to
track employee attendance. How would you use the
Report Wizard to generate a report that summarizes
each employee's monthly attendance?

Using the Report Wizard in LibreOffice Base, you can select
the attendance table and specify the fields you want in
your report, such as employee name, attendance dates,
and hours worked. You can group the data by employee
and sort it by date to get a clear summary of each
employee's monthly attendance. This report can be used
for performance reviews or payroll purposes.

You are developing a database for a library where
each book is associated with multiple authors. How
would you establish relationships in LibreOffice Base
to ensure accurate data linking between books and
authors?

In LibreOffice Base, you can establish a many-to-many
relationship between books and authors by creating a
junction table that links the two tables. The book table
and author table will each have primary keys, which are
then linked in the junction table via foreign keys. This
ensures accurate data representation, allowing each book
to have multiple authors and each author to be associated
with multiple books.

Assignment

Multiple-Choice Questions (MCQs)

1.

Which tool in LibreOffice Base helps you to create a
formatted summary of your database data?
a. Report Wizard b. Table Designer

c. Query Builder d. Form Wizard

Database Management System using LibreOffice Base
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Which type of DBMS uses tables to represent data?

a. Hierarchical DBMS

b. Network DBMS

c. Object-oriented DBMS

d. Relational DBMS

Which component of the LibreOffice Base interface
shows the progress of any task being performed?

a. Menu bar

b. Tasks pane

c. Status bar

d. Toolbar

Which tool allows you to create a form in LibreOffice
Base's Design View?

a. Form Controls toolbar

b. Table Design tool

c. Form Wizard

d. Report Wizard

Which view allows users to sort records directly
using toolbar buttons in LibreOffice Base?

a. Design view

b. Report view

c. Datasheet view

d. Form view

Very Short Answer Questions

1.
2.
3.

What does RDBMS stand for in LibreOffice Base?
What is LibreOffice Base?

What is the benefit of using the Report Wizard in
LibreOffice Base?

Short Answer Questions-I

1.

What is the primary purpose of a form in LibreOffice
Base, and how does it enhance user interaction with
the database?

How can you set the database file format when
creating a database in LibreOffice Base?

Which SQL command is commonly used to retrieve
data from a table in LibreOffice Base?

Short Answer Questions-II
1.

How does LibreOffice Base ensure data integrity in
an RDBMS environment?

Information Technology

How can you customize the toolbar in LibreOffice
Base to include specific window control buttons?

Describe the process of importing data from a
spreadsheet into a table in LibreOffice Base.

Long Answer Questions

1.

How does HSQLDB function as the default database
engine for LibreOffice, and what are the advantages
and limitations of using HSQLDB for small to
medium-sized database applications? Discuss its
capabilities in terms of data storage, retrieval, and
manipulation.

Describe the different types of queries available,
such as select, action, and parameter queries.
Provide examples of how each type can be used to
extract or manipulate data from a database, and
discuss the importance of queries in the context of
database design and reporting.

How can users sort records in a table or a query result
set? Explain the various sorting options available,
such as ascending and descending order, and
how multiple fields can be sorted simultaneously.
Additionally, elaborate on how sorting impacts data
presentation and analysis.

Lab Activities

1.

Your university wants to track student enrollments
and course registrations using a relational database.
Create two tables: "Students" with fields for Student
ID, Name, and Major, and "Courses" with fields for
Course ID, Course Name, and Credits. Establish a
relationship between the two tables using a junction
table called "Enrollments" that links Student IDs to
Course IDs. Populate the tables with sample data
and demonstrate how to use SQL queries to retrieve
a list of students enrolled in a specific course.

You are tasked with creating a simple Employee
Management System using a flat-file database in
LibreOffice Base. Start by designing a table named
"Employees" with fields for Employee ID, Name,
Position, and Salary. Populate the table with data
for five employees. Afterward, demonstrate how
to query this table to retrieve information about
specific employees based on their positions.
Discuss the limitations of using a flat-file database
for managing employee records compared to an
RDBMS.
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Maintain Healthy, Safe and
Secure Working Environment

Introduction

Managing health and safety involves creating and maintaining a safe
workplace by identifying potential hazards, implementing safety
protocols and ensuring compliance with regulations. It includes
risk assessments, safety training and the use of Personal Protective
Equipment (PPE). Effective management requires fostering a safety
culture, encouraging reporting of incidents and continuous monitoring
and improvement of safety practices. Key aspects include emergency
preparedness, accident investigation and adherence to legal standards.

A proactive approach to managing health and safety not only protects
employeesbutalso benefits the organization by reducing costs associated
with accidents and illnesses. It enhances employee productivity and
morale as they feel valued and secured in their work environment.
Involving employees in safety discussions and decision-making fosters
a collaborative culture where everyone takes responsibility for safety.
Overall, effective health and safety management is integral to building
a sustainable and responsible workplace culture.

In this unit, you will learn about maintaining workplace safety. Then
you will learn about first-aid, accidents and emergency and evacuation
plans. At the end, you will learn hazards and healthy living.
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Session 1: Maintaining Workplace Safety

Workplace safety involves creating and maintaining

a safe environment to prevent accidents and health -
issues. It helps in preventing injuries, illnesses and ;
ensuring a productive work environment. Every
workplace accident, illness, or conflict carries a
cost for the organization, as well as for the affected
individuals and their families. It is our duty to establish B e
a safe working environment, which will enhance both -

the workplace atmosphere and overall productivity. YN
Employees must take ownership of their own health & / \
and safety, rather than relying entirely on the ‘safety

officer’ or management as shown in Figure 1. Some OFFICE S FETY
common ways to maintain safety at the workplace A
are as follows:
xv\?gi'frreogciome ﬁ)@ Maintain distance
o Employee health encompasses physical, 5
1 - 1 1 1 Wash your hands Keep yourself informed
mental apd social well-being. Organizations ﬁ% ik o mlammants
must provide a safe and healthy workplace to N —
. [ Use the hand sanitizer on = Do not spread rumours, and
prevent dlseases' Zg%zge;:dbg:%r;;;d after /verifyinformation

o Cleanliness is crucial, so workspaces should
be cleaned daily. Proper air conditioning and
filtered water are essential, and a cafeteria offering fresh food supports health. Additionally, well-
maintained washroom facilities must be provided.

Figure 1:  Office Safety

e The work environment must be safe and free from hazards and risks. A hazard is any factor that can
cause harm, while a risk is the likelihood of that harm occurring.

e The organization must develop and strictly adhere to comprehensive safety guidelines. Employees
should regularly practice these safety procedures.

e The Department of Information Technology (DolT) has established a policy to ensure a safe and
healthy work environment. This policy is a formal statement by the employer, committing to the
protection of employees and the public, and demonstrates management’s dedication to maintaining
a secure workplace.

e The policy outlines the necessary elements and objectives to safeguard workers and must meet
government-required standards. Additionally, the company should have a specific health, safety,
and security committee to identify and address workplace hazards.

The following reasons highlight the importance of a safety policy:
o It demonstrates the company’s dedication to the health and safety of its employees.
o It aligns business performance with safety performance, showing that they are mutually supportive.

o It specifies the accountability of everyone in the company regarding workplace health, safety, and
security.

o It ensures compliance with national Occupational Health and Safety (OH&S) policies as outlined by
the government of India.

o It helps prevent employee injuries and illnesses through established policies.

Information Technology
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Some of the potential sources of hazards in an organization are as follows:

Unsafe work practices: Employees may engage in unsafe work practices, such as improper use of
equipment or tools, failing to follow established safety procedures, or lacking adequate training
and awareness about safety protocols.

Workplace conditions: Poorly maintained or cluttered workspaces can pose hazards. Additionally,
inadequate lighting or ventilation, as well as unstable or uneven flooring, can contribute to unsafe
working conditions.

Machinery and equipment: Faulty or poorly maintained machinery presents a risk. The absence of
appropriate machine guards and inadequate safety features or controls can increase the likelihood
of accidents.

Chemical substances: Improper storage or handling of hazardous chemicals can create risks.
Inadequate labelling or documentation, such as missing Material Safety Data Sheet (MSDS) and the
lack of proper Personal Protective Equipment (PPE) also contribute to potential hazards.

Electrical systems: Exposed wiring or faulty electrical equipment pose a significant hazard.
Overloading electrical outlets or circuits, combined with inadequate grounding or insulation,
further increases the risk.

Fire safety: Blocked or inaccessible fire exits can impede emergency evacuations. The absence of
functional fire alarms or extinguishers and the improper storage of flammable materials also create
fire hazards.

Ergonomic issues: Poorly designed workstations or seating can lead to ergonomic hazards.
Repetitive strain from awkward postures and inadequate lifting techniques or equipment are also
common concerns.

Human factors: Fatigue or stress among employees can result in decreased attention and
performance, increasing the risk of accidents. Inadequate supervision or safety leadership, along
with communication breakdowns regarding safety procedures, can further contribute to hazards.

Cautions While Working on the Computer

Some important cautions to consider while working on a computer:

Maintain proper posture: To ensure comfort and reduce the risk of strain, follow these guidelines:
¢ Sit upright with your back supported.

¢ Keep your feet flat on the floor.

¢ Position your computer screen at eye level to avoid neck strain.

Take regular breaks: To take regular breaks, follow these guidelines:

¢ Follow the 20-20-20 rule: Every 20 minutes, look at something 20 feet away for 20 seconds.

¢ Stand up, stretch, and move around every 30-60 minutes to reduce strain on your body.

Use proper lighting: To use proper lighting, follow these guidelines:

¢ Avoid glare by positioning your screen away from direct light sources.

¢ Use ambient lighting that is not too bright or too dim.

¢ Consider using a desk lamp with adjustable brightness.

Maintain Healthy, Safe and Secure Working Environment
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Adjust screen settings: To adjust screen settings, follow these guidelines:

¢ Set the screen brightness to a comfortable level.

¢ Use larger font sizes to reduce eye strain.

¢ Adjust the colour temperature to warmer tones to reduce blue light exposure.
Protect your eyes: To protect your eyes from computer screen, follow these guidelines:
¢ Blink frequently to keep your eyes moist.

¢ Use anti-glare screen protectors if necessary.

¢ Consider blue light filtering glasses if you spend long hours at the computer.

Maintain proper keyboard and mouse usage: To maintain proper keyboard and mouse usage,
follow these guidelines:

¢ Keep your wrists straight while typing.
¢ Use a wrist pad for support if needed.
¢ Position the keyboard and mouse at a comfortable height to avoid strain.

Keep your work area clean and organized: To keep your work area clean and organized, follow
these guidelines:

¢ Keep liquids away from the computer to prevent spills.

¢ Ensure cables are properly managed to avoid tripping hazards.

¢ Clean your screen, keyboard, and mouse regularly to prevent dirt buildup.

Ensure adequate ventilation: To ensure adequate ventilation, follow these guidelines:
¢ Avoid blocking the computer’s ventilation ports.

¢ Use a cooling pad if you are using a laptop for extended periods.

¢ Keep the room well-ventilated to avoid overheating.

Practice proper hand and finger care: To practice proper hand and finger care, follow these
guidelines:

¢ Avoid excessive pressure on the keys while typing.

¢ Take short breaks to stretch your fingers and wrists.

¢ Use ergonomic keyboards and mice to minimize strain.

Back up important data: To back up important data, follow these guidelines:

¢ Regularly back up files to external storage or cloud services.

¢ Keep antivirus software up-to-date to protect against malware.

¢ Avoid downloading software from untrusted sources to prevent infections.
Follow electrical safety guidelines: For electrical safety follow these guidelines:
¢ Use surge protectors to prevent damage from power fluctuations.

¢ Unplug devices when not in use for extended periods.

¢ Avoid overloading power outlets with multiple devices.

Be mindful of ergonomics: To ensure ergonomics issues, follow these guidelines:

¢ Use an ergonomic chair that provides good lumbar support.
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¢ Keep frequently used items within easy reach to avoid excessive stretching.
¢ Adjust the desk and chair height to maintain comfortable positioning.

Figure 2 shows the correct sitting postures in an office while working with a computer.
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Figure 2:  Correct Sitting Postures in an Office

Fire Prevention
Some fire preventing measures are as follows:

e Maintain clean workspaces: Keep work areas free of clutter, especially flammable materials such as
paper, chemicals and textiles. Ensure that waste is disposed of regularly and appropriately.

e Proper storage of flammable materials: Store flammable materials in designated areas with proper
labeling and ventilation. Use fire-resistant cabinets and keep these materials away from the sources
of ignition.

e Safe electrical practices: Avoid overloading electrical outlets and circuits. Use power strips with
surge protectors and ensure that electrical cords are in good condition without fraying or exposed
wires.

e Regular maintenance of equipment: Ensure that machinery and electrical equipment are regularly
inspected and maintained to prevent malfunctions that could lead to fires.

e No smoking in restricted areas: Enforce strict no-smoking policies in ?_
areas where flammable materials are present and provide designated DID YOU Know &'
smoking areas away from the main building. Safetyisa

shared responsibility.

e Proper use of heating equipment: Ensure that space heaters and other Everyone has a role to
heating equipment are used safely and are equipped with automatic play in creating a safe
shut-off features. Keep them away from combustible materials. workplace.
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General Safety Rules
Some common safety rules are as follows:

e Report hazards immediately: This means promptly informing supervisors or relevant authorities
about any dangerous or unsafe conditions in the workplace.

o Follow safety procedures: This involves adhering to established guidelines, protocols, or rules
designed to minimize risk and ensure safety.

e Wear PPE as required: PPE stands for Personal Protective Equipment, which includes items such as
helmets, gloves, safety goggles and masks.

e Be aware of your surroundings: This involves staying alert to potential hazards and changes in the
work environment that could cause harm.

o Take breaks to rest and avoid fatigue: Taking regular breaks allows your body and mind to rest,
refresh and maintain focus, especially during demanding or repetitive tasks.

e Participate in safety training: This ensures that workers are informed about safety procedures,
proper use of equipment and how to respond to emergencies.

ACTIVITY ¥, \

1. Make a list of hazards such as flammable chemicals, gas leaks, or malfunctioning equipment in your chemistry lab.

2. Write a story that incorporates fire safety rules, helping students understand and remember the importance of following
these rules.

ASSESS YOURSELF ,(ﬁﬂf‘ . .

1. Workplace safety involves only preventing physical injuries and does not consider mental or social well-being. (True/
False)

2. Flammable materials should be stored in areas with poor ventilation to minimize the risk of fire. (True/False)

Session 2: Understanding First-Aid

First-aid is a critical skill that can make a life-saving difference in emergency situations. It involves
providing immediate medical care and support to individuals who are injured or ill until professional
medical help can take over. By being prepared and knowledgeable about first-aid techniques, you can
effectively manage various medical emergencies and potentially save lives.

Basic Principles of First-Aid

Some basic principles of first-aid are as follows:

o Assess the situation: Ensure the area is safe for both the responder and the injured person. Check
for potential hazards like fire, electrical wires, or toxic fumes before approaching.

e Call for help: Contact emergency services as soon as possible. Provide clear information about the
location, nature of the injury or illness and the number of people involved.

e Stay calm: Keep a calm attitude to comfort the injured person and handle the situation efficiently.
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Techniques of First-Aid

Some first-aid techniques are as follows:

e Cardiopulmonary Resuscitation (CPR): Used when a person is unconscious and not breathing.
Perform chest compressions and rescue breaths to maintain circulation and oxygen flow. Follow the
latest guidelines or training protocols for CPR, as shown in Figure 3.

e Control bleeding: Apply CPR: Step by Step
pressure to the wound using '

a clean cloth or bandage to :
stop the bleeding. If the 112

bleeding is severe, elevate ‘; @ @@
the injured limb above

hear'F level if possnble and Call 112 or ask Lay the person on their back If they are not
continue to apply pressure. someone else to and open their airways breathing, start CPR

e Treating burns: For minor
burns, cool the area with

. a3
cool (not cold) running @ @-—o
water for at least 10 ©
minutes. Do not apply ice 04

: chest Two rescue Repeat until an ambulance
dlreCtly to _the burn. Cover compressions breaths or Automated External
the burn with a clean, non- Defibrillator (AED) arrives

stick bandage. For severe
burns, seek medical help  Figure3: Step-by-Step CPR Process

immediately. P

e Fractures and sprains: Immobilize the injured area to prevent further —=DID YOU Know.’? =
damage. Use a splint or padding to stabilize fractures. For sprains, use The three
the Rest, Ice, Compression, Elevation (RICE) method to reduce swelling essential steps of first-
and pain. aid are Check, Call, Care.

o . . ) First, check the scene

e Choking: Perform the Heimlich maneuver if someone is choking and and the person, then
cannot breathe. Stand behind the person, place your hands above the call for help, and finally,
navel, and give quick, upward thrusts until the object is dislodged. provide appropriate care

e Poisoning: Identify the substance involved and follow specific first-aid based on the situation.

procedures for that type of poisoning. Do not induce vomiting unless
instructed by a medical professional.

o Shock: Lay the person down and elevate their legs if possible. Keep them warm and comfortable,
and do not give them anything to eat or drink. Monitor their condition until help arrives.

e Seizures: Clear the area of any objects that could cause injury. Do not restrain the person or put
anything in their mouth. Once the seizure subsides, place them in the recovery position and
monitor their breathing.

e Heat exhaustion and heatstroke: Move the person to a cooler environment, loosen tight clothing,
and provide cool (not cold) water to drink. For heatstroke, cool the person with a cold compress or
fan and seek immediate medical help.

e Hypothermia: Warm the person gradually, starting with the core of the body. Use warm, dry clothing
and blankets, and provide warm, non-alcoholic beverages.

Maintain Healthy, Safe and Secure Working Environment

©Copyright 2025 by Dreamtech Press




First-Aid Kit Essentials

First-aid kit helps address minor injuries and provide initial care in emergencies. The essential items in a
first-aid kit are shown in Figure 4. A first-aid kit should include the following key items:

e Adhesive bandages and sterile

gauze pads: They are crucial Gagze rgll Instant cold pack Elastic bandages
and pads

for covgring nﬁnor 'wounds and Bandages /\ Fmergency

preventing infection. These \ _ blanket

items help protect the injury \\) = @

from dirt and bacteria while

promoting healing. Thermometer Antiseptic
Adhesive Triangular wipes

e Antiseptic wipes and antibiotic
ointment:  Antiseptic  wipes

help disinfect the area around First-aid @
. . . . |
a‘cut or scrape, while antlblqtlc manua Smssors
ointment can be applied
afterward to further reduce the

i i i Gloves
risk of infection. Emergency contact information/ medical Tweezers

e Tweezers and scissors: They are information for family members
important tools in a first-aid
kit as tweezers can be used to
remove splinters, ticks or debris from wounds, and scissors are necessary for cutting tape, gauze,
or clothing if needed.

tape Safety pins > bandage

Figure 4:  Essentials in First-Aid Kit

e Pain relievers: Pain relievers, such as ibuprofen or aspirin, are important for managing discomfort
or pain resulting from injuries, headaches, or fever.

e Thermometer: A thermometer is a vital instrument for monitoring body temperature, which can
help assess whether someone has a fever or other health issues.

e Cold packs: Instant cold packs are valuable for treating sprains, strains, or swelling. These packs
can be activated easily and provide immediate cold therapy to reduce inflammation and numb pain
at the injury site.

e CPR mask or face shield: A CPR mask or face shield should be included in the first-aid kit to ensure
safe rescue breaths during CPR.

e Emergency blanket: An emergency blanket is a lightweight, compact blanket that helps retain body
heat in situations where someone may be in shock or experiencing hypothermia.

e First-aid manual: A first-aid manual is an essential resource that provides step-by-step instructions
on how to handle various medical emergencies.

ACTIVITY L \

. Role-play a scenario where one student pretends to have a minor injury and others practice providing first-aid, such as
cleamng the wound, applying a bandage and offering comfort.

2. Create a step-by-step guide to administering first-aid, including stopping the bleeding and cleaning the wound. Work with
your group to demonstrate each step using first-aid supplies.

N

ASSESS YOURSELF. . \

. To control severe bleeding, apply pressure to the wound and ... the injured limb above heart level if possible.
2. The Heimlich maneuver is used for a person Who is ... and cannot ...

(o =]
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Session 3: Accidents

An accident is defined as an unfortunate event that happens unpredictably as well as unintentionally and
may lead to harm and injury to people. They can happen in various settings, including the workplace, at
home, on the road, or in public spaces.

Common Causes of Accidents
Some common causes of accidents are as follows:

e Human error: Mistakes or negligence, such as failing to follow safety protocols, lack of attention,
or reckless behaviour, often contribute to accidents.

e Environmental hazards: Slippery floors, poor lighting, uneven surfaces and adverse weather
conditions can lead to slips, trips, falls and other accidents.

e Equipment and machinery malfunctions: Faulty or poorly maintained equipment can cause
accidents, especially in industrial or construction settings.

e Improper use of tools and equipment: Using tools or machinery without proper training or for
unintended purposes increases the risk of accidents.

e Inadequate safety measures: Lack of safety equipment, such as helmets, gloves, seatbelts, or
harnesses, can lead to injuries in case of accidents.

e Fatigue and stress: Physical and mental fatigue can impair judgment and reaction times, increasing
the likelihood of accidents.

e Substance abuse: Alcohol or drug use can impair a person’s ability to function safely and effectively,
leading to accidents.

Types of Accidents

Some common types of accidents at the workplace are as follows:

e Slip, trip and fall: Accidents caused by slipping,
tripping or falling due to uneven surfaces or
obstacles as shown in Figure 5.

e Moving, lifting or pushing heavy objects: Injuries
resulting from the physical effort involved in
moving, lifting or pushing heavy items.

e Hit by falling objects: Injuries sustained when
objects fall and strike an individual.

o Leakage of toxics: Exposure to harmful chemicals
or gases due to leaks or spills.

e Struck by objects in walkway: Injuries from
being hit by objects that are improperly placed or
unsecured in walkways.

e Repetitive strain injuries: Injuries caused by
repetitive motion or strain, often affecting muscles ~ Figure 5 Slip, Trip and Fall Accident
or tendons.

e Falling from a height: Accidents where individuals fall from elevated surfaces or structures.
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e Burn injuries: Injuries resulting from exposure to heat, chemicals or electrical sources that cause
burns.

o Electrocutions: Injuries or fatalities caused by electric shock or contact with live electrical sources.

e Violence at the workplace: Incidents involving physical or verbal aggression between individuals
in the workplace.

e Vehicle-based accident: Accidents involving vehicles, such as forklifts or company cars that occur
on or near the work site.

e Faulty and unhealthy machinery: Injuries resulting from malfunctioning or poorly maintained
machinery.

Handling Accidents at the Workplace

Some rules and guidelines followed for handling accidents at the workplace are as follows:

Provide first-aid to the victim during an accident.

Report about the accident to the superior or manager.

Follow the Standard Operating Procedure (SOP) designed by the organization for handling accidents.

Ensure that sufficient safety equipment is available at the workplace to avoid accidents.

Call the doctor or medical team immediately in the wake of an accident.

o Follow emergency drills set by the organization during an emergency.

_ACTIVITY ¥#7, \

1. Create a report on some common causes of accidents in your school and how they might be prevented.
2. Develop a safety checklist for your classroom or workplace that includes items to regularly inspect to prevent accidents.
(.

_ ASSESS YOURSELF 3§01~ \

1. Environmental hazards like poor lighting can contribute to accidents. (True/False)
2. Slipping, tripping and falling are common workplace accidents. (True/False)

Session 4: Case Studies of Hazardous Situations
Case 1: Fall from the Ladder

Mr. Suresh is an electrician at Artofence Pvt. Ltd. for the last 15 years. He shared his experience of
meeting with an accident.

One morning in 2013, | started work as per my normal routine. | had to reconnect some electrical wires
that were previously cut off due to some upgrades. The wires were located on a wall, so | used a ladder
to reconnect the wires. This ladder was about 35 feet long. | was on the ladder about 25 feet up and
reconnecting the cables. Suddenly, I slipped and fell down from the ladder. I tried to keep my head up
while falling. I fell on my back and arms. I could not breathe properly, and every breath was very painful.
| waved my hands towards other employees, and they called an ambulance for me. | was laid on a
stretcher and given oxygen. When I reached the hospital, a team of doctors examined me. Meanwhile, my
employer informed my family about the accident. My family was very upset at the news. | was diagnosed
with cracked and bruised ribs. The hospital released me after two days, but it took almost eight weeks
to get rid of the pain completely.
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Case 2: Tripped on Network Cables " Quick Quiz

Mr. Kadam is a network engineer at APS Pvt. Ltd. He sets up the network

cables in the organization. What is the sudden shaking

of the ground caused by
Once, while working, I tripped on the cables and fell down. The ankle of my seismic activity called?

left foot got twisted, and my knee was displaced. asenbyieg ‘suy

When I fell on the floor, two of my colleagues came to my help. One of them gave me first-aid, and the
other called an ambulance. In the hospital, | was given injections to alleviate my pain, and immediate
surgery was suggested to fix my knee.

I remained hospitalized for a week and thereafter had to take physiotherapy sessions to regain the
strength in my leg. I joined the office after three months of surgery.

Case 3: Accident at the Time of Repairing Machine

Mr. Yash is a machine engineer at a manufacturing plant. He has to face an accident while repairing
machines. He shares his experiences.

One morning of 2017, | started working like my normal routine. An employee of the manufacturing plant
reported me about some malfunction in a machine. I checked the machine and found that one part was
jammed. | was clearing the blockage from the machine.

At the same time, some other worker switched on the machine. This caused the blades to rotate, and my
thumb and middle finger got cut off from the middle. I pulled my hand back from the machine and
immediately took the first-aid. My fingers were tied by the nurse at the workplace. At the hospital, the
doctors bandaged my wound but could not rejoin my fingers. The accident affected me in many ways, as
I can no longer use my left hand properly and am faced with various problems to perform daily tasks.
I returned to work after nine months of leave.

Session 5: Emergency ~
DID You Know £

The word

‘emergency’ comes from

the Latin ‘emergere,’

meaning 'to arise or

bring to light.’

An emergency is defined as an unforeseen situation that requires immediate
attention and action to prevent risk of health, life, wealth or atmosphere.
Emergencies can range from natural disasters and medical crises to fires
and security threats. Effective emergency management involves preparation,
quick response and recovery strategies.

Some common types of emergencies at the workplace are as follows:

e Natural disaster: They are serious incidents that cause major damage to people and nature.
Examples of the natural disaster are:

¢ Earthquakes: Sudden shaking of the ground caused by seismic activity.

¢ Floods: Overflow of water that submerges land and can damage property and endanger lives.

¢ Hurricanes and tornadoes: Severe weather events characterized by strong winds and heavy rain.
¢ Wildfires: Uncontrolled fires that spread rapidly, often in forested or rural areas.

¢ Blizzards and extreme weather: Severe snowstorms and other extreme weather conditions.

o Medical emergencies: In medical emergencies, quick action can save lives, ensuring immediate
care for injuries, illnesses, or sudden health issues. Examples of the medical emergencies are:

¢ Heart attacks: Sudden blockage of blood flow to the heart muscle.

¢ Strokes: Interruption of blood supply to the brain.
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¢ Choking: Blockage of the airway preventing breathing.
¢ Allergic reactions: Severe reactions to allergens, which can cause anaphylaxis.
¢ Traumatic injuries: Injuries from accidents, falls or violence.

Fire emergencies It can happen suddenly and spread quickly, causing serious risks to life and
property. Examples of the fire emergencies are:

¢ Building fires: Fires in homes, offices or other structures.
¢ Industrial fires: Fires in factories or facilities handling flammable materials.
¢ Kitchen fires: Fires caused by cooking equipment or flammable kitchen items.

Chemical and hazardous material emergencies: It occur when dangerous substances leak or spill,
posing risks to health and the environment. Examples of the chemical and hazardous material
emergencies are:

¢ Spills and leaks: Release of hazardous substances like chemicals, gases, or radioactive materials.
¢ Poisoning: Exposure to toxic substances.

Security emergencies: They happen when there is a threat to people’s safety, such as violent
events. It’s crucial to be prepared and know how to respond to keep ourselves safe. Examples of
the security emergencies are:

¢ Violence or terrorism: Acts of violence, including shootings, bomb threats or other attacks.
¢ Break-ins or robberies: Unauthorized entry or theft.
¢ Kidnapping or hostage situations: Unlawful confinement of individuals.

Public health emergencies: They are serious situations that require immediate action and
coordination among health officials, communities and governments to ensure public safety.
Examples of the public health emergencies are:

¢ Pandemics and epidemics: Widespread outbreaks of infectious diseases.

¢ Food or water contamination: OQutbreaks due to contaminated food or water sources.

Some general emergency handling procedures for the workplace are as follows:

Emergency contact information: Ensure that all employees are aware of emergency contact
numbers, including internal contacts, emergency services (e.g., police, fire department, medical),
and the building’s emergency coordinator. Display emergency contact numbers prominently in
common areas.

Emergency evacuation plan: Develop and clearly mark evacuation routes and exits. Conduct regular
evacuation drills to ensure all employees know how to evacuate quickly and safely. Designate
assembly points outside the building where employees should gather after evacuation.

Fire safety procedures: Install and maintain fire alarms, smoke detectors and fire extinguishers.
Train employees on how to use fire extinguishers and how to respond to a fire alarm. Ensure that
fire exits are not blocked and are easily accessible.

First-aid procedures: Provide first-aid kits in accessible locations throughout the workplace. Train
employees in basic first-aid and Cardiopulmonary Resuscitation (CPR). Designate individuals as
first-aid responders and ensure they are available during work hours.

Medical emergencies: Instruct employees to call emergency services immediately in the event of
a medical emergency. Provide clear guidelines on how to report medical emergencies and assist
injured individuals until professional help arrives.
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e Chemical spill response: Have spill containment kits readily available and ensure employees know
how to use them. Train employees on proper procedures for handling chemical spills, including
evacuation if necessary. Follow manufacturer guidelines and Safety Data Sheets (SDS) for specific
chemical spill responses.

e Natural disasters: Prepare for natural disasters such as earthquakes, hurricanes, or tornadoes by
developing specific response plans. Educate employees on the appropriate actions to take during
each type of natural disaster. Ensure that emergency supplies, such as first-aid kits, food and water,
are readily available.

e Violence and security threats: Establish procedures for handling workplace violence or security
threats, including protocols for lockdowns or evacuations. Provide training on recognizing and
reporting suspicious behaviour or security risks. Implement access control measures and maintain
security systems, such as cameras and alarms.

o Communication during emergencies: Implement a system for communicating emergency
information to all employees, such as emergency notification systems or loudspeakers. Ensure that
employees know how to receive and respond to emergency alerts and instructions.

e Post-emergency procedures: Conduct a debriefing session after an emergency to evaluate the
response and identify areas for improvement. Provide counselling or support services for employees
affected by the emergency. Review and update emergency procedures based on lessons learned
from the incident.

ACTIVITY ¥, ASSESS YOURSELF ]

1. Make a group to create a plan of simple evacuation 1. Hurricanes and tornadoes are characterized by strong
drill for a fire emergency. Identify and mark the and
primary and secondary evacuation routes from 2. Emergency contact information should be displayed
various locations in the building. prominently in ... areas of the workplace.

Session 6: Emergency and Evacuation Plan

An emergency and evacuation plan is a comprehensive strategy designed to ensure the safety of individuals
during emergencies, such as fires, natural disasters, chemical spills or other crises. The primary goal of
such a plan is to provide clear guidelines for safely evacuating a building or facility, minimizing risks and
ensuring the well-being of all individuals.

An emergency and evacuation plan should include the following steps:

e Planning and preparation: It refers to the organized steps and actions taken to ensure a safe,
efficient and timely evacuation during emergencies.

¢ Risk assessment: It involves conducting a risk assessment to identify potential hazards such
as fires, chemical spills, natural disasters, or security threats. It also includes evaluating the
workplace layout, including exits, stairwells and assembly points.

¢ Designated roles and responsibilities: Evacuation coordinators oversee the process, ensuring
everyone is accounted for. Fire wardens or monitors assist others in evacuating, checking rooms
and using fire extinguishers.

¢ Evacuation routes and exits: They must be clearly marked and kept free of obstructions, with
maps posted in visible locations throughout the workplace.
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¢ Safe assembly points: These should be located away from the building and free from hazards
and should be designated to provide a gathering area for employees after evacuation.

Communication and notification: This refers to the methods and processes used to inform
individuals about emergencies and provide clear instructions for safe evacuation.

¢ Alarm systems: To ensure effective communication and notification during emergencies,
organizations should install alarm systems, such as fire alarms and public address systems.

¢ Emergency communication plan: This plan should be developed to guide communication
with employees. This plan should incorporate multiple communication methods, such as
loudspeakers, emails, text messages, or mobile apps.

Training and drills: It refers to the organized activities designed to prepare individuals for
emergency evacuations.

¢ Employee training: Regular training sessions should cover the evacuation plan, including exit
locations, evacuation routes, assembly points, and how to assist employees with disabilities
during emergencies.

¢ Evacuation drills: The drill should be conducted at least once a year, with more frequent sessions
if possible. These drills must cover various scenarios to prepare everyone for different types of
emergencies effectively.

During an evacuation: It refers to the procedures, actions, and considerations that need to be
followed when an evacuation is taking place.

¢ Evacuation procedure: It is crucial for employees to remain calm and avoid panic in emergency
situations. They should listen to the evacuation coordinator and follow their instructions closely.
It is important to use the stairs to exit the building during emergencies because elevators may
stop working or become unsafe.

¢ Headcounts and reporting: Once at the assembly point, a headcount should be conducted to
ensure everyone has evacuated safely, and any missing persons should be reported to emergency
personnel immediately.

Post-evacuation procedures: They are essential steps to ensure safety, accountability and easy
access to normal activities after an evacuation.

¢ Do not re-enter the building: Post-evacuation procedures include several important steps to
ensure safety. Firstly, do not re-enter the building until it has been declared safe and if there are
injuries, provide first-aid as needed.

¢ Incident review: Following the evacuation, conduct an incident review to assess the evacuation
process and identify any issues. Based on feedback and observations from this review, update
the evacuation plan and procedures accordingly.

Special considerations: It refers to specific factors or accommodations that need to be addressed
to ensure the safety and effective evacuation of all individuals during an emergency.

¢ Special needs: When planning evacuations, it’s crucial to support employees with disabilities
or special needs by providing necessary resources. Procedures should also ensure visitors and
contractors are included in the emergency response plan.

Continuous improvement: It refers to the ongoing process of evaluating, updating and enhancing
the evacuation procedures and strategies based on feedback and experiences from drills or actual
evacuations.
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¢ Review and update: It is essential to regularly review and update to reflect changes in the
workplace, such as new hazards, alterations in building layout or the addition of new employees.

General Evacuation Procedures

General evacuation procedures are essential for ensuring the safety of individuals during an emergency.
A step-by-step guide to typical evacuation procedures:

1.

Alert: The system has detected unusual activity and requires immediate attention to ensure security
and prevent potential issues. Some key aspects of alert are as follows:

¢ An emergency alert (alarm, notification, or announcement) is triggered to inform everyone
about the need to evacuate. This could be due to fire, gas leaks, natural disasters, or other
emergencies.

¢ Ensure the alarm system is clear, loud, and easily heard across the facility.

Assess the situation: Before making any decisions, it’s important to assess the situation thoroughly
by gathering all relevant information and understanding the context of the issue at hand. Some key
aspects of assessing the situation are as follows:

¢ Quickly evaluate the emergency situation (if it's safe to do so) and determine if evacuation is
necessary. If in doubt, evacuate immediately.

¢ Designate or identify a safe assembly point away from the hazardous area.

Follow evacuation routes: In the event of an emergency, it is crucial to follow the designated
evacuation routes to ensure your safety and reach the nearest exit promptly. Some key aspects of
evacuation routes are as follows:

¢ Employees or individuals should immediately leave the premises via pre-designated evacuation
routes, marked with exit signs.

¢ Ensure that all pathways are clear of obstructions, well-lit, and accessible.
¢ Do not use elevators, as they might malfunction during certain emergencies.

Assistance for people with disabilities: Assistance for people with disabilities involves providing
tailored support, accommodations, and resources to help them navigate daily tasks, access services,
and participate fully in society. Some key aspects of assistance for people with disabilities are as
follows:

¢ Designate specific personnel to assist those who may have mobility impairments or other
disabilities, ensuring they are safely evacuated.

¢ Use designated equipment (such as evacuation chairs) where necessary.

Evacuate calmly and quickly: Evacuating calmly and quickly is crucial for safety in emergency
situations. Some key aspects to follow:

¢ Evacuees should proceed quickly and calmly, without pushing or shoving.
¢ Stay together as a group, and do not return for personal belongings.
¢ Follow instructions from emergency personnel or designated safety officers.

Accountability: Accountability refers to the obligation of an individual or organization to explain,
justify, and take responsibility for their actions, decisions, or performance. Some key aspects of
accountability are as follows:

¢ Once outside, individuals should proceed to the assembly point where a headcount will be
conducted.
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¢ Ensure that all personnel are accounted for. Report any missing individuals to emergency
services.

7. Wait for official clearance: Wait for official clearance refers to the process of awaiting formal
approval or authorization from the relevant authorities or parties before proceeding with a specific
action, project, or task. Some key aspects of official clearance are as follows:

¢ Do notre-enter the building until it is officially deemed safe by emergency services or designated
authorities.

8. Review and update procedures: Review and update procedures should include conducting post-
event debriefings to assess the evacuation’s effectiveness, identifying challenges, and regularly
updating the plan. Some key aspects of review and update procedures are as follows:

¢ After the event, conduct a debriefing to assess the evacuation’s efficiency, any challenges faced,
and areas for improvement.

¢ Regularly update evacuation procedures and conduct drills to ensure preparedness.

—ACTIVITY ¥, . ASSESSYOURSELFSJ.

1. Conduct a mock evacuation drill for your classroom 1. An evacuation plan outlines specific steps to safely exit a
or school. Qutline the steps for the drill, including building during emergencies. (True/False)
how to alert everyone, the route taken, assembly 2. Evacuation routes should be ... of obstructions
points and any special considerations. at all times.
2. Draw a simple evacuation map for your home or 3. Alarm systems should be tested regularly to ensure they
L workplace. Mark all exits and safe assembly points. J1 are functioning properly. (True/False) )

Session 7: Understanding Hazards

Hazard is defined as a potential source that causes harm to an individual. Hazards can be physical,
chemical, biological, ergonomic, or psychosocial in nature, and they can exist in various environments,
including workplaces, homes and public spaces. Identifying and managing hazards is essential for
maintaining safety and preventing accidents or health issues. In an organization, there are several types
of hazards that may harm the life and health of an employee or worker. Some common types of hazards
are as follows:

e Physical hazard: Refers to the hazard that could harm an individual with or without making a
physical contact. The common sources of physical hazards are slippery floors, excessive noise, poor
lighting, fire, fall, etc.

e Ergonomic hazard: Refers to the hazard in which the working condition and environment, body
posture, and type of work, etc., put the strain on the body of an employee. The common sources
of ergonomic hazards are bad sitting posture, repetitive and awkward movement, stretching the
body, lifting heavy objects, etc.

e Psychological hazard: Refers to the hazard that affects or harms the employee mentally. The
common sources of psychological hazards are extra workload, working shift, harassment, violence
at the workplace, work stress, partial judgment of seniors, lack of respect, continuous low-level
noise, etc.

e Biological hazard: Refers to the hazard that includes viruses, bacteria, insects, animal and bird
droppings, etc., which can cause an adverse impact on the health of the employee. Common
sources of biological hazards are mildew, blood, harmful plants, bodily fluids, sewage, dust, insect
bites, etc.
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Chemical hazard: Refers to the hazard that harms employees when they prepare a chemical or deal
with any form of chemical (solid, liquid, or gas). The sources of chemical hazard are paints, acids,
solvents, vapours, fumes, varnishes, gases, flammable materials, pesticides, etc.

Safety hazard: Refers to the hazard that creates an unsafe working atmosphere. The sources of
safety hazards are unguarded machinery, loose or frayed carpets, hanging cables, faulty cables,
unsafe and malfunctioning equipment, etc.

Mitigation Strategies

To effectively manage these hazards, workplaces should:

Conduct regular risk assessments to identify potential hazards. DID YOU Know £

Implement appropriate safety measures, such as protective equipment, Slips, trips and

signage and safety protocols. falls account for over
30% of all workplace

Provide regular training and education for employees on hazard

.. . injuries.
recognition and safe work practices.

Ensure proper maintenance and inspection of equipment and facilities.

Foster a culture of safety and encourage reporting of hazards and near-misses.

Workplace Safety Hazards and Basic Safety Rules

Workplace safety is paramount for a healthy and productive work environment. Identifying potential
hazards and adhering to safety rules can prevent accidents and injuries.

Common Workplace Hazards

Some of the most common hazards at the workplace are as follows:

Slip and fall hazards: Hazards that can cause falls, including wet or uneven floors, poor lighting,
cluttered walkways, or poorly maintained stairs, are called slip and fall hazards as shown in
Figure 5. Safety rules for slip and fall hazards include:

¢ Keep walkways clear of obstacles and clutter.

¢ Immediately clean up spills and mark wet areas with warning signs.

¢ Ensure floors and stairs are well-maintained and have proper non-slip surfaces.
¢ Use appropriate footwear with good traction.

Electrical hazards: Electrical hazards can arise from exposed wiring, faulty equipment, or improper
use of electrical tools. Safety rules for electrical hazards include:

¢ Ensure all electrical equipment is properly maintained and regularly inspected.
¢ Use equipment with proper grounding and safety certifications.

¢ Avoid overloading electrical outlets and use extension cords correctly.

¢ Turn off and unplug equipment before servicing.

Fire hazards: Fire hazards can occur due to faulty wiring, flammable materials, or improper storage
of combustibles. Safety rules for fire hazards include:

¢ Keep flammable materials away from ignition sources.

¢ Install and maintain smoke detectors and fire extinguishers.

Maintain Healthy, Safe and Secure Working Environment
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¢
¢

Conduct regular fire drills and train employees on evacuation procedures.

Ensure clear access to fire exits and maintain fire lanes.

e Chemical hazards: Chemical hazards include exposure to harmful substances such as solvents,
acids, or other toxic chemicals. Safety rules for chemical hazards include:

¢ Store chemicals in properly labelled containers and use them according to manufacturer
instructions.
¢ Use PPE such as gloves and goggles when handling chemicals.
¢ Ensure proper ventilation in areas where chemicals are used.
¢ Have Material Safety Data Sheet (MSDS) readily available.
e Machinery hazards: Machine hazards involve risks from operating P Quick Quiz
machinery, such as moving parts or inadequate safeguards. Safety
rules for machine hazards include: What is the recommended
— . i ight?
¢ Install and maintain machine guards to protect operators from uratin ofisleep or each nignit
moving parts. a. 5-6 hours c. 10-12 hours
¢ Train employees on safe machine operation and proper use. b. 7-3hours d. 3-4hours
SINoY G-/ *q ‘suy
¢ Keep machinery in good working condition and conduct
regular maintenance.
¢ Ensure emergency stop controls are accessible.

Health and Safety Requirements for Computer Workplace

Health and safety requirements for a computer workplace are crucial to ensure a safe, comfortable, and
productive environment. Some of the key guidelines:

e Ergonomics: Ergonomics focuses on designing work environments and tools that optimize human
well-being and productivity. Some key aspects of ergonomics are as follows:

¢

* & o o

¢
¢

Workstation setup: Ensure the desk, chair, and computer equipment are arranged to maintain
a neutral posture.

Chair: Should be adjustable (height, backrest, armrests) to support the lower back.
Desk: Should have enough space for all work materials without clutter.
Monitor: Top of the screen should be at or slightly below eye level, about an arm’s length away.

Keyboard and mouse: Should be at a height that keeps elbows at a 90-degree angle, wrists in a
neutral position.

Posture: Encourage employees to sit upright, feet flat on the floor, knees at a 90-degree angle.

Footrest: If needed, use a footrest to support feet.

o Lighting: Lighting refers to the use of various light sources to illuminate a space in a way that
enhances visibility and comfort while minimizing strain. Some key aspects of lighting are as follows:

¢

¢
¢
¢

Natural lighting: Utilize natural light as much as possible, minimizing glare.
Artificial lighting: Use adjustable, anti-glare lighting to avoid strain.
Screen glare: Position monitors perpendicular to windows or light sources to reduce glare.

Task lighting: Provide desk lamps for focused work.
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e Screen usage: Screen usage refers to best practices aimed at minimizing the negative effects of
prolonged screen time, especially in terms of eye strain and discomfort. Some key aspects of
screen usage are as follows:

¢ Screen breaks: Encourage short breaks every 20-30 minutes to reduce eye strain (20-20-20 rule:
every 20 minutes, look at something 20 feet away for 20 seconds).

¢ Font size and contrast: Adjust screen settings to have comfortable font size and contrast.
¢ Blue light filters: Use blue light filters or screen settings to reduce eye strain.

o Electrical safety: Electrical safety refers to practices and precautions taken to prevent electrical
hazards that could lead to injury, fire, or damage to equipment. Some key aspects of electrical
safety are as follows:

¢ Cable management: Ensure cables are organized and not a tripping hazard.

¢ Power outlets: Use grounded outlets and avoid overloading sockets.

¢ Surge protectors: Use surge protectors to safeguard equipment from power surges.
¢ Regular inspection: Check and maintain electrical equipment regularly for safety.

e Air quality and temperature: Air quality and temperature are crucial factors in maintaining a
comfortable and healthy workplace environment. Some key aspects of air quality and temperature
are as follows:

¢ Ventilation: Maintain good air circulation with proper ventilation.

¢ Temperature control: Keep the workplace temperature comfortable (around 20-22°C or
68-72°F).

¢ Humidity levels: Maintain adequate humidity (30-50%) to prevent dry air that can affect eyes
and skin.

o Noise levels: Noise levels refer to the intensity or volume of unwanted sound in an environment,
which can be distracting, disruptive, or harmful to productivity and well-being. Some key aspects
of noise levels are as follows:

¢ Noise reduction: Use noise-absorbing materials (carpets, curtains) to reduce ambient noise.
¢ Headphones: Encourage using noise-canceling headphones if needed.
¢ Quiet zones: Create quiet zones for focused work or meetings.

e Breaks and movement: Breaks and movement refer to strategies that promote physical activity and
rest to reduce the negative effects of prolonged sitting and computer use. Some key aspects of
breaks and movement are as follows:

¢ Regular breaks: Encourage regular breaks away from the computer to reduce fatigue.
¢ Stretching: Promote stretching exercises to relieve tension, especially for neck, back, and wrists.

¢ Movement: Encourage standing up, walking around, or using a sit-stand desk to reduce
sedentary behaviour.

e Health and safety training: Health and safety training is an essential part of creating a safe and
healthy work environment. Some key aspects of health and safety training are as follows:

¢ Training: Provide training on ergonomic practices, correct workstation setup, and safe use of
equipment.

Maintain Healthy, Safe and Secure Working Environment
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¢ First aid: Ensure easy access to first aid kits and provide training for basic first aid.

¢ Emergency procedures: Communicate clear procedures for emergencies (fire, electrical faults,
evacuation routes).

e Equipment maintenance: Equipment maintenance refers to the ongoing process of ensuring that
all equipment, such as computers, monitors, chairs, and other office or industrial tools, are in good
working condition. Some key aspects of equipment maintenance are as follows:

¢ Regular checks: Schedule routine inspections for all equipment (computers, monitors, chairs) to
ensure they are functioning properly.

¢ Repairs and replacements: Replace damaged or faulty equipment promptly.

e Mental health considerations: Mental health considerations in the workplace focus on creating a
supportive environment that prioritizes the emotional and psychological well-being of employees.
Some key aspects of mental health consideration are as follows:

¢ Workload management: Encourage a balanced workload to avoid stress.

¢ Support: Provide access to mental health resources and support, including counselling if
necessary.

¢ Flexible work options: If possible, offer flexible work arrangements to support employee
well-being.

_ACTIVITY ¥, \

1. Your school is conducting a safety audit to identify and address potential hazards in different areas, such as classrooms,
hallways and playgrounds. Your task is to work in groups to identify these hazards and propose solutions.

|\ J

__ ASSESS YOURSELF 3], \

1. Ergonomic hazards mainly affect the mental health of workers. (True/False)
2. Regular fire drills are an important part of fire hazard prevention. (True/False)

|\ J

Session 8: Healthy Living

Healthy living involves adopting habits that promote physical, mental and emotional well-being, including
proper nutrition, exercise, sleep and stress management. The healthy lifestyle of an individual makes a
healthy environment at home as well as at the workplace. Happy and healthy employees always do
their best at the workplace. It is important to understand how to follow a healthy lifestyle. Some key
components and tips for healthy living are as follows:

e Nutrition: To maintain a healthy lifestyle, prioritizing a balanced diet is crucial by consuming a
variety of foods, including fruits, vegetables, whole grains and healthy fats. Practice portion control
to prevent overeating, stay hydrated with water and limit processed and sugary foods.

o Physical activities: To maintain a healthy lifestyle, aim for at least 150 minutes of moderate-intensity
aerobic exercise or 75 minutes of vigorous exercise weekly, along with muscle-strengthening
activities twice a week. Stay active throughout the day by taking breaks to walk or stretch and
pursuing outdoor activities like playing sports.

o Mental and emotional well-being: Practice stress-relief techniques like deep breathing, meditation,
yoga, or mindfulness. Building healthy relationships with family, friends and colleagues provides
essential social support. Engaging in activities that relax and rejuvenate you, such as hobbies,
reading or spending time in nature, can also promote emotional balance.
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o Sleep: Adequate sleep is essential for physical and mental health, with 7-9 hours of quality sleep
recommended each night. Good sleep hygiene includes maintaining a regular sleep schedule,
creating a comfortable sleep environment, and reducing screen use before bedtime.

o Healthy lifestyle choices: Avoid smoking, alcohol and drugs, as they can lead to serious health
problems. Maintain regular health check-ups for preventive screenings, vaccinations and ongoing
health management.

e Good hygiene and personal care: This involves maintaining cleanliness to promote health and
well-being. This includes regular handwashing, bathing, oral hygiene, grooming and wearing
clean clothes. These habits prevent illness, reduce the spread of germs and enhance self-esteem,
contributing to both personal health and a positive social impression.

e Healthy mindset and personal growth: It involves cultivating a positive attitude by practicing
gratitude, engaging in lifelong learning and personal development, and setting realistic, achievable
goals. Focusing on these areas helps foster continuous improvement in both personal and
professional aspects of life.

The tips for healthy loving are shown in Figure 6:

6 Tips for

Healthy Living P
CLEAN EATING
[ ]
Drink More (/¢/
Water / EXERCISE

. REGULARLY
| |
||

READ FOR 30 MINUTES
EVERYDAY —ACTIVITY kL -—

1. Plan a balanced meal for a week that

7-9 HOURS TAKE BREAKS includes healthy options for breakfast,
[ ] OF SLEEP FROM SOCIAL lunch and dinner in a scrapbook along
PER NIGHT MEDIA with pictures.

\"”\- B 2. Develop a checklist of good sleep
hygiene practices that can help improve
Ll n the quality of your sleep.

Figure 6:  Healthy Living Tips

ASSESS YOURSELF 3.

1. Itis recommended t0 g€t .o minutes of moderate-intensity aerobic exercise per week.
2. A good way to manage stress is by practicing ...
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Health and safety of employees at the workplace play
an important role in the overall effectiveness of an
organization.

First-aid is the initial aid given to an injured or sick
person to save his/her life before the arrival of medical
assistance.

The main purpose of first-aid is to provide immediate
relief to the patient until medical assistance arrives.

An accident is defined as an unfortunate event that
happens unpredictably as well as unintentionally and
may lead to harm and injury to people.

An emergency is defined as an unforeseen situation
that requires immediate attention and action to
prevent risk of health, life, wealth, or atmosphere.

Fire emergencies can happen suddenly and spread
quickly, causing serious risks to life and property.

An emergency and evacuation plan is a comprehensive
strategy designed to ensure the safety of individuals

Bruised: A condition where the skin and underlying
tissues are injured, causing blood vessels to break and
bleed into the surrounding area.

Electrocution: It refers to death or severe injury
caused by electric shock.

Ergonomic: The study and practice of designing and
arranging workspaces, tools, and tasks to fit the
needs, capabilities and limitations of human body.

Equipment: It refers to the tools, machines, devices
or materials used for a specific purpose or task. It
can include anything from simple hand tools (like
hammers) to complex machinery (like computers or
industrial machinery) required to perform work or
achieve a goal.

Evacuation: It is a planned evacuation of individuals
from a dangerous place to ensure their safety, usually
during emergencies such as natural disasters, fires, or
military activities, with an emphasis on a quick and
organized exit.

Extinguisher: An extinguisher is a portable device
designed to put out or control fires. It typically

84 Information Technology

Summary

during emergencies, such as fires, natural disasters,
chemical spills, or other crises.

An evacuation plan provides a set of procedures to be
used by the occupants of a building in an emergency.

Hazard is defined as a potential source that causes
harm to an individual. In an organization, there are
several types of hazards that may harm the life and
health of an employee or worker.

Hazards that can cause falls, including wet or uneven
floors, poor lighting, cluttered walkways or poorly
maintained stairs, are called slip and fall hazards.

A healthy lifestyle helps an individual to maintain and
improve his health and happiness.

The healthy lifestyle of an individual makes a healthy
environment at home as well as at the workplace.
Happy and healthy employees always do their best at
the workplace.

KEY TERMS

contains substances like water, foam, or chemicals,
which help suppress flames and prevent fire spread.

Flammable: It describes materials that can ignite
quickly and catch fire when exposed to heat, flames,
or sparks, posing fire hazards.

Harassment: It refers to any unwanted, intrusive,
or offensive behaviour that creates a hostile or
intimidating environment for individuals.

Mitigation: The process of reducing the severity,
impact, or likelihood of a harmful event.

Physiotherapy: It is a healthcare specialty that
focuses on restoring movement and function through
exercises, manual therapy and patient education for
rehabilitation.

Rejuvenate: It refers to the process of revitalizing or
renewing something, restoring its youthful energy,
vigour, or freshness, often associated with improving
health, well-being or appearance.

Tourniquet: A medical device used to apply pressure
to a limb to control severe bleeding, typically in
emergency situations.
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Solved Questions
Multiple-Choice Questions (MCQs)

1.

Which of the following is a “Don’t” in providing
first-aid?

a. Assure the victim of immediate help

b. Use direct pressure to stop bleeding

c. Raise the victim’s head if bleeding is in the upper
body

d. Apply a tourniquet
If a victim has a wound, how should it be cleaned
according to the first-aid guidelines?

a. With a cloth

b. With sterile wipes

c.  With unwashed hands

d. Not to clean at all

Which of the following is not mentioned as a tip for
living a healthy life?

a. Eating healthy food

b. Maintaining a smoke-free environment

c. Avoiding physical exercise

d. Drinking sufficient amounts of water

What are common sources of chemical hazards in
the workplace?

a. Loose or frayed carpets

b. Repetitive and awkward movements

c. Paints, acids and solvents

d. Extra workload and harassment

Which hazard involves issues such as unguarded
machinery and faulty cables?
a. Psychological hazard

b. Safety hazard

c. Chemical hazard

d. Ergonomic hazard
ANSWERS

3.c.

Very Short Answer Questions

1.
Ans:

Why should fire safety signs be clearly visible?
Clear signs help guide employees to exits and firefighting
equipment during emergencies.

How can employees ensure they are using safe
electrical equipment?

' PRACTICE QUESTIONS

Ans:

Ans.

Ans.

Use equipment that meets government safety standards
and is well-maintained.

Define first-aid.

First-aid is the initial aid given to an injured or sick person
to save his/her life before the arrival of specialized medical
assistance.

What is an accident?

An accident is defined as a unfortunate event that happens
unpredictably as well as unintentionally and may lead to
harm and injury to people.

Short Answer Questions-I

1.

Ans:

Ans:

How should accidents be handled in the workplace
to ensure safety?

Handling workplace accidents involves immediate
response and reporting. First, provide first-aid to the
injured and call emergency services if needed. Secure
the area to prevent further injuries and document the
incident. Investigate the cause and implement corrective
measures, such as safety training or equipment repairs, to
prevent recurrence. Maintain clear communication with all
employees and ensure they are aware of safety procedures
and their roles in emergency situations.

What are the different types of emergencies that
can occur in a workplace, and how should they be
addressed?

Workplace emergencies include natural disasters
(earthquakes, floods), fires, chemical spills and medical
emergencies. Each requires specific responses: evacuate
for fires and natural disasters, use spill kits for chemical
spills, and provide immediate first-aid for medical
emergencies. Regular training, clear emergency plans,
and proper safety equipment are essential. Ensuring all
employees understand their roles and the procedures for
different emergencies can significantly enhance workplace
safety and readiness.

Short Answer Questions-II

1.

Ans:

What are the critical steps involved in general
evacuation procedures at a workplace, and why
are they essential for ensuring safety during an
emergency?

General evacuation procedures include creating a detailed
plan, marking emergency exits, conducting regular drills
and training employees on their roles. The plan should
outline routes, assembly points and actions for various
emergencies. Employees must help people with special
needs, ensure routes are clear, and maintain updated
emergency contacts, promoting safe, efficient evacuations
and minimizing risks.

Maintain Healthy, Safe and Secure Working Environment

©Copyright 2025 by Dreamtech Press




2. What are the key components of providing effective
first-aid in the workplace, and why are they
essential?

Ans: Key components of effective workplace first-aid include
having trained personnel, accessible first-aid kits, and
clear procedures for common injuries like cuts, burns
and fractures. Ensuring employees know how to summon
professional medical help is also critical. These elements
are essential because they enable immediate response
to injuries, stabilize victims before medical professionals
arrive, and prevent minor injuries from becoming more
serious, thereby promoting a safer work environment.

Long Answer Questions

1. What are the core principles of maintaining a healthy
lifestyle, and how do they contribute to overall well-
being and productivity?

Ans: Core principle of maintaining a healthy lifestyle involves
eating a balanced diet with fruits, vegetables and whole
grains while limiting processed foods. Regular physical
activity supports heart health, boosts energy and
improves mood. Managing stress through mindfulness
or relaxation improves mental well-being, and adequate
sleep is essential for recovery and brain function. These
practices enhance physical and mental health and enhance
productivity by improving focus and resilience in daily life.

2. What do you mean by hazard? Explain any three
hazards at the workplace.

Ans. Hazard is defined as a potential source that causes harm
to an individual. In an organization, there are several
types of hazards that can harm the life and health of an
employee or worker. Some common types of hazards at
the workplace are as follows:

O Biological hazard: Refers to the hazard that includes
viruses, bacteria, insects, animal and bird droppings,
etc., which can cause an adverse impact on the health
of the employee. Common sources of biological
hazards are mildew, blood, harmful plants, bodily
fluids, sewage, dust, insect bites, etc.

O Ergonomic hazard: Refers to the hazard in which the
working condition and environment, body posture,
and type of work, etc. puts strain on the body of an
employee. The common sources of ergonomic hazards
are bad sitting posture, repetitive and awkward
movement, stretching the body, lifting heavy objects,
etc.

O Psychological hazard: Refers to the hazard that affects
or harms the employee mentally. The common sources
of psychological hazards are extra workload, working
shift, harassment, violence at the workplace, work
stress, partial judgment of seniors, lack of respect,
continuous low-level noise, etc.

Information Technology

Higher Order Thinking Skills (HOTS) Questions

1. An employee experiences frequent back pain due
to poor posture at their workstation. What should
the company implement to address this issue
effectively?

Ans: The company should implement ergonomic assessments,
provide adjustable furniture, offer posture training,
encourage regular breaks, and supply ergonomic
accessories. These measures help correct poor posture and
reduce back pain at work.

2. An employee notices that a fire extinguisher in their
department is missing. What immediate actions
should the employee take?

Ans. The employee should report the missing fire extinguisher
to the safety officer and ensure the area is equipped with
a replacement.

Assignment
Multiple-Choice Questions (MCQs)

1. What kind of hazard includes factors like extra
workload and work stress?

a. Physical hazard b. Chemical hazard
c. Psychological hazard d. Safety hazard

2. What is a recommended frequency for physical
exercise to maintain a healthy lifestyle?

a. Once a week
b. Daily for at least 30 minutes
c. Once a month
d. Only on weekends
Very Short Answer Questions
1. What is hazard?
2. Why is it important to keep an eye on the victim’s
condition during first-aid?
Short Answer Questions-I
1. What type of emergency involves a chemical spill?

2. List down the different types of accidents.

Short Answer Questions-II

1. What are the primary objectives of first aid, and list
any three key principles of first aid?

2. What are the benefits of regular physical exercise?

Long Answer Questions

1. Write a detailed note on emergency and evacuation
plans.

2. Explain the rules for maintaining workplace safety
from fire, falls, slips, trips and electricity.
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